
Министерство науки и высшего образования Российской Федерации 

Федеральное государственное бюджетное образовательное учреждение 

высшего образования 

«Курский государственный университет» 

 

Колледж  коммерции,  технологии  и  сервиса 

 

 

 

 

 

 

 

Методические рекомендации 

по выполнению практических работ 

по дисциплине: 

 

ЕН.01. Информатика и информационные технологии в профессиональной 

деятельности 

программы подготовки специалистов среднего звена (ППССЗ) 

по специальности СПО 

 

 

43.02.14 Гостиничное дело 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Курск 2019 

Документ подписан простой электронной подписью
Информация о владельце:
ФИО: Худин Александр Николаевич
Должность: Ректор
Дата подписания: 20.01.2021 10:57:51
Уникальный программный ключ:
08303ad8de1c60b987361de7085acb509ac3da143f415362ffaf0ee37e73fa19



2 

 

Содержание 

1.Работа с браузером. Работа с Интернет-СМИ, Интернет – библиотекой…………………..4 

2. Работа с глобальной сетью Интернет. Поиск информации в сети Интернет с помощью 

поисковой программы…………………………………………………………………………...9 

3. Создание  и сохранение    файла MS Office Word. Форматирование текста  и документа 

(символов  и абзацев). Изменение шрифта, выравнивание. Разметка  страницы  перед 

набором текста………………………………………………………………………………….10 

4. Создание документа в Word. Набор и редактирование документа. Сохранение документа 

на диске………………………………………………………………………………………….17 

5. Перемещение, копирование блоков текста. Вставка спецсимволов и буквицы, сносок и 

разрывов. Обрамление и заполнение текста в виде газетных полос. Колонтитулы………..21 

6. Создание таблиц в редакторе MS Word. Форматирование таблицы……………………...23 

7. Выполнение расчетов  в  таблице, созданной  в редакторе MS Word…………………….28 

8. Вставка  и создание графических объектов (рисунков, диаграмм). Редактирование 

графических объектов………………………………………………………………………….30 

9. Создание  автособираемого оглавления. Редактирование  оглавления. Печать 

документов. Предварительный  просмотр……………………………………………………34 

10. Создание маркированных, нумерованных, многоуровневых списков.  

Редактор формул………………………………………………………………………………..37 

11. Вставка  и редактирование  номеров страниц. Создание в  документе  разных разделов. 

Создание   разных колонтитулов для разных разделов  документа…………………………40 

12. Составление  типовых документов. Слияние  документов в  MS Word………………...43   

13. Слияние документов. Формирование конвертов, почтовых наклеек, комплектов  

писем…………………………………………………………………………………………….49 

14. Подготовка оригинал – макета брошюры в MS Word. Редактирование и 

форматирование статического информационного контента…………………………………52 

15. Создание и заполнение табличных документов в редакторе Word, редактирование и 

форматирование таблицы. Простейшие расчеты в таблице…………………………………56 

16. Создание, форматирование рисунков с помощью фигур.  

Работа с объектами SmartArt…………………………………………………………………..58 

17. Создание учебного пособия «Практические советы при работе с текстовым 

процессором MS Word………………………………………………………………………….63 

18. Зачетное  занятие  по теме: «MS Word»…………………………………………………...65 

19. Создание буклета и визитки средствами программы Publisher………………………….66 

20. Создание календаря средствами программы Publisher…………………………………..68 

21. Текстовые эффекты Adobe Photoshop……………………………………………………..68 

22. Создание текстовых эффектов в Adobe Photoshop……………………………………….80 

23. Создание коллажей в графическом редакторе……………………………………………99 

24. Создание тестовых эффектов в графическом редакторе……………………………….103 

25. Назначение  презентаций. Создание  и сохранение  презентаций, основные операции со 

слайдами……………………………………………………………………………………….109 

26. Создание компьютерной презентации с помощью Шаблона в редакторе презентаций 

Microsoft Power Point………………………………………………………………………….112 

27. Вставка  графических объектов в  презентацию (рисунков, таблиц, диаграмм)……...117 

28. Создание гиперссылки на произвольный показ или место в текущую презентацию...117 

29. Создание презентации «Обучающая презентация по работе с MS Power Point 2007» с 

использованием графических объектов, анимации и гиперссылок………………………..124 

30. Создание  тематических презентаций. Настройка  анимации. Показ слайдов………..125 

31. Зачетное  занятие  по теме: «Презентации  MS PowerPoint». Создание портфолио по 

профессии……………………………………………………………………………………...129 

32. Форматирование и редактирование  данных в ячейках таблицы MS Excel…………...130 



3 

 

33. Создание, редактирование и форматирование информации. Выполнение вычислений в 

электронной таблице. Копирование формул………………………………………………...132 

34. Выполнение  вычислений. Использование абсолютных и относительных ссылок…..135 

35. Использование функций электронной  таблицы. Применение логических функций...139 

36. Проведение  расчетов с вложенными функциями………………………………………141 

37. Построение  графиков и диаграмм………………………………………………………145 

38. Сортировка и фильтрация данных при обработке документа. Поиск оптимального 

решения………………………………………………………………………………………..148 

39. Использование сценариев модели «что-если», средств подбора параметров и поиска 

решения для анализа данных…………………………………………………………………153 

40. Создание комплексных документов. Специальная вставка…………………………….156   

41. Вывод на печать. Предварительный  просмотр. Редактирование таблицы в  режиме  

предварительного просмотра…………………………………………………………………157 

42. Зачетное  занятие  по теме: «Электронные таблицы  MS Excel………………………..161 

43. СУБД Access: интерфейс, основные приемы  работы 

Изучение  структуры рабочего окна, использование справочника. Создание файла базы 

данных и таблиц. Работа с данными таблицы: поиск, замена и фильтрация данных 

таблицы………………………………………………………………………………………...164 

44. Создание схем данных. Установление связей между таблицами.  

Типы связей……………………………………………………………………………………167 

45. Создание схем данных. Установление связей между таблицами.  

Типы связей……………………………………………………………………………………167 

46. Создание запросов. Запросы на выборку данных………………………………………170 

47. Создание запросов с параметром………………………………………………………...175 

48. Вычисление в запросах. Создание итогового запроса………………………………….176 

49. Разработка отчетов. Просмотр отчета. Вывод отчета на печать……………………….180 

50. Зачетное  занятие  по теме: «СУБД MS Access»………………………………………..185 

51. Создание базы данных клиентов………………………………………………………...186 

52. Создание базы данных клиентов………………………………………………………...186 

53. Разработка таблиц учета стоимости оборудования, расходных  материалов, заработной 

платы сотрудников……………………………………………………………………………193 

54. Создание Web-документа. Общая структура сайта. Команды форматирования 

символов……………………………………………………………………………………….193 

55. Команды форматирования списков, таблиц, гипертекстовых связей………………….197 

56. Создание ящика электронной почты и настройка его параметров. Формирование 

адресной книги………………………………………………………………………………..203 

57. Защита информации в компьютерной системе от случайных угроз…………………..205 

58. Зачетное  занятие  по дисциплине «Информатика и  ИКТ  в профессиональной  

деятельности»…………………………………………………………………………………214 

 



ПРАКТИЧЕСКАЯ РАБОТА № 1 

Тема: «Работа с браузером. Работа с Интернет-СМИ, Интернет-библиотекой» 

 

Цель: научиться работать со стандартным браузером, а так же применять интернет-сми и 

интернет-библиотеки в работе. 

Оборудование: ПК 

Программное обеспечение: Internet Explorer  

 

Краткое содержание 

Браузер – это программа для просмотра web-страниц. 

Все браузеры позволяют выполнить некоторые настройки для оптимизации работы 

пользователей в Интернете. 

Первый веб-браузер был создан в 1989 году сэром Тимом Бернерс-Ли (Рис.1). Он 

назывался WorldWideWeb и позже был переименован в Nexus. Но первым 

распространённым браузером с графическим интерфейсом был NCSA Mosaic, он имел 

графический интерфейс (Рис.2). На его основе был разработан Рис.1 

самый популярный в свое время браузер Netscape Navigator, произошло это в 1994 

году. он имел ошеломительный успех и приносил неплохую прибыль компании его 

разработчика. 

 

Рис. 2 Браузер Mosaic            Рис.3 Браузер Navigator 

Компания Microsoft не могла не заметить такой успех Netscape Navigator и 

разработала свой собственный браузер в 1995 году, так же сделанный на основе NCSA 

Mosaic, и назывался он - Internet Explorer. Вследствие именно Internet Explorer (IE) стал 

неотъемлемой частью всех операционных систем этой компании. Так, как ОС Windows 

пользовалось огромное количество пользователей, IE быстро завоевал данную нишу и 

завоевал около 95% всего рынка. Это и привело к закрытию проекта Netscape Navigator, 

ведь конкурировать с такой монополией было невозможно. 

Впоследствии Netscape покупает компания AOL Time Warner, которая делает 

исходный код Navigator открытым. Далее AOL, в связи со своим закрытием, передает все 

права и свои разработки в новую компанию — Mozilla Foundation, которая продолжила 

развивать их идеи. 
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В 1996 году появилась Opera, которая, благодаря маленькому весу и быстрой 

загрузке страниц, стала в то время самой популярной альтернативой Internet Explorer в 

России и странах СНГ, да и по всему свету. 

В ноябре 2004 года появился веб-обозреватель Mozilla Firefox, который 

основывался на проекте Mozilla Suite. 

В 2006 году компания Apple выпустила свой продукт под названием Safari, а в 2008 

году на рынок вступила и компания Google, выпустив свое детище под названием Google 

Chrome. 

К сегодняшнему дню было создано и выпущено огромное множество различных 

интересных веб-обозревателей, каждый из них обладает своими уникальными функциями 

и особенностями. 

Самые популярные браузеры: 

 Google Chrome 

 Одна из самых быстрых, понятных и популярных программ такого рода. 

Обновления выходят практически каждую неделю и включают в себя самые лучшие и 

передовые инновации. Именно на основе Chrome сейчас делаются многие другие веб-

обозреватели, например такие как, Opera, Yandex.Browser, Orbitum и т.д. Славится 

огромным количеством приложений, расширений, тем и игр в своем маркете. 

Mozilla Firefox 

 Не менее популярный браузер, чем Google Chrome, так же быстр и красив. 

Имеет свой уникальный интерфейс и возможность расширения функционала за счет 

установки множества различных расширений. Именно Файрфокс в свое время сломал ход 

истории и преломил монополию Internet Explorer на рынке. Программа работает на 

всевозможных операционных системах и постоянно обновляется. 

Opera 

 Один из самых общеизвестных и востребованных браузеров в России и 

странах СНГ. Опера появилась более 20 лет назад, и, в процессе своего развития, сменила 

полностью движок на котором она до этого разрабатывалась. Opera обладает понятным и 

красивыми интерфейсом, очень быстрой скоростью работы, возможностью установления 

различных расширений и виджетов. Программа постоянно обновляется и имеет 

множество своих уникальных особенностей. Имеет в своем арсенале функцию «Turbo», 

которая значительно уменьшает время загрузки страниц. 

Safari 

 Браузер, который специально разрабатывался для операционной системы 

Mac OS, корпорацией гигантом Apple. В свое время была выпущена его версия и для ОС 

Windows, но, с 2012 года новые версии для этой ОС больше не выходили. Сафари 
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обладает самыми инновационными технологиями, уникальным интерфейсом и очень 

быстрой скоростью работы. Так же, отличительной его особенностью является 

«глянцевый интерфейс». 

  Internet Explorer 

Данный браузер был разработан компанией Microsoft. Последней версией является 

Internet Explorer 11. В Windows 10 Microsoft, в связи с нелюбовью пользователей, решила 

прекратить его дальнейшую разработку и выпустила уже полностью новый проект под 

названием Microsoft Edge. 

Перемещение пользователей в интернете осуществляется при помощи специальных 

программ – браузеров. Их количество сейчас исчисляется десятками. Но далеко не 

каждый браузер способен гарантировать приемлемую скорость, удобство и безопасность 

работы. 

 

Браузер начинают оценивать с удобства его интерфейса. Среднестатистический 

пользователь интернета проводит в нем достаточно много времени, поэтому удобство 

перемещения по страницам и использования прочих функций браузера имеет 

первостепенное значение. 

• Google Chrome славится своим “аскетичным” дизайном, без необязательных для 

использования кнопок. Если особо требовательный пользователь захочет использовать 

какую-нибудь непопулярную функцию, он может зайти в сервис расширений и 

установить ее. 

Хром по праву можно считать самым безопасным браузером. Он регулярно 

обновляется, имеет встроенный черный список вредоносных ресурсов. Если случайно или 

намеренно происходит скачивание исполняемого файла (.exe), то высветится сообщение с 

предупреждением, а действие надо будет подтвердить. 

С другой стороны, от самой компании Google, которая очень любит скрытно 

собирать статистические данные пользователей, защититься не получится. 

 Яндекс Браузер имеет некоторую схожесть с Хромом. Он несложен в освоении и 

вполне может использоваться новичками. Мобильная версия для Android и iOS избавилась 

от множества дополнительных вкладок и не перегружает устройства. 
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А чтобы работать в браузере было удобнее, добавили управление при помощи 

жестов.  

Яндекс Браузер отлично справляется с задачами безопасности. Система 

своевременно оповещает о мошеннических, фишинговых, хакерских сайтах. 

Любой файл, который пользователь загружает через браузер, сканируется 

антивирусной утилитой от Касперского. 

• На первый взгляд, в интерфейсе Оперы разобраться будет не просто. Перед 

глазами у пользователя встают множественные панели и кнопки, большинство из которых 

никогда ему не пригодятся. Придется потратить время, чтобы сделать подходящий для 

себя набор настроек, сняв галочки с ненужных пунктов. 

Это не только упростит работу, но и повысит производительность самого браузера. 

Opera позволяет проводить детальную настройку безопасности. Например, можно 

скрывать свою пользовательскую активность, удалять историю посещений, Cookies и кэш. 

Бреши и пробоины защиты оперативно заделываются, в чем способствует само 

сообщество пользователей. Обнаружив какую-либо уязвимость, любой сможет отправить 

пользовательский отчет. 

Для желающих получить полную анонимность, существует связка Opera – Tor.  

• Mozilla Firefox устанавливается на компьютер совершенно без дополнительного 

функционала. Исключение составляет панель закладок, которая пригодится любому 

пользователю, и настраиваемая поисковая панель. 

Поддерживается несколько различных тем оформления (скинов), которые легко 

можно изменить согласно собственным предпочтениям.  

Firefox пользуется той же технологией Safe Browsing, что применяется в Яндекс 

Браузере. Механизмы безопасности тоже на уровне. Но не стоит забывать о 

многочисленных обвинениях в адрес разработчиков браузера, поводом для которых 

послужила политика навязывания услуг сторонних компаний и сбор информации о 

пользователях без их на то согласия. 

Задания 

Задание №1 

     1. В каком городе родился Сальвадор Дали? 

     2. В каком году была открыта станция метро "Аэропорт" в Москве, и кто был автором 

проекта? 

3. Какие шесть романов написал Харуки Мураками? 

     4. Как ещё называлась улица Тверская в Москве? 

Задание №2 

     1. Почему старые путеводители называли Никольскую улицу "улицей просвещения"? 

     2. Кто изобрёл будильник? 

     3. Как называется колонна, стоящая на Дворцовой площади в Санкт-Петербурге? 
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     4. Из какого города приехал театральный режиссер Евгений Гришковец 

Задание №3 

     1. Что и в какой стране называлось "волчьим персиком"? 

     2. Где в Москве (метро, улица, дом) находится Библиотека Иностранной Литературы? 

     3. Как звали мать Пушкина? 

     4. Какие цветы и в честь кого называют растениями "далия"? 

Задание №4 

     1. Какой график работы у книжного магазина "Москва", находящегося на Тверской 

улице? 

     2. Когда и где появились первые очки от солнца? 

     3. Какое Интернет-кафе находится в Москве у станции метро "Новокузнецкая"? 

     4. К какому отряду относится птица киви? 

Вопросы для самоконтроля  

1. Что такое компьютерная сеть? 

2. Из каких частей состоит электронное письмо? 

3. Перечислить информационные услуги компьютерных сетей. 

4. Какие линии связи вы знаете? Чем они отличаются? 

5. Что такое протокол сети? 

6. Что такое Web-браузер? 

7. Какими способами можно найти нужную Web-страницу? 

8. Что такое компьютер-сервер? 

9. Правила создания электронного ящика 

10. Что такое Интернет? 

11. Почему в качестве линий связи чаще всего используются телефонные линии? 

12. Какая информация может присутствовать на Web-странице? 

13. Где располагается электронный ящик абонента? 

14. Что такое киберпространство? 

15. Для чего нужен сервер? 

16. Какая сеть называется региональной? 

17. Из каких частей состоит электронный адрес? 

18. Что такое модем? Для чего он нужен? Каковы характеристики современных 

модемов (скорость передачи данных)? 

19. Что такое гипермедиа? 

20. Какой язык является международным языком общения в сети Интернет? 

21. Как организована связь между страницами в Интернет? 

22. Чем локальная сеть отличается от глобальной? 

23. Перечислить технические средства компьютерных сетей. 

24. Что такое телеконференции? 

25. Достоинства электронной почты перед обычной? 

26. Что такое хост-машина? 

27. Что такое Гипертекст? 

28. Какую функцию выполняют поисковые программы? Какие поисковые программы 

вы знаете? 

29. Что такое терминал? 

30. Какие функции выполняет локальная сеть? 

31. Что такое Электронная почта? 

32. Правила работы с электронной почтой 

33. Какими возможностями обладает современный модем? 
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34. Что такое WWW? 

35. Что такое Web-сервер? 

 

 

ПРАКТИЧЕСКАЯ РАБОТА № 2 

Тема: «Работа с глобальной сетью Интернет. Поиск информации в сети Интернет 
с помощью поисковой  программы» 

 

Цель: освоить приемов работы с браузером Internet Explorer; изучение среды браузера и 

его настройка; выработать навыки извлечения web-страниц путем указания URL-адресов; 

навигации по гиперссылкам. 

Оборудование: ПК 

Программное обеспечение: Internet Explorer  

Теоретические сведения к практической работе 

 Настройка браузера. Все браузеры позволяют выполнить некоторые настройки для 

оптимизации работы пользователей в Интернете. В браузере Internet Explorer основная 

часть настроек содержится в меню Сервис – Свойства обозревателя. 

Вкладка Общие позволяет задать адрес домашней страницы, которая будет 

автоматически загружаться в окно браузера при его запуске, цвета гиперссылок по 

умолчанию, название шрифта по умолчанию. Здесь же определяется сколько дней будет 

храниться ссылка посещенных страниц в журнале. Кроме того, для ускорения просмотра. 

Все посещенные страницы помещаются в специальную папку, и с помощью кнопки 

Параметры можно задать разные способы обновления таких страниц. 

С помощью вкладки Безопасность можно создать списки надежных узлов и узлов с 

ограниченными функциями. Зона Интернет будет при этом включать все остальные узлы, 

не вошедшие в эти две папки. Для каждой из них с помощью кнопки Другой можно 

изменить параметры безопасности, установленные для них по умолчанию. Здесь можно 

запретить выполнение сценариев, отображение всплывающих окон, загрузку файлов и т.д. 

Вкладка Конфиденциальность дает возможность настроить работу с файлами cookie, 

с помощью которых информация о пользователе автоматически передается на сервер. 

Вкладка Содержание позволяет ограничить доступ к некоторой информации 

(насилие, ненормативная лексика и т.д.). 

Вкладка Подключения позволяет установить подключение к Интернету. 

На вкладке Дополнительно можно задать некоторые дополнительные параметры 

работы (отключить загрузку графических изображений, отменить подчеркивание ссылок, 

запретить отладку сценариев и т.д.). 

Вкладка Программы позволяет определить программы, которые будут по умолчанию 

использоваться службами Интернета (почтовые программы, html-редакторы и т.п.). 

Содержание работы: 

Задание №1. Изучите элементы среды Internet Explorer, возможности настройки этого 

браузера. Занесите в список надежных узлов сайты http://www.gismeteo.ru, 

http://www.yandex.ru. Запретите загрузку файлов. Заблокируйте всплывающие окна. 

Задание №2. Восстановите настройки Internet Explorer по умолчанию. 

Задание №3. Зайдите на сайт интернет-библиотеки по адресу http://www.internet-

biblioteka.ru, зарегистрируйтесь. Изучите правила работы с библиотекой. Найдите книгу 

Комоловой Н. "Компьютерная верстка и дизайн. Самоучитель". Скачайте ее. Составьте 

список книг библиотеки по информатике. 
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Задание №4. Изучите новости Смоленской области, открыв, например, адрес 

http://www.smolnews.ru/. Сохраните последние новости в документе MS Word. 

Задание №5. Зайдите на сайт турагентства по адресу http://agency.travelplus.ru. Изучите 

возможности организации турпоездок на ближайший месяц по России. Сохраните 

ближайшие туры в текстовом документе. 

 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА  № 3 

Тема:  «Создание  и сохранение  файла MS Word. Форматирование текста и 

документа (символов и абзацев). Изменение  шрифта, выравнивание.  Разметка  

страницы  перед набором текста». 

 

Цель:  Приобретение практических навыков работы по созданию и форматированию 

документов в программе MS Word, изменению  шрифта, выравнивания.  Разметка  

страницы  перед набором текста. 

 

Краткие теоретические сведения. 

 

▪ Запуск текстового процессора Microsoft Word. 

 Запуск текстового процессора Word осуществляется с помощью команды Пуск – 

Программы – Microsoft Office – Microsoft Office Word. 

 

▪ Создание, сохранение документа. 

Для создания нового документа выполняют команду Офис  – Создать или щелкают 

на кнопке Создать на панели инструментов. 

Для сохранения нового документа выполняют команду Офис – Сохранить или 

щелкают на кнопке Сохранить на панели инструментов. В окне Сохранение документа 

указывают папку, в которую необходимо сохранить документ, и вводят имя документа. 

Вызвать окно сохранения файла (команда Сохранить как)  можно   с помощью 

функциональной клавиши F12. 

 

▪ Форматирование текста. 

Редактирование – добавление, удаление, перемещение или исправление текста или 

графики. 

Форматирование – изменение внешнего вида.  

Форматирование и редактирование могут быть применены к различным 

структурным единицам текста: символу, абзацу, таблице, рисунку, документу целиком. 

 

▪ Форматирование символов. 

Символы – это буквы, пробелы, знаки пунктуации, цифры, специальные символы. 

Среди основных параметров форматирования символов можно выделить: шрифт 

(гарнитура), кегль, начертание. 

 

▪ Шрифт. 

Шрифт – полный набор символов определенного начертания, включая прописные 

и строчные буквы, знаки препинания, специальные символы, цифры и знаки 

арифметических действий. Шрифты разделяются на две большие группы: шрифты с 

засечкой и рубленые (без засечки). 

Виды шрифтов: 
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▫ шрифты с засечками: Times New Roman, Courier New и др.; 

▫ рубленые шрифты: Heletica, Arial и др. 

 

▪ Размер шрифта (кегль). 

Единицей измерения шрифта является пункт (пт). В российской системе пункт 

равен  

0,376 мм.  

Кегль – это величина площадки, на которой размещается символ (буква) с учётом 

свисающих, надстрочных и подстрочных элементов. 

 

▪ Начертание. 

Полужирное, Курсивное, Подчеркнутое. 

 

▪ Способы форматирования символов. 

В текстовом процессоре Word по умолчанию символы оформляются шрифтом 

Times New Roman, размер 12 или 14  пт, нормальное начертание.  

 Для изменения установок используют способы: 

1 способ. Щелчком по кнопке  на вкладке  Главная – Шрифт, вызываем диалоговое 

окно Шрифт, в котором на вкладке Шрифт можно выбрать шрифт, размер, начертание, 

цвет символов, варианты подчёркивания и другие эффекты, на вкладке Интервал можно 

установить интервал между символами. 

 
  

Рис. 1. Группа кнопок Шрифт 

 

   
Рис.2 Диалоговое  окно Шрифт 

Замечание.  Для изменения форматирования уже набранных символов необходимо их 

выделить и выбрать нужное форматирование. 

2 способ. С помощью кнопок группы Шрифт вкладки Главная. В списке Шрифт 

выбирают нужный шрифт, в списке Размер выбирают или вводят нужный размер, 

кнопками Полужирный, Курсив, Подчёркнутый выбирают нужное начертание. 
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▪ Формирование абзацев. 

В компьютерных программах, абзацем считается любой текст, заканчивающийся 

маркером абзаца (нажатием клавиши Enter). Маркер абзаца отображается символом ¶ (при 

включённом режиме непечатаемых знаков). К форматированию абзаца относят следующие 

параметры форматирования: отступы (расстояние от поля до текста), выравнивание текста, 

междустрочный интервал. 

 

▪ Выравнивание абзаца. 

Выравнивание текста – это способ, с помощью которого устанавливаются относительно 

друг друга начало и окончания строк. 

Существует 4 способа выравнивания абзацев: 

– по левому краю – устанавливает начало строк по одной вертикальной линии 

(распространен в англоязычных странах); 

– по правому краю – устанавливает окончание строк по одной вертикальной линии 

(применяют для небольших примечаний); 

– по центру – центрирует строки между левыми и правыми полями (применяют для 

заголовков); 

– по ширине – устанавливает начало и окончание строк по своим вертикальным линиям. 

 

▪ Отступ первой строки  (красная строка) может быть: 

– положительным, когда первая строка начинается правее всех остальных строк абзаца, 

применяется в обычном тексте; 

– отрицательным (выступ), когда первая строка выходит влево относительно остальных 

строк, применяется в словарях, определениях; 

– нулевым, для абзаца, выровненных по центру и обычного текста. 

 

▪ Способ форматирования абзацев. 

1 способ. С помощью Строки меню. Выполняют команду  

Главная  – Абзац.  Появляется диалоговое окно Абзац, 

которое имеет две вкладки Отступы и интервалы и 

Положение на странице. На вкладке Отступы и интервалы 

в поле Отступ устанавливают отступ текста от левого 

(правого) поля, в поле Интервал перед (после) 

устанавливают величину расстояния перед первой строкой 

для каждого выделенного абзаца, в поле Междустрочный 

вводят значение интервала между строками текста, в поле 

Первая строка: на вводят значение отступа первой строки, 

в поле Выравнивание выбирают нужный способ 

выравнивания выделенного текста. 

2 способ. С помощью Группы  команд Абзац вкладки Главная устанавливают 

нужное выравнивание на соответствующей кнопке панели (По левому краю, По центру, 

По правому краю, По ширине). 

С помощью Линейки. Верхний маркер линейки устанавливает величину отступа  первой 

строки.  

 

 
 

Левый (правый) нижний устанавливает отступ текста от левого (правого) поля. Чтобы 

добавить границы и заливку к тексту, его предварительно выделяют и выполняют команду 

Разметка страницы – Границы страниц -  заливка. 
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 Рис. 3. По  Диалоговое окно Абзац.   

Задания. 

Задание 1. Создание документа, набор и форматирование текста согласно образцу. 

Задание 2 (А, Б). Набор и форматирование текста. 

Задание 1. Создание документа, набор и форматирование текста. 

▪ Загрузите текстовый процессор MS Word. 

▪ Создайте новый документ и сохраните его с именем «Первый документ» в своей рабочей 

папке. 

▪ Наберите предложение «Информатика – мой любимый предмет!» 

▪ Скопируйте данное предложение 6 раз, друг под друга. 

▪ Видоизмените слово «информатика» согласно параметрам, написанным в скобках. 

Информатика - мой любимый предмет! (зачеркнутый). 

ИИннффооррммааттииккаа - мой любимый предмет! (с тенью). 

Информатика - мой любимый предмет! (двойное зачеркивание). 
Информатика

 - мой любимый предмет!  (надстрочный). 

Информатика - мой любимый предмет! (подстрочный). 

И н ф о р м а т и к а  – мой любимый предмет! (междусимвольный интервал  - 

разреженный на 7 пт). 

Информатика – мой любимый предмет! (подчеркивание волнистое, синего цвета). 

Задание 2. Набор и форматирование текста. 

(А) 

▪ Создайте новый документ и сохраните его с именем «Интернет» в своей рабочей папке. 

▪ Установите следующие параметры страницы: левое, правое поле – 2 см, верхнее, нижнее 

поле – 1,5 см. 

▪ Наберите текст согласно образцу. 

▪ Добавьте в ваш документ пять новых страниц. 

▪ Скопируйте данный текст 4 раза (каждый раз на новую страницу). 

▪ Отформатируйте текст на второй странице, установив следующие параметры 

форматирования: шрифт – Garamond, размер шрифта – 14 пт, начертание – полужирный 

курсив, междусимвольный интервал – разреженный на 2 пт, цвет текста – синий, 

выравнивание – по ширине, красная строка – 2 см, междустрочный интервал – 

полуторный. 

▪ Добавьте к тексту на третьей странице волнистую рамку и заливку серого цвета. 

▪ Вставьте в конце первого абзаца символ. 

▪ Проверьте правописание в документе. 

Образец. 

Интернет - всемирная компьютерная сеть, составленная из связанных друг с другом 

сетей, включающих компьютеры, работающие под управлением  разных операционных 

систем. Интернет - это сеть сетей. 

С точки зрения пользователя Интернет представляет собой совокупность крупных 

узлов, объединённых между собой каналами связи. Каждый узел - это один или  несколько 

мощных компьютеров-серверов. Управляют узлом или подсетью узлов его собственник - 

организация, которая называется провайдером, или поставщиком услуг Интернет. Во 

многих случаях название отдельной сети - это  название  её  провайдера. Провайдеры за 

определённую плату и обслуживают  коллективных и индивидуальных пользователей 

Интернет, обеспечивают их определенным набором услуг.  

Задание3. Изменение  параметров  абзаца  

1.Наберите абзац текста из 5-ти строк 

2.Скопируйте абзацы и вставьте 5 раз 

3.Произведите во втором абзаце следующие преобразования, выделяя нужные слова 
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первые два слова оформить полужирным шрифтом; 

вторые два слова - курсивом; 

третьи два слова - подчеркиваем; следующие два слова – курсивом + полужирный + 

подчеркиванием  

4.Задайте в первом абзаце разные виды подчеркивания  

Первое – с пунктирным подчеркиванием,   

Третье – с двойным подчеркиванием, 

5.Наберите слово «эффект». Скопируйте его, пять раз, и наложите следующие 

видоизменения  

Эффект (зачеркнутый); 

Э
ффект 

(верхний индекс); 

эффект (нижний индекс); 

эффект (малые прописные); 

эффект (прописные + контур + полужирный). 

Краткая справка. Копирование текста складывается из четырех операций: 

 Выделяя текста для копирования; 

 Запись фрагмента в буфер памяти; 

 Установка курсора в место вызова копируемого фрагмента; 

 Вызов из буфера памяти  

6.Наложите на первую строку первого абзаца эффект ««сс  ттееннььюю»» 

Краткая справка. Выделение строки текста производится одинарным щелчком мыши 

слева от строки. 

7.В исходном тексте установите на слово «Интернет» интервал разрежения на 10 пт. 

8.На слова «Провайдеры» установите волнистое подчеркивание и синий цвет шрифта. 

9.Выделите второй абзац текста и измените гарнитуру шрифта на Arial.  

10.Выделив первый абзац текста, установите следующие параметры абзаца: 

Первая строка – отступ стандартный; 

Межстрочный интервал - полуторный; 

Выравнивание - по ширине 

Краткая справка. Выделение абзаца текста производится двойным щелчком мыши  слева 

от абзаца. 

11. Выделив третий абзац текста, установите следующие параметры абзаца: 

Первая строка - отступ стандартный; 

Межстрочный интервал – одинарный; 

Выравнивание – по левому краю. 

12. Выделив пятый абзац текста, установите следующие параметры абзаца: 
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Первая строка - нет; 

Межстрочный интервал – двойной; 

Выравнивание – по правому краю. 

13. Выделив шестой абзац текста, установите следующие параметры абзаца: 

Первая строка – отступ на 2,5 см; 

Межстрочный интервал – множитель 1,3; 

Выравнивание – по центру. 

14. Выделив второй абзац текста, установите следующие параметры абзаца: 

Первая строка – отступ на 1,5 см; 

Отступ справа – 4 см; 

Межстрочный интервал – множитель 1,8; 

Выравнивание – по ширине. 

15. Выделив четвёртый абзац текста, установите следующие параметры абзаца: 

Первая строка – отступ на 2 см; 

Отступ справа – 3 см; 

Отступ слева – 6 см; 

Межстрочный интервал –  множитель 2,5; 

Выравнивание – по ширине. 

Задание 4. Обрамление абзацев. 

Выделяя абзацы текста, установите следующие параметры рамки  

                        Первый абзац: 

Тип линии – обычная линия; 

Цвет – авто;  

Ширина – 0,5 пт.; 

Применить – к абзацу; 

Тип обрамления  - рамка. 

                           Третий абзац  

Тип линии – обычная линия; 

Цвет – синий; 

Ширина – 2,25 пт.; 

Применить – линии слева и снизу. 

                            Пятый абзац: 

Тип линии – пунктирная линия; 

Цвет – красный; 

Ширина – 1,5 пт.; 
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Применить – к абзацу; 

Тип обрамления – линии слева и справа. 

Задание 5.  Заливка абзацев. 

Выделяя абзацы текста, установите следующие параметры заливки. 

                    Второй абзац: 

Заливка - светло-желтый цвет; 

Узор – 10%применить – к абзацу  

                     Четвертый абзац: 

Заливка – светло-голубой цвет; 

Узор – нет 

Применить – к тексту 

                        Шестой абзац: 

Заливка – сиреневый цвет 

Узор – светлый по диагонали вниз 

Применить – к абзацу 

Задание 10.4 Задание межабзацных расстояний. 

Выделите весь текст и задайте межабзацное расстояние 24 пт. 

(Б)  

▪ Перейдите на новую страницу. 

▪ Наберите текст согласно образцу. 

 

Образец. 

Решение квадратного уравнения. 

Чтобы решить квадратное уравнение вида: ax
2
+bx+c=0 необходимо сначала 

вычислить дискриминант по формуле: D=b
2
-4ac. 

Если D<0, то уравнение не имеет вещественных корней. 

 

Контрольные вопросы. 

 

1. Что такое редактирование текста? 

2. Как выделить блок текста? 

3. Как переместить, скопировать, удалить блок текста? 

4. Какое расширение имеет документ программы Word?  

5. Как установить параметры страницы? 

6. Что такое форматирование? 

7. Как установить красную строку? 

8. Какие параметры форматирования текста вы знаете? 

9. Какие параметры форматирования абзаца вы знаете? 

10. Как задать границы и заливку тексту? 

11. Как вставить в текст символ, которого нет на клавиатуре? 

12. Как проверить правописание в документе? 
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Практическая работа № 4 

Тема: Создание документа в Word. Набор и редактирование документа. Сохранение 

документа на диске. 

Цель: знакомство с основными приемами редактирования текста, 

набор текста по образцу с помощью текстового редактора. 

 

Ход работы. 

Задание №1. 

1. Установите режим Разметка страницы (Вид-разметка страницы). 

2. Установите масштаб По ширине (Вид – Масштаб – По ширине). 

3. Установите поля страницы по 2 см (Файл – Параметры страницы, вкладка Поля). 

4. Установите книжную ориентацию страницы и размер бумаги А4 (Файл – 

Параметры страницы, вкладка Размер бумаги). 

 

Задание №2. Напечатайте фразу: Я изучаю текстовый редактор Microsoft Word. 

Скопируйте данную фразу и вставьте еще 5 таких же. 

Указания: 

 Предварительно выделите данную фразу одним из ниже описанных способов (см. 

ниже «Выделение фрагментов текста») 

 Скопируйте ее в буфер обмена (Правка – Копировать) 

 Снимите выделение текста щелчком мыши в пустом месте страницы 

 Установите курсор на новую строку (переместите курсор в коней фразы и 

нажмите клавишу  Enter) 

 Вставьте фразу из буфера обмена (Правка – Вставить) 

 

Выделение фрагментов текста 
 

Существуют различные способы выделения: 

 Подвести указатель мыши к началу фрагмента текста, который вы хотите выделить, 

нажать левую кнопку мыши и, не отпуская ее, перемещать указатель до конца 

выделения. 

 Для выделения слова следует дважды щелкнуть на нем левой кнопкой мыши. 

 Для выделения всего предложения следует выполнить щелчок на любом символе 

предложения при нажатой клавише Ctrl. 

 Чтобы выделить целую строку, следует поместить указатель мыши слева от первого 

слова строки, чтобы появилась белая стрелка и нажать левую клавишу мыши. 

 Для выделения целого абзаца следует поместить курсор мыши слева от 

выделяемого абзаца и выполнить двойной щелчок. 

 Для выделения всего текста удобнее воспользоваться меню Правка – Выделить всё 

 

Задание №3. Измените параметры шрифта (название шрифта, его размер, стиль, 
цвет, подчеркивание, эффекты) для первой фразы, набранной в предыдущем 
задании (задание №2) 
Указания: 

 Выделите первую строку, меню Формат – Шрифт 

 Выберите шрифт - Garamond, размер – 16, начертание – полужирный, цвет 

символов – синий, подчеркивание – пунктирное, эффект – с тенью. 

 

Задание №4. Наберите ниже указанный текст в рамочке и выровняйте его по ширине. 
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Установите красную строку 2 см. Затем скопируйте текст и выровняйте его остальными 

способами. 

 

Указания: 

 Установите курсор внутри абзаца, Формат – Абзац, вкладка Отступы и 

интервалы. 

 В раскрывающемся списке Выравнивание выберите По ширине. 

 В раскрывающемся списке Первая строка выберите Отступ. 

 В списке На установите 2 см. 

 

Важно различать конец абзаца и конец строки внутри абзаца. Текст, который не 

помещается в данной строке, автоматически переносится на новую строку, поэтому для 

перехода на новую строку в пределах одного абзаца клавиша Enter не нажимается. 

Клавишу Enter нужно нажимать только в конце абзаца. 

_____________________________________________________________________________

_______________________________ 

Существует 4 способа выравнивания абзацев: 

 По левому краю – левый край текста ровный, а правый как получится. 

 По центру – весь текст выровнен по центру. 

 По правому краю – правый край текста ровный, а левый как получится 

 По ширине – оба края ровные. 

 

Задание №5. Напечатайте текст, руководствуясь указаниями: 

 

Ш У Т О Ч Н Ы Е  В О П Р О С Ы  

 

К а к и е  ч а с ы  п о к а з ы в а ю т  в е р н о е  в р е м я  т о л ь к о  

д в а  р а з а  в  с у т к и ?  

( К о т о р ы е  с т о я т )  

Ч т о  н у ж н о  с д е л а т ь ,  ч т о б ы  о т п и л и т ь  в е т к у ,  

н а  к о т о р о й  с и д и т  в о р о н а ,  н е  п о т р е в о ж и в  е ё ?  

( П о д о ж д а т ь ,  п о к а  о н а  у л е т и т )  

В  к о м н а т е  г о р е л о  7  с в е ч е й .  П р о х о д и л  м и м о  

ч е л о в е к ,  п о т у ш и л  2  с в е ч и .  С к о л ь к о  с в е ч е й  

о с т а л о с ь ?  

( Д в е ,  о с т а л ь н ы е  с г о р е л и )  

Указания: 

1. Установите автоматический перенос слов (Сервис – Язык – Расстановка  

переносов, активизируйте флажок Автоматическая расстановка переносов). 

2. Напечатайте весь текст от левой границы страницы, разбив его на 7 абзацев. 

3. Выделите весь текст (вместе с заголовком) и установите: 

 Абзацные отступы слева и справа по 1,5 см (Формат – Абзац, вкладка Отступы и 

интервалы, группа Отступ: слева – 1,5 см, справа – 1,5 см). 

 Красную строку 1 см (Первая строка – есть, Отступ - 1 см). 

4. Выровнять вопросы по ширине, ответы – по правому краю, заголовок по центру. 

5. Установите начертание для вопросов – обычный, для ответов – курсив. 

6. Оформите заголовок: 

 Прописными буквами (Формат – Шрифт, вкладка Шрифт, эффект – все 

прописные). 

 В разрядку (Формат – Шрифт, вкладка Интервал, в списке Интервал выберите 

Разряженный, в списке На установите 3 пт). 
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7. Оформите текст рамкой: 

 Выделите весь текст вместе с заголовком. 

 Меню Формат – Границы и заливка, вкладка Граница, в группе Тип установите 

Рамка, выберите Тип и Цвет линии для рамки). 

  

 

Задание №6. Оформите приглашение, руководствуясь указаниями. 

Указания: 

1. Активизировать панель Рисование, если она отсутствует на экране (Вид – Панели 

инструментов – Рисование или щелкните по кнопке Рисование) 

2. Щелкните по кнопке Автофигуры – Основные фигуры и выберите Ромб. 

3. Измените параметры ромба следующим образом (все изменения производятся 

только при выделенном объекте): 

 Выделите ромб (установите указатель мыши на ромб так, чтобы он принял форму 

стрелки с перекрестием и щелкните – должны появиться белые маркеры). 

 Измените размер ромба, сделав его больше или меньше (установите указатель 

мыши на один из маркеров, чтобы появилась двойная стрелка, нажмите левую 

кнопку мыши и растяните ромб). 

 Щелкните по кнопке Цвет заливки и выберите Нет заливки. 

 Щелкните по кнопке Цвет линий и выберите серый 25%. 

 Щелкните по кнопке Тип линии и выберите толщину 3 пт. 

4. Сделайте несколько копий ромба: 

 Выделить ромб. 

 Меню Правка – Копировать. 

 Меню Правка – Вставить, данную команду выполните несколько раз (ромбы будут 

вставляться по диагонали). 

5. Составьте узор из скопированных ромбов, перемещая их мышью. 

6.  Выделите рисунок (щелкните по кнопке Выбор объектов и растяните рамку вокруг 

рисунка так, чтобы он полностью в нее поместился – все ромбы выделяются 

маркерами). 

7. Сгруппируйте рисунок (щелкните по кнопке Действия – Группировать, маркеры 

появятся вокруг всего рисунка). 

8. Переместите рисунок на текст и поместите рисунок позади текста (Действия – 

Порядок – Поместить за текстом). 

9. Нарисуйте рамку для всего приглашения (выделите весь текст, щелкните по кнопке  

Формат – Границы и заливка). 
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ПРИГЛАШЕНИЕ 

Дорогие друзья! 

Приглашаю Вас на чаепитие 

По случаю моего совершеннолетия. 

Буду ждать в субботу, 

7 января 1998 г. в 14 часов. 

Отличное настроение обязательно! 

 

Оксана            

 

 Задание №7. Вставьте колонтитулы: 

 

 Меню Вид – Колонтитулы (появится панель инструментов Колонтитулы). 

 В Верхнем колонтитуле напишите Ф.И.О., курс, группу. 

 Перейдите в нижний колонтитул (щелчок по кнопке Верхний/Нижний колонтитул). 

 Вставьте номер страницы (щелчок по кнопке Номер страницы) 

 Для выхода из режима колонтитулов щелкните по кнопке Закрыть. 

   

  Задание №8.  Напечатайте текст и разбейте его на колонки: 

 

Общая характеристика информационных технологий обучения. 

Систематические исследования в области компьютерной поддержки профессионального 

образования имеют более чем 30-летнюю историю. За этот период в учебных заведениях 

США, Франции, Японии, России и ряда других стран было разработано большое 

количество компьютерных систем учебного назначения, ориентированных на различные 

типы ЭВМ. 

 

Указания: 

1. Выделить текст вместе с заголовком. 

2. Меню Формат – колонки. 

3. В группе тип выберите Три или в списке Число колонок установите 3. 

4. Активизируйте флажок Разделитель. 

 

Задание №9. Сохраните свою работу в указанной папке (Файл – Сохранить как – папка 

Мой компьютер – диск С – папка с номером вашей группы). 

 

Контрольные вопросы. 

1. Для чего нужна прикладная программа MS Word? 

2. Как просмотреть содержимое текстового файла на экране? 

3. Какие форматы файлов поддерживает MS Word при открытии файлов ? 

4. Как создать новый документ, используя программу MS Word? 

5. Как установить параметры страницы для создаваемого документа? 

6. Как установить шрифт, размер и цвет текста в набираемом документе? 

7. Как отформатировать набранный текст. 
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ПРАКТИЧЕСКАЯ РАБОТА №5 

Тема: «Перемещение, копирование блоков текста. Вставка спецсимволов и 
буквицы, сносок и разрывов. Обрамление и заполнение текста в виде газетных 
полос. Колонтитулы». 
 

Цель:  

приобретение  практических навыков:  

 копирования блоков текста различными способами; формирование  навыка 

вставки спецсимволов, буквицы; 

 создание различных разделов  с помощью команды Разрывы (страницы, 

раздела, колонки…); 

 установки оформления  с  помощью колонок; 

 создания и редактирования  колонтитулов. 

 

Задание1.  Копирование  текста. 

Заполните таблицу Способы копирования текста. 

Способ копирования Последовательность выполнения 

С помощью строки 

меню  

 

С  помощью 

контекстного меню  

 

С помощью комбинации 

клавиш  

 

Другие способы  

 

Задание2.  Создание колонтитулов. 

                 Порядок работы 

1. Установите вид документа – «Разметка страницы» 

2. Задайте колонтитулы документа (вставка – Верхний  колонтитул). Изучите 

назначение кнопок панели Работа с колонтитулами, подводя к ним курсор мыши. 

В колонтитулы введите следующую информацию: 

В верхний колонтитул – Ф.И.О., дата, время. 

В нижний колонтитул – названия учебного заведения и номера страниц. 
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Краткая справка. Обратите внимание, что при вводе колонтитулов основной цвет 

приобрёл бледный цвет и стал недоступен. 

Окончание работы с колонтитулом производится кнопкой Закрыть панели 

колонтитулы. Колонтитулы видны только в виде Разметка страницы.  

 

3. Установите параметры страницы и расстояния от края до колонтитула. 

4. Измените вид экрана на обычный. Обратите внимание, что колонтитулы не видны 

в обычном виде документа. 

Задание3.  Заполнение   текста в виде газетных полос. 

 
▪ Оформление текста в виде колонок. 

  

Перед оформлением текста в виде колонок 

необходимо установить разрыв раздела в конце 

абзаца (для этого устанавливают курсор в конце 

абзаца и выполняют команду Вставка – Разрыв – 

Новый раздел на текущей странице). Далее 

выделяют текст и выполняют команду Формат – 

Колонки. В появившемся диалоговом окне 

Колонки выбирают тип колонок, расстояние 

между ними, разделитель между колонками. 

1. Скопировать и вставить несколько раз блок 

текста. 

2. Второй  и третий  абзацы оформить в  

вилле газетных полос с разными размерами . 

3. Сохраните набранный документ в своей 

папке с именем. 
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ПРАКТИЧЕСКАЯ РАБОТА № 6 

 

Тема:  «Создание таблиц в редакторе MS Word. Форматирование таблицы». 
 

Цель:  

 Приобретение практических навыков работы по созданию и форматированию 

таблиц в  программе MS Word.  

 Формирование  навыков создания таблиц, выполнения  различных операций  с 

ячейками таблицы (вставка и удаление, объединение, разбиение ячеек, изменение 

направления текста); 

 Формирование  умения  задания различных типов обрамления и заливки; 

 Закрепить навыки использования рациональных приемов  работы. 

 

Краткие теоретические сведения 

 

Таблица - это перечень данных (текстовых, числовых, графических), приведенных в 

определенную систему и разнесенных по графам.  

Элементы в таблице организованы в строки и столбцы. Пересечение строки и 

столбца в таблице образует ячейку (основной элемент таблицы), в которую можно 

поместить текст, графику или другие данные. 

 

▪ Создание таблицы в документе MS Word. 

Существует несколько  способов создания таблиц:  

▪ С помощью меню. Выполняют команду – Вставка - Таблица, указав в соответствующих 

полях ввода число строк и столбцов создаваемой таблицы. 

▪  с помощью  Команды Вставка  таблицы   с помощью  команды Нарисовать 

таблицу  
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При создании таблицы  появляется  дополнительная  панель – Работа  с  таблицами, 

содержащая 2  вкладки -  Конструктор и Макет. Здесь  содержатся все  кнопки для 

выполнения  операций с  таблицами. 

 

 
Рис.1. Работа с  таблицами 

 

 

▪ Форматирование текста в ячейке таблицы. 

 Чтобы изменить направление текста в ячейке, выделяют текст и выполняют 

команду Макет – Направление текста. В появившемся диалоговом окне Направление 

текста выбирают нужное направление. 

 

▪ Форматирование элементов таблицы. 

Выделение строки/столбца/ячейки:  

1 способ. С помощью меню.  

Пользуясь меню Макет – Выделить можно выделить ячейку,  строку (столбец), в которой 

предварительно установлен курсор, или всю таблицу целиком.  

2 способ. С помощью мыши.  

Если для выделения воспользоваться мышью - наводят указатель мыши левее строки 

(выше столбца) и щелкают мышью в тот момент, когда указатель примет форму стрелки, 

указывающей на выделяемый участок. Для выделения ячейки устанавливают указатель на 

левый край ячейки (указатель должен иметь форму стрелки) и нажимают кнопку мыши. 

 

Способы выделения таблицы целиком. 

 

1 способ. Устанавливают курсор в любую ячейку и выполняют команду Макет - 

Выделить - Выделить таблицу. 

2 способ. Выделяют крайний столбец при помощи мыши и, не отпуская левой клавиши, 

протаскивают выделение до другого края таблицы. 

3 способ. Выделяют крайнюю строку при помощи мыши и, не отпуская левой кнопки, 

протаскивают выделение до другого края таблицы. 

4 способ. Кликнуть 1 раз левой  кнопкой  мыши по значку таблицы . 

 

▪ Изменение ширины столбца (высоты строки). 

 Подводят указатель мыши к линии, разделяющей два столбца и в тот момент, когда 

указатель примет вид двойной стрелки, нажав левую клавишу мыши, перемещают границу 

столбца. Задать точную ширину столбца (высоту строки) можно с помощью команды 

Макет – Размер  ячейки - Высота и ширина ячейки. 

 

▪ Вставка строки/столбца в имеющуюся таблицу. 

 Установив  курсор или выделив строку (столбец), выполняют команду п.к.м. -  Вставить 

строку (столбец). Если выделить столбец (строку, несколько столбцов или строк,  

диапазон ячеек  на разных строках), то выбор инструмента  автоматически добавляет в 
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таблицу столбец (строку, несколько столбцов или строк). 

Вставить строки  в конец  таблицы  можно при помощи клавиши Tab. 

▪ Удаление таблицы (строк, столбцов, ячеек). 

Выделяют таблицу (строку, столбец, несколько строк или столбцов) и выполняют 

команду п.к.м. - Удалить столбцы (строки, ячейки, таблицу). 

 

▪ Добавление границ  и заливки в таблицы. 

 Обрамление и заливку можно добавить к таблице автоматически, с помощью 

команды Работа с  таблицами – Конструктор - Стили таблиц, которая предоставляет 

множество вариантов оформления таблицы.  

Можно выполнить подобную работу вручную. Чтобы добавить к таблице, видимые 

на печати линии сетки вокруг ячеек или заливку, выделяют таблицу целиком и выполняют 

команду Разметка страницы – Границы страниц – вкладка Заливка. В диалоговом окне 

Границы и заливка выбирают требуемые параметры: тип обрамления (Нет, Сетка, Рамка), 

положение и тип линий, заливка ячеек; их можно применить ко  всей таблице или 

отдельной ячейке.  

 

▪ Объединение ячеек таблицы. 

Чтобы объединить несколько ячеек в одну, их предварительно выделяют и 

выполняют команду  Макет – Объединить ячейки или в контекстном меню (п.к.м) 

выделенных ячеек выбирают пункт Объединить ячейки. 

 

▪ Разбиение ячеек таблицы. 

Чтобы разбить ячейки на несколько их предварительно выделяют и выполняют 

команду Макет – Разбить ячейки или в контекстном меню выделенных ячеек выбирают 

пункт Разбить ячейки. В появившемся диалоговом окне Разбиение ячеек указывают число 

столбцов и строк, на которые следует разбить выделенные ячейки.  

 

▪ Разбиение таблицы. 

Если таблица не помещается на листе её можно разбить на несколько таблиц. Для 

этого устанавливают курсор на строку, перед которой должна быть разбита таблица и 

выполняют команду Макет  – Разбить таблицу. 

 

▪ Указание свойств таблицы. 

Указание свойств таблицы выполняется командой Таблица – Свойства таблицы 

(или в контекстном меню таблицы выбирают пункт Свойства таблицы). В появившемся 

диалоговом окне Свойства таблицы можно указать: 

– на вкладке Таблица – размер таблицы, её положение на листе, обтекание текстом,  

границы и заливку, параметры полей ячеек таблицы; 

– на вкладке Строка – высоту строки; 

– на вкладке Столбец – ширину столбца; 

– на вкладке Ячейка – ширину ячейки и выравнивание текста в ячейке. 

Если таблица  располагается на нескольких страницах, и нужно повторять заголовок  на  

каждой  из них,  в окне Свойства таблицы – вкладка Строка – ставим флажок  

Повторять как  заголовок  на каждой  странице  (только для первой  строки!). 

 

Задания. 

 

 

 

Задание 1. Создание макета таблицы. 
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Задание 2. Создание и заполнение таблиц данными. 

 

Задание 1. Создание макета таблицы. 

▪ Загрузите программу MS Word. 

▪ Сохраните офис с именем «Таблицы» в своей рабочей папке. 

▪ Создайте таблицу, состоящую из 5 столбцов и 8 строк. 

▪ Преобразуйте таблицу согласно образцу (рис. 2), применяя операции объединения и 

разбиения ячеек. 

▪ Добавьте заливку к ячейкам, измените внешние границы таблицы согласно образцу. 

▪ Отформатируйте таблицу, указав следующие параметры форматирования – ширина 

первого столбца – 3 см; ширина таблицы – 15 см. 

 

 

        

 
 

    

 

 

 

 

           

            

           

   

    

 

 

Рис.2. Шаблон таблицы. 

 

Задание 2. Создание и заполнение  таблиц с данными. 

 

▪ Добавьте в документ «Таблица» новую страницу. 

▪ Создайте таблицу согласно образцу (рис. 3). 

 

 

Номера групп 

 

О
б

щ
ее

 к
о
л
-в

о
 

Январь 100 

1 2 3 4 5 6 7 8 

 

Февраль 200 

Понедельн

ик 

Вторник 

 

Март 300 

 

Рис. 3. Шаблон таблицы. 

 

Задание 3.Создание  документов, содержащих таблицы 

  Оформить документ, содержащий таблицу, по образцу. Произвести расчет штатной 

численности по каждой группе оплаты труда. 

Краткая справка.  Верхнюю часть документа оформите с использованием таблицы (тип 

линий - нет границ). Произведете расчет суммы по столбцам. Дату вставьте командой 

Вставка/Дата. 
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Образец  

ОАО «Прогресс» 

21.12.2010 № 38 

Москва 

 Утверждаю 

Генеральный директор  

                               _____ Б. Н. Добров 

03.11.2011 

Структура и штатная численность ОАО «Прогресс» на 2011г. 

Наименование 

должностей 

Штатная численность и группы по оплате труда 

Первая Вторая  Третья Четвертая Пятая 

Генеральный 

бухгалтер 
1     

 Сотрудники 

бухгалтерии 
1 2 2   

Старшие 

специалисты 
 3 7 1  

Специалисты   4 5 6 

Итого      

Задание 4.   

Набрать таблицы  по образцу, применив  различные типы  обрамления и заливки. 

Таблица 1 

Таблица 2 

     

  

   

   

 

Таблица 3 

      

     

    

 

            

          

 

  

Контрольные вопросы: 

1. Как создать таблицу в  текстовом редакторе Word? 

2. Какие операции с ячейками таблицы можно выполнить с помощью вкладок  

Конструктор и Макет? 

3.  Как можно  удалить строку (столбец)? Несколько  строк  или столбцов?  

Дата Товарооборот Выручка Секции Состав Итого 

План Факт 1 2 3 

1999 12345 12333 4443556 2434 3455 3455 34 2324 

2000 54343 34545 4646577 3454 3454 3455 36 2354 

2001 45434 45566 5755766 2344 3454 3453 24 3466 

2002 44556 44555 4656546 2344 3454 4566 12 5677 
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4. Как  выполнить объединение  ячеек? 

5. С помощью каких операций  можно изменить  обрамление  таблицы? 

6. Каким образом можно изменить ширину столбцов? 

7. Какими способами можно отформатировать текст в ячейке таблицы?  

8.  Как выделить строку, столбец, ячейку? 

9. Как выделить таблицу целиком? 

10. Как изменить ширину столбца? 

11. Как вставить, удалить столбец, строку в таблицу? 

12. Как можно объединить несколько ячеек таблицы в одну? 

13. Как можно разбить ячейки на несколько ячеек? 

14. Какие свойства таблицы можно узнать в окне Свойства таблицы? 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА № 7 

Тема:  «Выполнение расчетов  в  таблице, созданной  в редакторе MS Word.» 
Цель:  

  

 формирование навыков выполнения  расчетов в  таблице; 

 закрепление практических навыков работы по созданию и форматированию таблиц 

в  программе MS Word.   

 закрепление   навыков создания таблиц, выполнения  различных операций  с 

ячейками таблицы (вставка и удаление, объединение, разбиение ячеек, изменение 

направления текста); 

 использование рациональных приемов  работы. 

 

Краткие  теоретические  сведения 

Расчеты в таблице, созданной  в редакторе  Microsoft  Word 2007 

 Возможности текстового редактора MS Word позволяют не только создавать  

таблицы  различной степени сложности, но и выполнять  простейшие расчеты.  

Рассмотрим применение формул на примере. 

Создать таблицу предложенного образца. 

 А В С D 

1 Наименование товара  Цена  Количество  Стоимость  

2     

3     

4     

5 Итого    

   

  Пронумеруем строки таблицы, а столбцы обозначим буквами латинского 

алфавита. 

Таким образом, в ячейке А1  содержится  текст Наименование товара. 

Заполним ячейки А2, А3, А4, В2, В3, В4, С2, С3, С4  произвольными данными.  

Затем рассчитаем Стоимость товара, (данные в ячейках D2 –D4). 

 Установив курсор на ячейке D2 , выполняем команду Работа с таблица ми– Макет. В 

разделе меню Данные выбираем команду Формула. 
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По этой команде раскроется диалоговое окно, которое по умолчанию содержит 

одну из двух формул, позволяющих вычислить сумму по столбцу или строке.  

Удаляем формулу и вводим формулу для подсчета стоимости =В2*С2. 

 Примечание!  Адреса ячеек обязательно должны быть набраны 

латинскими буквами. 

Нажав ОК (или  клавишу Enter) получим значение. 

Переводим курсор  на ячейку D3  и аналогично вводим формулу для подсчета 

стоимости =В3*С3. 

Расчет автосуммы. 

Вставим  в  таблицу  строку снизу для подсчета итоговой суммы.  Установив курсор в 

ячейке D5, в разделе меню Данные выбираем команду Формула. 

По этой команде раскроется диалоговое окно, которое по умолчанию содержит 

одну из двух формул, позволяющих вычислить итоговую сумму: 

 по столбцу         = SUM (ABOVE) 

 или  по строке   = SUM(LEFT)  

 Выбираем   формулу = SUM (ABOVE) и нажимаем   ОК.  

Примечание! В отличие от табличного редактора   Excel, где можно 

копировать формулы из одной ячейки в другие, и вводить формулы еще до 

заполнения ячеек данными, а также при изменении значений в ячейках 

редактор автоматически пересчитывает все, в которых данные 

используются для расчетов по  формуле,   в редакторе  MS Word эта 

возможность отсутствует. Сначала надо ввести данные, а уже затем 

выполнить вычисления по формуле. При изменении значений расчеты по 

формуле автоматически не пересчитываются. 

Задание №1 

1. Создать таблицу  в редакторе Word. 

  Расчет за кредит 

 А В С D Е F 

1 Наименование товара  Цена  Количество  Стоимость  Внесено  Остаток  

2       

3       

4       

5 Итого      

2. Заполнить столбцы А, В, С произвольными данными. 

3. В столбце D использовать формулу. 

4. В столбце Е использовать формулу для  вычисления первого взноса за кредит 

из расчета 25 % от стоимости товара. 

5. Вычислить Остаток.  

6. Подсчитать итоговую сумму. 

 

Задание №2  

1.Создать таблицу  в редакторе Word для расчета стоимости любого блюда. 

  Калькуляция  

 А В С D Е 

1 Наименование 

продукта  

Цена  Количество  Стоимость  

на 1 порцию  

Стоимость 

на 10 

порций  

2      

3      
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4      

5 Общая стоимость     

2. Ввести  основные данные: ингредиенты, цену 1 кг, количество. 

3. Рассчитать  по формуле стоимость  1 порции, 10 порций. 

4. Описать порядок выполнения работы с указанием формул, применявшихся 

для выполнения вычислений.  

  

Дополнительное задание.  Оформить таблицу анализа объема выпуска продукции по 

изделиям в соответствии с образцом. Произвести расчеты в таблице (макет – Формула – 

Sum (above) 

Краткая справка. Для изменения направления текста выделите группу ячеек и 

воспользуйтесь командой Макет/ Направление текста. 

Номерклатурный 

номер 

Единица 

измерения И
ю

л
ь
 

2
0
1
1
г.

 

А
в
гу

ст
 

2
0
1
1
г.

 

С
ен

тя
б

р
ь
 

2
0
1
1
г.

 

124578 Шт. 45 782 57 896 41 963 

457892 Шт. 78 952 95 824 85 236 

598624 Шт. 12 457 46 721 63 852 

829262 Шт. 36 985 75 841 74 125 

164676 Шт. 85 924 72 921 26 292 

Итого:  ? ? ? 

 

 

Контрольные  вопросы  

1. Как выполнить расчеты в таблице? 

2. Можно ли изменить формат данных, вычисленных по формуле? 

3. Как вычислить итоговую сумму по столбцу/строке? 

4. Выполняется ли перерасчет формулы при изменении значений в ячейках? 

5. Почему более сложные расчеты удобнее выполнять в МS Excel? 

 

 

 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА № 8 

Тема: «Вставка  и создание графических объектов (рисунков, диаграмм). 
Редактирование графических объектов» 

Цель работы: 

- научиться  создавать рисунки   в  текстовом редакторе  Word; 

- научиться  выполнять простейшие  операции по группировке, изменению 

формата фигуры, положения и т.п.; 

- научиться  создавать диаграммы  средствами  MS Word; 

- формировать умение работать с  документами, содержащими графические  

объекты; 

-  закрепить навыки способы  копирования, перемещения, удаления и 

восстановления  блоков  текста и графических объектов. 
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MS  

Word  

Пакет прикладных программ  

Microsoft Office 2003 

MS  Excele MS  Access  MS  

PowerPoint  

 

Краткие  теоретические  сведения 

Создание  рисунков 

Рисование осуществляется следующим образом: в меню Вставка  выбрать пункт Фигуры, 

появится  панель, в которой  можно выбрать нужную фигуру. 

Щелкнув  правой кнопкой мыши на  нарисованной  фигуре, 

можно изменить цвет и толщину линии контура, цвет  и 

прозрачность заливки, тип стрелок  и т.п.  

Фигуры  можно копировать с помощью  различных общих 

приемов (контекстное меню, буфер обмена).  Но, пожалуй, самым 

простым будет перетаскивание при помощи левой кнопки мыши, 

удерживая  нажатой  клавишу  Ctrl. 

 

  

 

 

 

 

 

 

 

 

 Для изменения  

контура фигуры, толщины,  выполнения  заливки и др. можно  выбрать в  контекстном 

меню команду Формат  автофигуры.   

 Чтобы  рисунок воспринимался  как единое целое, можно выполнить 

группировку. 

 Нажимаем клавишу Shift,   и,  удерживая ее нажатой, левой  кнопкой  мыши 

прощелкиваем все  фигуры   в рисунке. Затем в контекстном меню выбираем команду 

Группировка – Группировать. Чтобы отменить  группировку, выбираем команду 

Группировка – Разгруппировать. 

 Обтекание  текстом  задается с помощью контекстного меню, вызываемого 

правой кнопкой мыши. например, выбираем  команду  Формат объекта, в  раскрывшемся  

окне выбираем вариант По Контуру  на вкладке  Положение  текста, и   рисунок   

принимает  данный вид.  

Если  мы выберем команду Вокруг рамки, то получим  следующее: 

можно  выбрать выравнивание, положение на странице  и другие  параметры. 

 Для редактирования графических объектов: 
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1) Щелкните мышью по объекту, чтобы выделить его. Появится панель Настройка 

изображения: 

 
 

2) На панели инструментов Настройка изображения выберите требуемый режим. 

3) При работе  с  рисунками  также появляется  дополнительная  панель Средства 

рисования – Формат.  

 

Щёлкнув  по кнопке  Заливка фигуры, можно выбрать  в ней желаемый цвет; также 

изменить  контур или саму фигуру;   задать  объём, тень и другие дополнения к 

оформлению рисунка. 

Можно также выполнить разбор или поворот рисунка: 

Вставленный рисунок из библиотеки или автофигуру можно разобрать на отдельные 

графические объекта или развернуть. 

Для этого надо щелкнуть по рисунку правой кнопкой мыши, выбрать пункт Формат 

рисунка и на закладке Положение  убедиться в том, что выставлено не обтекание «в 

тексте» (иначе надо изменить его на другое). Затем надо щелкнуть по рисунку правой 

кнопкой мыши, выбрать пункт Группировка – Разгруппировать. Теперь можно 

растаскивать и разворачивать части  рисунка.   

Задание 1 

1. В  документе  MS Word создайте  рисунки предложенного образца. 

2. Выполните группировку рисунка.  

3.  Измените виды  фигур, применив  различные типы  обрамления  и заливки. 

4. Наберите текст задания 2 и схему, сгруппируйте  рисунок  и задайте  обтекание 

текстом, как  в  предложенном варианте.  

5. Измените положение  фигур относительно текста.  

6. Создайте  схему  (задание 3), измените оформление  фигур, применив  эффекты 

тени, задав  объем с помощью вкладки Работа с  рисунками (формат). 

 

Контрольные  вопросы: 

1. Зачем  в  рисунке Word нужно группировать фрагменты? 

2. Как выполняется  эта  операция?  

3. Как выполнить  изменение формата  фигуры (линии, заливки)? 

4. Какие способы копирования фигуры вы знаете? Каким чаще всего пользуетесь? 

5. Как задать обтекание  текстом? 

 

 

 

 

 



33 

 

по параметрам  ПК 

супер ЭВМ большие 

ЭВМ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Задание 2 

На сегодняшний день обществом  используется очень большое количество 
вычислительных машин. И для того чтобы разобраться с этим объемом   ПК, их 
необходимо классифицировать по следующим признакам: 

-по поколениям (этапам ) развития,  рассмотренным выше;  
-по параметрам  ПК принято разделять  на:  
А) супер ЭВМ: производительность -1000- 1000 000 MIPS , оперативная  

память – 2000-10 000 Мбайт, разрядность – 128 бит;  
Б) большие ЭВМ: производительность -2000- 10 000 МбайтMIPS, 

разрядность -32-64 бит;  
В) мини ЭВМ: производительность – 1- 100  MIPS оперативная память  - 16-

512 Мбайт, разрядность -16-64 бит;  
Г) микро ЭВМ: производительность  - 1-100 MIPS, оперативная память -4-

256 Мбайт, разрядность- 16-64 бит.  
Задание 3 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

Функции менеджера: 
 

 Разрабатывает и 

запускает проекты по 

совершенствованию, 

приносящие изменения 

 

Контролирует   разработку 

определенных проектов 

 

Отвечает за распределение всевозможных 

ресурсов организации 
 

Выполняет обычные 

обязанности  

правового или 

социального характера 

 

Отвечает за  мотивацию  и 

активизацию подчиненных  

на  достижение целей 

организации, координирует 

их усилия 
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ПРАКТИЧЕСКАЯ  РАБОТА № 9 

Тема: «Создание автособираемого оглавления. Редактирование  оглавления. 
Печать документов. Предварительный  просмотр» 

Цель: 

 научиться создавать оглавление, редактировать и форматировать его элементы; 

 научиться выполнять предварительный  просмотр перед печатью, задавать 

параметры  печати; 

 закрепить навыки форматирования шрифта  и документа.  

 

Краткие  теоретические  сведения 

  

Вывод на печать документов, созданных  в  Word 2007. 

Предварительный просмотр 

Чтобы получить представление о том,  как будет выглядеть документ в 

напечатанном виде, вы можете воспользоваться окном предварительного просмотра. В 

этом окне можно отразить одну или сразу несколько страниц и внести последние 

уточнения перед печатью. Предварительный просмотр экономит время и бумагу, 

поскольку позволяет вовремя исправить допущенные ошибки. 

Базовые стратегии 

фирмы 

Сокращение (стратегия 

последнего средства) 

Комбинированная 

стратегия 

Ограниченный рост Рост  
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Для этого щелкните на кнопке «Предварительный просмотр» в меню  Office  

. 

Появляется  окно предварительного просмотра, в котором  можно выбрать 

параметры предварительного просмотра: изменить ориентацию страницы, поля, масштаб 

изображаемого документа, показать или скрыть линейку. При небольшом масштабе, когда 

на  экране  несколько страниц, кнопки Одна страница  или Две страницы  задают 

соответствующее количество страниц.  

  
В окне предварительного просмотра отображается текущая страница документа. В 

нем появляется новая панель инструментов, но меню программы остается без изменений.  

Для того чтобы увидеть сразу несколько страниц документа, щелкните на кнопке 

«Масштаб» в правой  нижней части окна программы. Перемещая мышь с нажатой левой 

кнопкой, выберите нужное количество страниц. 

Редактирование в окне предварительного просмотра. 

1. Поля – можно изменить поля  документа. 

2. Флажок  «Показать линейку» отображают горизонтальную линейку.   

3. Кнопка  позволяет просмотреть документ  в масштабе 1:1. 

4. Кнопка Масштаб – позволяет  выбрать произвольный  масштаб отображения  

просматриваемого документа.  

5. Щелкнув  на кнопке «Сократить на страницу», можно уменьшить количество 

страниц в документе . 

6. Если перед вами  одна страница,  щелчок  на кнопке Следующая  (предыдущая) 

страница позволит перейти к  соответствующей  странице. 



36 

 

7. Кнопка  выводит документ на печать. 

8. Кнопка  Закрыть закрывает Окно предварительного просмотра и  можно 

далее редактировать документ. 

 

 Печать документа  

Вывести на  печать можно полностью весь документ, с помощью кнопки  меню Офис - 

Печать - Быстрая печать. В этом  случае печтается  одна копия  документа. 

   

Кнопка    Печать  раскрывает диалоговое окно 

Печать, в котором можем указать нужные 

параметры  печати:  число копий, номера 

отдельных страниц, которые нужно распечатать, 

можно вырать варианты – текущая страница или 

выделенный  фрагмент. Масштаб позволяет 

выбрать разное  количество страниц на  листе – от 

1 до 16 (2, 4, 6, 8). При выборе варианта 

двусторонняя печать в зависимости от типа  

принтера страницы могут печататься в различном 

порядке.  

Установив  нужные параметры, нажимаем ОК. 

 
 

Задания  

1. Создайте  документ MS Word и сохраните его в  своей  папке под именем 

«Колонтитулы». 

2. Скопируйте  из различных ранее созданных файлов 3-4 страницы  произвольно 

выбранного текста. 

3. Разделив  текст на «главы» по смыслу,  введите  название  каждой  главы, и с 

помощью вкладки Ссылки  Добавить текст пометьте  название  каждой  главы 

(Уровень 1). 

4. Перейдите  на 1-ую страницу (Ctrl +End)  и  создайте  оглавление Ссылки  

Оглавление  Автособираемое  оглавление . 

5. Наберите несколько строк (или скопируйте  блок текста) в одну из глав, так, чтобы 

изменилась нумерация.  

6. С помощью кнопки Обновить таблицу (обновить только номера  страниц) внесите 

изменения в  оглавление. 

7.  Между 3-ей  и 4-ой вставьте еще одну главу. 
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8. Обновите оглавление. 

9. Перейдите  из оглавления в текст любой главы (с помощью Ctrl). 

10. Выделите оглавление и измените шрифт в соответствии  со стандартом. 

 

 

Контрольные вопросы  

1. Для чего нужно выполнять предварительный  просмотр перед печатью документа? 

2. Как вывести документ на печать7 

3. Какие преимущества имеет автособираемое  оглавление? 

4. Как создать оглавление в  тексте? 

5. Какие способы  вывода на печать вы знаете?  

6. Какие  возможности предоставляет кнопку  Обновить таблицу? 

 

 

 

ПРАКТИЧЕСКАЯ РАБОТА № 10 

Тема:  «Создание маркированных, нумерованных, многоуровневых  списков. 
Редактор формул» 
 

Цель:   

 Приобретение практических навыков работы по созданию различных видов 

списков в программе MS Word; 

 Приобретение  практических навыков  работы   в  редакторе формул. 

 

 

Краткие теоретические сведения. 

 

Программа Word позволяет автоматически оформить текст в виде нумерованного, 

маркированного, многоуровневого списков. 

 виды списков (абзац) 

маркированный – нумерованный  - многоуровневый  

▪ Создание нумерованного или маркированного списка. 

 С помощью  группы команд вкладки Главная - Абзац. Щелкают на кнопке Маркеры 

или  Нумерация  для создания соответствующего списка. 
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а)выбор маркера для списка;                                   б) выбор формата  номера 

 

▪ Создание многоуровневого списка. 

 Чтобы создать многоуровневый список выполняют команду Главная – Абзац – 

Многоуровневый список. 

  

Можно создавать список из имеющегося текста, для этого выполняют следующие 

действия: 

▪ Выделяют абзацы, которые должны войти в список. 

▪ Щелкают  по нужной  кнопке  списка  и выбирают маркер или нумерацию. 

▪Для перехода к следующему пункту списка нажимают клавишу Enter  

▪Word автоматически поместит маркер или номер перед каждым новым абзацем.  

▪Для выхода из списка дважды нажимают клавишу Enter.  

 

Замечание. Расстояние маркера от левого отступа можно изменить с помощью верхнего 

левого маркера на линейке, величину отступа от номера до текста - с помощью нижнего 

левого маркера. 

 

▪ Отмена списка. 

 Чтобы удалить из списка маркеры или номера, превратив текст списка в обычные 

абзацы необходимо выделить нужный текст и щелкнуть на кнопке Маркеры или 

Нумерация на панели Форматирование. 

 

Задания 

 

Задание 1. Создание и форматирование маркированного списка. 

Задание 2. Создание и форматирование нумерованного списка. 

Задание 3. Создание и форматирование многоуровневого списка. 

Задание 4. Оформление текста в виде колонок. 

 

Задание 1. Создание и форматирование маркированного списка. 

▪ Загрузите программу MS Word. 

▪ Сохраните офис с именем «Списки» в своей рабочей папке. 

▪ Наберите текст в виде маркированного списка согласно образцу. 

▪ Отформатируйте список, установив отступ маркера на 4 см, отступ текста на 5 см. 
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Образец 

Стандартные программы Windows общего назначения. 

В состав Windows входят следующие программы (стандартные) общего назначения: 

 текстовый редактор WordPad; 

 текстовый редактор Блокнот; 

 графический редактор Paint; 

 средство обработки графических документов Imaging; 

 Калькулятор. 

 

Задание 2. Создание и форматирование нумерованного списка. 

▪ В документ «Списки» добавьте новую страницу. 

▪ Наберите текст в виде нумерованного списка согласно образцу. 

 

Образец 

Этапы создания папки в ОС Windows. 

1. Открывают папку, в которой будет создана новая папка. 

2. Вызывают контекстное меню (щелкают правой кнопкой мыши на свободном месте 

рабочей области открытого окна), в котором выбирают команду Создать – Папку. 

3. Вводят имя папки и нажимают клавишу Enter. 

▪ Отформатируйте список, установив отступ номера на 2 см, отступ текста на 2,5 см. 

▪ Измените список, установив нумерацию первого пункта с цифры 3. 

▪ Измените список, установив вместо арабских цифр римские цифры. 

 

Задание 3. Создание и форматирование многоуровнего списка. 

▪ В документ «Списки» добавьте новую страницу. 

▪ Наберите текст в виде нумерованного списка согласно образцу.  

▪ Измените список, установив на втором уровне вместо арабских цифр значки. 

 

Образец 

1. Использование ПК. 

1.1. Включение, выключение и использование персонального компьютера. 

1.1.1. Запуск системы. 

1.1.2. Как пользоваться кнопкой Пуск. 

1.1.3. Перезагрузка компьютера. 

1.2. Запуск программ и работа с окнами. 

1.2.1. Запуск программ в Windows. 

1.2.2. Настройка меню Пуск. 

1.2.3. Удаление программ из меню Пуск. 

1.3. Работа с приложениями. 

1.3.1. Форматирование текста и цифр. 

1.3.2. Как сохранять документ в разных форматах. 

 

Задание 3. Работа в  редакторе формул. 

▪ Чтобы решить квадратное уравнение вида: ax2+bx+c=0 необходимо 
сначала вычислить дискриминант по формуле: D=b2-4ac. 

Если D<0, то уравнение не имеет вещественных корней. 
 

  
          

  
 ; 

 

Свойства  корней:     
 

 =  
 

 , где n     m   . 
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? Контрольные вопросы. 

 

1. Что такое список? 

2. Какие виды списков можно создать в программе MS Word? 

3. Как создать маркированный список? 

4. Как создать нумерованный список? 

5. Как создать многоуровневый список? 

6. Как определить номер уровня в многоуровневом списке? 

7. Сколько уровней многоуровневого списка существует в программе MS Word? 

8. Каковы основные  возможности редактора формул? 

 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА № 11 

Тема: «Вставка и редактирование  номеров  страниц. Создание в  документе   
разных разделов. Создание разных колонтитулов  для разных разделов 
документа» 

Цель работы: 

 научиться создавать в документе разные разделы, создавать различные  

колонтитулы  и задавать различную  ориентацию страниц для разных 

разделов: 

 научиться вставлять номера страниц, изменять формат номера.  

Краткие  теоретические  сведения  

1.Что такое верхние и нижние колонтитулы 
Верхний и нижний колонтитул – это текст вверху (верхний колонтитул) или внизу 

(нижний колонтитул) каждой страницы документа. В  верхних и нижних колонтитулах 

могут быть записаны номера страниц, название главы, имя автора и т.п. Word 

предлагает несколько параметров верхних и нижних колонтитулов, включая такие: 

 один и тот же верхний колонтитул для каждой страницы документа; 

 один верхний или нижний колонтитул для первой страницы 

документа и другой – для остальных страниц; 

 один верхний или нижний колонтитул для четных страниц и другой – 

для нечетных; 

 если ваш документ разбит на разделы, можно создать различные 

верхние или нижние колонтитулы для каждого раздела. 

2. Создание и редактирование верхних и нижних колонтитулов 

Чтобы вставить верхний или нижний колонтитул в документе или 

отредактировать уже существующий, выполните следующее: 

1.Если  документ разбит на разделы, установите курсор в любом месте раздела, в 

который вы хотите поместить колонтитул. 
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2. Выберите команду «Вставка»→ Колонтитулы». Word переключится в режим 

разметки страницы и покажет колонтитул текущей страницы, заключенный в 

непечатаемую пунктирную рамку. Обычный текст документа становится тусклым, и 

появляется панель инструментов «Колонтитулы». На этой панели щелкните на кнопке 

«Верхний/нижний колонтитул» для переключения между  разными колонтитулами 

текущей страницы.  

 
3.Введите текст верхнего либо нижнего колонтитула, используя обычные приемы 

редактирования Word. Используйте кнопки панели форматирование для выравнивания 

текста  в верхнем / нижнем колонтитуле. 

4. Применяйте остальные кнопки панели форматирования для выполнения 

указанных действий. 

5. По окончании щелкните на кнопке «Закрыть» панели инструментов 

«Колонтитулы» для возвращения к тексту документа. 

3. Создание различных  верхних и нижних колонтитулов для различных 

страниц. 

Word по умолчанию выводит один и тот же колонтитул для всех страниц раздела и 

документа. Единственный способ создать различные колонтитулы для разных частей 

документа – разделить  документ на два и более раздела.  

Примечание. Для создания разделов в  документе  выполняем следующую 

последовательность команд: Разметка  страницы  Разрывы  Разрывы разделов  

Следующая страница (или любой пункт из группы команд 

Разрывы разделов) 

 

Затем вы можете использовать способ, описанный выше, для 

создания каждого раздела собственного верхнего /нижнего 

колонтитула. 

Кроме использования разделов, можно выбрать 

следующие параметры: 

 один верхний /нижний колонтитул для первой 

страницы и другой – для остальных; 

 один верхний /нижний колонтитул для 

нечетных страниц и другой – для четных. 
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Для установки одного или нескольких параметров из вышеперечисленных 

выполните следующее: 

1. Выберите команду «ВставкаКолонтитулы». 

2. Щелкните на кнопке «Параметры строки» панели инструментов 

«Параметры страницы» в режиме «Макет». 

3. В области окна «Различать» колонтитулы установить флажок четных 

и нечетных страниц и (или) флажок первой страницы. 

Щелкните на кнопке «ОК», чтобы закрыть диалоговое окно «Параметры 

страницы».   

После выбора одного или нескольких параметров колонтитулов используйте 

способ, описанный ранее, для ввода и редактирования текста колонтитула. К примеру, вы 

установили флажок «Различать колонтитулы четных и нечетных страниц». Если курсор 

находится на четной странице, можно вводить  и редактировать текст, который будет на 

четных страницах. При щелчке на кнопке «Переход к следующему» на панели 

инструментов «Колонтитулы» вы перейдете к колонтитулу для нечетных страниц.  

В группе команд  Положение можно установить  расстояние от колонтитула до 

края листа и до текста документа. 

 

4. Вставка  номеров страниц 

Если надо вставить в  документ номера  страниц, выполняем команды 

ВставкаНомер страницы. В раскрывшемся  подменю выбираем нужный вариант (вверху 

или внизу страницы, на полях). Затем в раскрывшемся списке  выбираем нужное 

положение номера. Можно установить нумерацию с цифры 1  или любой другой 

(ВставкаНомер страницыФормат номеров страниц). 

При создании разных разделов  можно установить сквозную нумерацию для всех 

разделов  документа, или же каждый  раздел начинать  с  

определенного номера.  

Для  этого в  диалоговом окне Формат номеров  страницы 

 Нумерация  страниц устанавливаем параметры 

Продолжить или  Начать с (вводим номер страницы). 

Можем также  изменить формат номера (например, 

римские цифры, буквы латинского алфавита и т.п.). 

Номер  страницы  тоже находится в  области 

колонтитулов. Если удалить текст (или номер страницы)  

в  одном из колонтитулов, то  он автоматически  удалится 

из всех  страниц документа. 

Задания 

11. Создайте  документ MS Word и сохраните его в  

своей  папке под именем «Колонтитулы». 

12. Скопируйте  из различных ранее созданных файлов 2-3 страницы  произвольно 

выбранного текста. 
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13. Поставить текстовый  курсор в 10 строке  и  нажать клавиши Ctrl + Enter  

(установить разрыв страницы). Для чего выполняется  эта  операция? 

14. Установить различные разделы  в документе. (Разметка  страницыРазрывы 

следующая  страница).  

15. Установить во 2-м  разделе  альбомную ориентацию страницы (Разметка  

страницыОриентация  Альбомная).  

16. Создать  в  1  разделе верхний  колонтитул (вкладка Вставка).  

17. Установить разные колонтитулы  для четных и нечетных страниц. 

18. Для колонтитулов 2-го раздела  снять флажок как в  предыдущем. Ввести 

произвольный  текст. 

19. Создать 3-ий  раздел, установить книжную ориентацию. В 3-ем разделе в 

колонтитул вставить текущую дату. 

20. В  нижнем колонтитуле вставить номера страниц. Нумерацию страниц  документа  

начать с 3-ей страницы. 

21. Создать 4-ый раздел с альбомной  ориентацией. Ввести 10 строк текста. 

22. Установите нумерацию страниц в  4- м разделе с 35 страницы. 

23. При помощи кнопки Отобразить все знаки просмотреть документ. Удалить 

разрыв раздела между 3-м и 4-м разделами. Что произошло  с документом? 

24. Сохранить документ в своей  папке. 

 

 

Контрольные вопросы: 

1. Что такое  колонтитул? 

2. Как создать колонтитулы? 

3. Какие возможности предоставляет MS Word 2007 для создания колонтитулов? 

4. Как выполняется нумерация  станиц? 

5. Какие  параметры  можно изменить при помощи опции Формат номеров страниц?  

 

 

 

 

ПРАКТИЧЕСКАЯ РАБОТА №12 

Тема: «Составление  типовых документов. Слияние документов в  MS Word» 
Цель работы: 

- научиться  выполнять слияние   документов  в  текстовом редакторе  Word; 

- научиться  создавать базу данных, изменять ее столбцы (поля), вводить 

информацию в  базу и сохранять её; 

- формировать умение работать с  документами, созданными с  помощью 

технологии слияния (просматривать, редактировать, находить нужные объекты); 
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- применять  различные параметры  для установки полей, ориентации страницы, 

разрывов. 

- закрепить навыки способы  копирования, перемещения, удаления и 

восстановления  блоков  текста; 

 

Краткие  теоретические  сведения  

Создание  документов   при помощи технологии Слияния 

При рассылке  писем  часто бывает необходимо подготовить множество 

однотипных документов, различающихся  только адресатами и некоторыми данными.  

Например, требуется подготовить рассылку  уведомлений  организациям,  

имеющим задолженность по оплате за  электроэнергию. 

Для такой  работы  предусмотрена  технология создания  документов  слияния. 

Набираем  текст основного документа и выбираем команду Сервис 

Письма  и рассылки Слияние. 

Появляется  окно слияния и панель инструментов 

слияния. 

В окне   слияния  мы  можем  выбрать тип документа, указанный на 

рисунке, при помощи  кнопки Далее перейти    следующему  этапу  или  вернуть назад, 

при помощи одноименной  кнопки.  

Кнопкой Далее мы  переходим  к  каждому  из  6  этапов, выбирая  параметры  слияния. 

 

  

Рис. 2 Этапы  создания  документа  с  помощью слияния. 

При   выборе получателей  мы  можем  использовать как  уже созданный список, так и  

создать новый. Если список  получателей и других полей  для слияния  уже создан, то 

раскрываем диалоговое  окно Выбор источника  данных, в  нем выбираем файл, который  

нужно открыть. 
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Рис.4. Диалоговое   окно Выбор источника  данных. 

В новом списке  данных  заполняем поля нужной  информацией. 

 

Открывается  окно, содержащее поля для документа. Данные  в полях можно 

отсортировать,  т.е. выбрать адресатов, используя кнопки  для выбора фильтра. При 

помощи  кнопок   в  нижней   части окна можно перемещаться  по записям таблицы,  

посмотреть их, отфильтровать, создать или удалить запись, настроить поля, если  

требуется.  

 

 

Рис. Окно настройки полей слияния  (списка  адресов и полей). 

Кнопки Добавить, Удалить, Переименовать помогают совершить  с полями 

одноименные действия. Кнопки  Вверх и Вниз позволяют расположить поля в  требуемой 
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последовательности, что впрочем, неважно, т.к. выбор полей слияния  не  зависит от их 

положения  в  окне. Закончив  работу  со списком, нажимаем кнопку ОК . 

Далее  продолжаем работать  с основным документом, вставляя поля слияния.  

 

Рис.  5. Диалоговое   окно  Получатели слияния. 

 
Рис.  8. Панель  инструментов Слияние 

Панель  инструментов Слияние содержит следующие  кнопки: 

1. Выбрать  тип документа (письма, шаблоны, и т.д.); 

2. Открыть источник  данных;  

3. Адресаты  слияния; 

4. Блок  адреса; 

5. Строка  приветствия; 

6. Вставить поле слияния; 

7. Добавить поле   Word; 

8. Поля/ Данные; 

9. Затенение  полей; 

10. Сопоставление  полей; 

11. Размножить наклейки; 

12. Кнопки для  перехода  от одной  записи к  другой; 

13. Найти элемент; 

14. Поиск  ошибок; 

15. Слияние   в  новый  документ; 

16. Слияние    при печати; 

17. Слияние    при отправке  по электронной  почте; 

18. Слияние    по факсу; 

19. Стандартная  кнопка  для  добавления  панелей  инструментов. 

 

 При помощи  Кнопки Затенение полей  мы  можем в  готовом документе  

определить,  где именно находится  поле слияния, и  проверить правильность своих 

действий.  

Печать можно выполнить в  файл, чтобы  просмотреть варианты полученных 

документов,  и уже  затем на  бумагу. 

По умолчанию списки документов  сохраняются   в папке Office Address List, но  

мы  можем для  сохранения  выбрать и другую папку. 
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Если  мы сохраняем  файл, созданный с  помощью операции слияния на 

переносном диске, то здесь же надо сохранить и базу данных (список адресов).  При 

открытии файла  появляется диалоговое окно о поиске базы данных (списка адресов). На 

запрос  о помещении базы данных в документ при открытии файла отвечаем НЕТ. 

Таким образом,  данная технология позволяет избавить пользователя ПК   от   

однообразной работы при создании множества   однотипных документов. 

 

Задания 

1. Создать документ Word  одним из стандартных способов. Сохранить его  в 

папке  под своей  фамилией. 

2. Набрать текст следующего содержания: 

Уважаемый (ая) … 

Доводим до Вашего сведения, что Вам необходимо  срочно погасить 

задолженность за …в сумме … до … 

В противном случае Вам будут начислены пени в  размере …%  в  день.  

Администрация КУРСКЭНЕРГО. 

 

3. Сохранить файл по именем Слияние (фамилия) 

4. Затем выбираем  команды на вкладке Рассылки – Начать слияние –Пошаговый 

мастер слияния.  

5. На появившейся в  правом углу окна панели слияния последовательно 

выполняем команды каждого из 6 этапов слияния. 

6. На 1 этапе выбираем текущий документ.  

7. На 2 этапе – создание списка. 

8. На 3 этапе создаем список адресов (кнопка Настройка столбцов – удаляем 

лишние поля или переименовываем, создавая столбцы Фамилия, Имя, Год 

Сумма, Дата, % пени). 

 
9. Заполняем созданную базу (кнопка Создать запись), введя не менее 7 записей. 

10. На 4  этапе создаем письмо – в набранный ранее документ Вставляем поля 

слияния (с помощью одноименной кнопки выбираем нужные поля). 
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11. С помощью кнопки Выделить поле слияния просматриваем созданный  

документ, убеждаемся, что он действительно содержит поля из выбранной базы 

данных (поля выделяются цветом). 

Уважаемый (ая) Фамилия  Имя!  

Доводим до Вашего сведения, что Вам необходимо  срочно погасить задолженность 

за Год в сумме Сумма  до Дата 

В противном случае Вам будут начислены пени в  размере % пени  %  в  день.  

Администрация КУРСКЭНЕРГО. 

 

12. На 5 этапе просматриваем письма, перемещаясь по ним с помощью кнопки 

Просмотр писем. Какие еще возможности предоставляет этот этап? 

  
13. 6 этап -  Завершение  слияния. Можем просмотреть  созданные документы и 

распечатать все или выборочные из них. 

14. При необходимости что-либо исправить мы можем вернуться к любому из 

этапов и внести изменения. 

15. Дополнительное задание: Создайте  открытку для  поздравления  сотрудников 

предприятия  с любым праздником. Используйте обрамление и заливку, 

объекты WordArt, различные типы шрифтов. 

 

Ответить на вопросы (в  тетради): 

1. Для чего применяется операция слияния? 

2.  Сколько этапов выполнения это  операции? 

3. Как сохранить базу данных?  
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4. Можно ли использовать имеющуюся базу  данных или необходимо  каждый раз 

создавать новую?  

5. Как выполнить настройку полей в  базе? 

6. Можно ли выбрать для слияния документов не все объекты из базы? Каким 

образом? 

7. Для чего необходима кнопка Выделить поле слияния? 

8. В каких случаях Вы будете применять данную операцию? Приведите примеры.  

 

 

 

 

 

Практическая работа №13. 

Тема: «Слияние документов. Формирование конвертов, почтовых наклеек, 

комплектов писем» 

Слияние – это создание бланка письма, который используется для печати или 

отправки по электронной почте нескольких копий, предназначенных разным получателям. 

Можно вставить в такой бланк поля, например, «Имя» или «Адрес», которые 

автоматически заполняются сведениями из базы данных или списка контактов для каждой 

копии бланка письма. 

В Microsoft Word 2007-2010 на ленте Рассылки щелкните на кнопке Начать 

слияние и выберите команду Пошаговый мастер слияния. В правой части окна появится 

специальная панель Слияние, в которой указаны этапы (всего их 6). 

Этап 1. Выбор типа документа. Это могут быть: письмо, электронное сообщение, 

конверты, наклейки, каталог. Выбираем тип документа: письмо. Щелкаем в нижней части 

панели Слияние Далее. 

Этап 2. Выбор документа. Основой для создания писем могут являться текущий 

документ, шаблон, существующий документ.  Выберем 

Текущий документ – Далее. 

Этап 3. Выбор получателей. Предлагаются варианты: 

использование списка, контакты Outlook, создание списка. 

Выбираем Создание списка – Создать. Появится окно Новый 

список адресов. Вводим данные.  

 

 

С помощью кнопки Настройка столбцов 

можно добавить в список, удалить или 

переименовать дополнительные поля, например 

Отчество. С помощью кнопок Вверх, Вниз 

расположить в нужном порядке поля.  

Если список уже имеется, то нужно выбрать 

команду Использование списка – Изменить список. 



50 

 

 
Этап 4. Создание письма. Здесь необходимо написать содержимое письма, добавляя 

в него сведения о получателях. Для этого можно использовать Блок адреса, Строку 

приветствия, Другие элементы слияния.  

Этап 5. Просмотр писем. Можно просмотреть созданные вами письма, чередуя 

получателей с помощью счетчика. Также можно изменить список получателей, добавив 

или исключив их из списка. 

Этап 6. Завершение слияния. Можно распечатать готовые письма. Для уточнения 

писем можно щелкнуть ссылку «Изменить часть писем». 

 

Задание Вариант 1 

Введите в файл адресов следующие записи (обратите внимание на имена полей – они 

отличаются от имеющихся). Добавьте еще 6 записей самостоятельно. 

Обращен

ие 

Имя Отчество Фамили

я 

Адрес Инде

кс 

Населен

ный 

пункт 

Сумма 

Уважаемы

й 

Петр Иванович Михайл

ов 

Щепкина, 

34 

44412

7 

Звенигор

од 

789,00 

Уважаемы

й 

Федор Васильевич Петров Ленина, 45 15005

7 

Ярославл

ь 

899,00 

Уважаема

я  

Людми

ла 

Яковлевна Урусова Глушкова, 

40 

16701

7 

Хрустале

в 

1550,0

0 

Уважаемы

й  

Борис Борисович Петров Свободы, 

87 

19810

3 

Санкт-

Петербур

г 

2561,0

0 

Уважаемы

й 

Руслан Кузьмич Кузнецо

в 

Крещатик, 

13 

25200

1 

Киев 650,00 

Уважаема

я 

Ирина Владимиро

вна 

Агас Садовая, 56 12559

0 

Москва 1845,0

0 
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Отсортируйте список получателей по полю Фамилия. 

Святослав Боголюбов 

Щепкина, 31 

г. Москва 

  

«Имя» «Фамилия» 

«Адрес_1» 

«Индекс», «Область» 

 

Напоминание о доплате 

 

«Обращение» «Имя»  «Отчество» «Фамилия»,  

В соответствии с предварительной договоренностью мы выслали вам 

дополнительную литературу и материалы. По-видимому, из-за случайного недосмотра эта 

дополнительная информация до сих пор не оплачена.Вы должны «Сумма» рублей. 

Прошу Вас погасить задолженность, переслав на наш счет указанную сумму. В 

противном случае наш договор теряет силу. 

 

С уважением, Святослав Боголюбов. 

Задание Вариант 2 

Введите в файл адресов следующие записи (обратите внимание на имена полей – они 

отличаются от имеющихся). Добавьте еще 6 записей самостоятельно. 

Пол Имя Отчество Фамилия Адрес Индекс Населенный 

пункт 

Сумма 

м Петр Иванович Михайлов Щепкина, 

34 

444127 Звенигород 789,00 

м Федор Васильевич Петров Ленина, 

45 

150057 Ярославль 899,00 

ж Людмила Яковлевна Урусова Глушкова, 

40 

167017 Хрусталев 1550,00 

м Борис Борисович Петров Свободы, 

87 

198103 Санкт-

Петербург 

2561,00 

м Руслан Кузьмич Кузнецов Крещатик, 

13 

252001 Киев 650,00 

ж Ирина Владимировна Агас Садовая, 

56 

125590 Москва 1845,00 
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Отсортируйте список получателей по полю Фамилия 

В строке с обращением (Уважаем…) в зависимости от пола получателя нужно проставить 

окончание (ый или ая) с помощью применения условного оператора: Рассылки – Правила   

(IF…THEN…ELSE). 

Святослав Боголюбов 

Щепкина, 31 

г. Москва 

  

«Имя» «Фамилия» 

«Адрес_1» 

«Индекс», «Область» 

 

Напоминание о доплате 

 

Уважаем    «Имя»  «Отчество» «Фамилия»,  

В соответствии с предварительной договоренностью мы выслали вам 

дополнительную литературу и материалы. По-видимому, из-за случайного недосмотра эта 

дополнительная информация до сих пор не оплачена. Вы должны «Сумма» рублей. 

Прошу Вас погасить задолженность, переслав на наш счет указанную сумму. В 

противном случае наш договор теряет силу. 

 

С уважением, Святослав Боголюбов. 

 

 

 

 

____________________________________________________________________________ 

 

 

 

Практическая работа № 14. 

Тема: Подготовка оригинал – макета брошюры в MS Word. Редактирование и 

форматирование статического информационного контента. 

Стиль – это заранее определённый и сохранённый с некоторым именем набор 

значений параметров текста (описание свойств шрифта, тип выравнивания текста, отступы 

и т.д.) 

Одним из самых важных правил дизайна является правило единства стиля. По 

отношению к документу это означает, что задуманный способ форматирования не должен 

меняться от страницы к странице. 

Задание стилей позволяет обеспечить единство оформления документа практически 

до его создания. Сначала задаём стили, потом наполняем документ текстом и картинками. 

Если в дальнейшем возникнет необходимость изменить внешний вид документа, то 

это можно будет сделать, не «прикасаясь» к нему: достаточно переделать описание стилей, 

и документ изменится автоматически. 

Задание 1 

Создайте первую страницу брошюры. 

Порядок работы. 

1. Откройте Word.  

2. Создайте макет для написания брошюры. Разметка 

страницы→поля→настраиваемые поля. В окне параметры страницы настройте поля как 

показано на рис.1, страницы→брошюра, ориентация → альбомная               
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3. Установите стиль “Заголовок 1”(Главная →    Стили)  

4. Наберите с клавиатуры заголовок рассказа:  

    Собор Парижской     Богоматери 

 

 

 
5. Запишите текст в новый файл Достопримечательности Парижа (в своей 

папке) в папке Мои документы  

6. Отредактируйте стиль “Заголовок 1”. Установите рубленый шрифт Arial 

размером в 16 пунктов, полужирный (Главная→  Шрифт), выравнивание по центру, 

вывод с новой страницы  (Главная →     Абзац, вкладка Положение на странице).                   

7. Скопируйте в Word текст о соборе Парижской Богоматери. Мои документы 

→ папка 

 Париж   → тексты о достопримечательностях Парижа  

8. Отредактируйте стиль записанных абзацев (“Обычный”). Рис. 2. Установите 

шрифт Times New Roman размером в 12 пунктов, обычный (Главная → Шрифт), 

выравнивание по ширине, красную строку с отступом в 1,27 см. (Главная → Абзац, 

первая строка, отступ на  1,27 см.) Установите для стиля следующего абзаца стиль 

“Заголовок1”  
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Рис. 2. 

Установите режим автоматической расстановки переносов:  

Разметка страницы Расстановка переносов    Авто 

9. Вставьте картинку после заголовка (скачать фото Парижа): Вставка 

Рисунок Из файла…  
10.   Это интересно знать: 

При вставке картинки в документ она автоматически имеет положение «в тексте». 

Для изменения положения: 

1. выделить рисунок щелчком ПКМ; 

(Или Главная →Работа с рисунками→ Формат→ обтекание текстом→по 

контуру→ок) 

2. в контекстном меню выбрать строчку Формат рисунка.  

3. В открывшемся окне Формат рисунка перейти на вкладку Положение. 

4. Выбрать вид обтекание текстом по контуру, Ok. Рис.3 

 

 
Рис. 3. 

5. Переместите рисунок так, как вам кажется 

 удобным, и измените его размеры 
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Замечание 

При оформлении страницы с иллюстрациями следует придерживаться следующих 

правил: 

1. Для более компактного размещения рисунков использовать положение 

«вокруг рамки». 

2. Не следует размещать рисунок посередине текста. Это затрудняет 

восприятие, так как строчки начинаются с одной стороны рисунка, а заканчиваются с 

другой. Лучше сдвинуть рисунок к правой или левой границе лиса. 

3. Необходимо следить, чтобы внешние границы рисунка совпадали с 

внутренними границами полей листа. 

4. Если рисунок занимает более ¾ ширины текста, то лучше выбрать 

расположение текста сверху и снизу. В этом случае можно установить для рисунка 

положение «в тексте» и поместить его в пустом абзаце. 

5. Рисунки должны быть соразмерны количеству изображенных на них 

элементов. Чем больше на рисунке информационных элементов, тем он должен быть 

крупнее. 

Задание 2. 

Создайте самостоятельно 3 страницы брошюры с названиями «Лувр», «Сорбонна» 

и «Триумфальная арка». 

Текст и картинки  скачайте изинтернета. 

Задание 3.   Вставьте страничку «Интернет ресурсы» 

Сделайте нумерованный список 

Задание 4.   Установите номера страниц 

1. Вставка  →   Номер страницы →  Формат номеров страниц  →   начать 

с 1 ок 

Задание 5.  Сделайте оглавление 

1. Вставьте пустую страницу перед первым рассказом (Установить курсор в 

начало первого заголовка и нажать  Enter) 

2. Пропустите абзац, а на следующем вызовите окно Ссылки →   оглавление 

→  оглавление  и  ок 

3. Установите интервал после первого абзаца в 50 пунктов.  

4. Напишите на первой строке Содержание.  

Задание 6. Сделать обложку к брошюре 

1. Вставить новую страницу перед оглавлением и набрать в самом её верху имя 

автора стилем “Заголовок 1”: 

2. В следующем абзаце вставить  картинку Париж 

3. В следующем  абзаце написать город и год:  

4. В  последнем абзаце в позиции Шрифт установить рубленый шрифт Arial, 

размер 14 пунктов, а в позиции Абзац — выравнивание по центру без красной строки 

5. Для создания рамки на странице, вызвать окно Разметка страницы → 

Границы страниц…: На вкладке Страница установить нужные параметры:  

6. Для вставки рисованного названия книги воспользовались услугами 

WordArt: Вставка  →   WordArt: 
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Практическая работа №15. 

Тема: Создание и заполнение табличных документов в редакторе Word, 

редактирование и форматирование таблицы. Простейшие расчеты в таблице. 
Таблица документа Microsoft Word состоит из строк и столбцов ячеек, которые 

могут содержать цифры, текст, рисунки и используются для упорядочения и 

представления данных, позволяют выстроить числа в столбцы, а затем отсортировать их, а 

также выполнить различные вычисления. 

Создание новой таблицы в Microsoft Word можно осуществить тремя способами: 

вставить; нарисовать; создать на основе существующих данных (текста, чисел). 

Для выполнения этой лабораторной работы необходимо ознакомиться со способами 

создания таблиц в Microsoft Word, методами их редактирования и форматирования, а 

также ознакомиться с операциями ввода, редактирования и форматирования текста в 

таблицах. Кроме того, необходимо ознакомиться со способами вычислений в таблицах в 

Microsoft Word. 

ХОД РАБОТЫ 

  1. Откройте текстовый редактор MS Word. 

2. Создайте таблицу, состоящую из 7 столбцов и 7 строк. 

3. Заполните таблицу следующим образом 

 

 понедельни
к 

вторник среда четверг пятница суббота 

1 

Математика 

Математик
а 

Русский 
язык 

География 
Математик
а 

д
еж

у
р
н

ы
й

 

ИЗО 

2 
Литература Ин. Язык 

Русский 
язык История 

Технологи
я 

3 География История Биология 

Литература 4 Русский 
язык 

ОБЖ 

Математика Ин. язык Риторика 

5 
 Физкультур

а 

Информатик
а 

  

6      

 

4. Измените цвет шрифта текста по своему усмотрению. 
   5. Заштрихуйте пустые ячейки таблицы. 

   6. Залейте ячейки таблицы. 

   7. Вставьте в вашу таблицу  расписание звонков уроков. 

   8. Сделайте высоту строк таблицы 1 см. 

 

 Расписан
ие 

звонков 

понедельн
ик 

вторник среда четверг пятница суббота 

1 
8

00
-8

40
 

Математик
а 

Математ
ика 

Русский 
язык 

География 
Математ
ика 

Д
 е

 ж
 у

 р
 н

 ы
 й

      ИЗО 

2 
8

45
-9

25
 

Литерату
ра 

Ин. Язык 
Русский 
язык 

История 
Технолог
ия 3 

9
35

-10
15

 География История Биология 
Литератур
а 4 

10
25

-11
05

 
Русский 
язык 

    ОБЖ 
Математи
ка 

Ин. язык Риторика 

http://www.lessons-tva.info/edu/e-inf2/m1t1_4.html
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5 
11

15
-11

55
  

Физкульт
ура 

Информат
ика 

  

6 
12

00
-12

40
      

 

 

 

Практикум «тестовый редактор WORD»  

Задание 1  

Создайте таблицу: 

Устройства ввода 
информации 

Устройства вывода 
информации 

Устройство сохранения 
информации 

Устройство 
обработки 

информации 

к
л
ав

и
ат

у
р
а 

м
ы

ш
к
а 

ск
ан

ер
 

м
и

к
р
о
ф

о
н

 

м
о
н

и
то

р
 

принтер 
ко

л
о
н

к
и

 
внутренняя 

память 

внешняя  

память 

процессор 

м
ат

р
и

ч
н

ы
й

 

ст
р
у
й

н
ы

й
 

л
аз

ер
н

ы
й

 

п
о

ст
о
я
н

н
ая

 

о
п

ер
ат

и
в
н

ая
 

в
и

н
ч
е
ст

ер
 

д
и

ск
ет

а 

д
и

ск
и

 

 

Ячейку диски преобразуйте следующим образом: 

Задание 2 

Создайте таблицу 

Схема классификации типа хордовых 

Тип хордовые 

Класс млекопитающие птицы 

Отряд грызуны хищные  

Семейств

о 
мышиные беличьи собачьи кошачьи  

Род мыши крысы белки 
бурундук

и 
   

В
и

д
 

   
 

 
  

диски 

C
D

 

D
V

D
 

B
lu

-r
ay
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Контрольные вопросы. 

1. Как вызвать контекстное меню? 

2. Что такое масштабные линейки, как их убрать? 

3. Когда появляются и для чего предназначены полосы прокрутки? 

4. Что такое бегунок, что он отображает? 

5. Как переместиться по документу с помощью полос прокрутки, клавиш? 

6. Как изменить объект перехода для кнопок перехода на вертикальной полосе 

прокрутки? 

7. Какие существуют режимы отображения документа, как выбрать один из них? 

 

 

 

Практическая работа №16.  

Тема: «Создание, форматирование рисунков с помощью фигур. Работа с объектами 

SmartArt». 

Цель урока: приобретение практических навыков работы с  Microsoft Word 

ЗАДАНИЕ 1 

Создать текст объявления по предлагаемому образцу, используя: 

 вставку в текст готовых рисунков; 

 обрамление объявления рамкой графическим способом. 

Результат работы сохранить в своей папке в файле с именем ВНИМАНИЕ. 

 
 

Внимание участников семинара! 

 
К главному корпусу университета можно 

 проехать: 

 от аэропорта Минск-1 
трол. № 2, 18 до остановки «Площадь Независимости»  

 

  от аэропорта Минск-2 
автобус-экспресс до остановки «Гостиница Минск» 

 

  от автовокзала «Восточный» 
авт. №  8, 79, 42, 43 

трол. № 20, 30, 3, 16 

 

 от автовокзала «Центральный» 

 

  от железнодорожного вокзала 
 можно пройти пешком к Площади Независимости   
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ЗАДАНИЕ 2 
Создать в текстовом редакторе Word документ по предлагаемому образцу, 

используя: 

 различные подходящие типы автофигур; 

 оформление автофигур при помощи тени; 

 различные типы и цвета линий и цвета заливки. 

Результат работы сохранить в своей папке в файле с именем 

СТРУКТУРНАЯ_СХЕМА_МИКРОКОМПЬЮТЕРА. 

 

СТРУКТУРНАЯ СХЕМА МИКРОКОМПЬЮТЕРА 

 
 

ЗАДАНИЕ 3 

Создать в текстовом редакторе Word документ по предлагаемым ниже образцам, 

используя: 

 различные подходящие типы автофигур; 

 оформление автофигур при помощи тени; 

 различные типы и цвета линий и цвета заливки. 

Результат работы сохранить в своей папке в файле с именем Схема_понятия_конфликта 

(или с другим именем, связанным с создаваемым образцом). 

СХЕМА ПОНЯТИЯ КОНФЛИКТОВ 

 

 

 

ЦП 

Основная 

память Дисплей 
 

Принтер 

Различные 

периферийн

ые 

устройства 

Клавиату

ра 
 
Внешние 

ЗУ 

Данные Выво

д 

Выво

д 

Вв/вы

в 

Вв/вы

в 

Ввод 

Адрес 

Шина 
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СОСТАВ  ПРЕСТУПЛЕНИЯ 

 Состав преступления – совокупность установленных уголовным 

законом объективных признаков, характеризующих общественно 

опасное деяние как  конкретное преступление. 

    

ЭЛЕМЕНТЫ СОСТАВА ПРЕСТУПЛЕНИЯ  

ОБЪЕКТ 
ПРЕСТУПЛЕНИЯ 

ОБЪЕКТИВНАЯ 

СТОРОНА 

ПРЕСТУПЛЕНИ

Я 

СУБЪЕКТ 
ПРЕСТУПЛЕНИЯ  

СУБЪЕКТИВНА

Я 

СТОРОНА 

ПРЕСТУПЛЕНИ

Я 

Это охраняемые 

законом 

общественные 

отношения, 

которым 

причиняется или 

может быть 

причинен вред 

преступлением  

Это совокупность 

признаков, 

характеризующих 

внешнюю сторону 

преступления 

(действие или 

бездействие) 

Это физическое 

лицо, 

совершившее 

преступление и 

способное нести 

уголовную 

ответственность 

Это 

характеристика 

внутреннего 

содержания 

преступления, т.е. 

психическое 

отношение 

виновного к 

содеянному 

Конфликт = столкновение противоположно 

направленных тенденций в психике отдельного 

человека, во взаимоотношении людей и 

неформальных объединений 

Может быть 

допустимым 

и 

желательны

м 

Различие 

взглядов 

Различие  

позиций 

Различие 

интересов 

Выявляет 

“Подводные  

камни” 

Скрытые 

процессы 

Разнообразие 

 точек зрения 
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СХЕМА МАТРИЧНОЙ СТРУКТУРЫ УПРАВЛЕНИЯ 

 

 
 

ЗАДАНИЕ 4 

Создать в текстовом редакторе Word документ по предлагаемому образцу, 

используя: 

 различные подходящие типы автофигур; 

 оформление автофигур при помощи тени; 

 различные типы и цвета линий и цвета заливки. 

Результат работы сохранить в своей папке в файле с именем 

Областные_города_Беларуси. 

 

 

Руководитель фирмы 

Руководитель подразделения 

Руковод

итель 

проекта 

Руковод

итель 

проекта 

Руковод

итель 

проекта 

Испол

нитель 

Испол

нитель 

Испол

нитель 

Испол

нитель 

Испол

нитель 

Испол

нитель 

Испол

нитель 

Испол

нитель 

Испол

нитель 

Испол

нитель 

Испол

нитель 

Испол

нитель 
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МИНСК 

Брест 

Гродно 

Могилев 

Витебск 

Гомель 
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Практическая работа №17. 

 

Тема: Создание учебного пособия «Практические советы при работе с текстовым 

процессором MS Word». 

Создать учебное пособие по Word 2007, которое будет содержать следующие разделы: 

1. Основные функции MS Word 2007. 

2. Средства набора и редактирования текста. 

3. Организация внешнего вида документа. 

4. Работа с таблицами. 

5. Работа с графическими объектами. 

6. Работа с формулами. 

Правила оформления учебного пособия. 

1. Параметры страницы 

Поля: верхнее — 1,5; нижнее — 1,5; левое — 2; правое — 1 см. 

2. Заголовки 

Кегль: Times New Roman, жирный. 

Размер шрифта: 1 Заголовок — 16; 1.1 Заголовок — 15; 1.1.1 Заголовок — 14 пт. 

В нумерации после цифр идет пробел, а не табуляция. 

Заголовок первого уровня: интервал перед — 12 пт; интервал после — 18 пт; отступ — 1,5 

см. 

Заголовок второго уровня: интервал перед — 24 пт; интервал после — 18 пт; отступ — 1,5 

см. 

Каждый раздел (с заголовком первого уровня) текстового документа рекомендуется 

начинать с новой страницы. 

3. Основной текст 

Кегль: Times New Roman, 14 пт. 

Полуторный межстрочный интервал. 

Абзацный отступ: 1,5 см. 

Выравнивание текста по ширине. 

В тексте используется «длинное тире», его клавиатурное сочетание в MS Word — Ctrl + 

Alt + минус на доп. клавиатуре. 

Используются «кавычки-елочки», для вложенных кавычек — „кавычки-лапочки“. 

4. Перечисления 

Перед каждой позицией перечисления следует ставить строчную букву русского 

или латинского алфавитов, после которой ставится скобка. Для дальнейшей детализации 

перечислений необходимо использовать арабские цифры, после которых ставится скобка. 

Для первого уровня перечисления используется абзацный отступ, для второго — двойной 

абзацный отступ (т.е. одинарный абзацный отступ по отношению к первому уровню). 

Пункты перечислений начинаются с «маленькой буквы», заканчиваются точкой с запятой, 

последний пункт — точкой. 

В маркированном списке, согласно правилам русского языка, в качестве маркера 

(«буллита») следует использовать длинное тире. 
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Таблицы 

Название пишется над таблицей, форматирование — как у обычного текста. 

Нумерацию используем сквозную. 

Название состоит из «Таблица», номера, тире и названия, например: «Таблица 1 — 

Перечень реквизитов массива». 

Заменять кавычками повторяющиеся в таблице цифры, математические знаки, 

знаки процента и номера, обозначение марок материалов и типоразмеров изделий, 

обозначения нормативных документов не допускается. 

При отсутствии отдельных данных в таблице следует ставить прочерк (тире). 

Рисунки 

Название пишется под рисунком по центру, как и рисунок, форматирование — 

как у обычного текста. Нумерация — сквозная. 

Если рисунок один, то он обозначается «Рисунок 1». 

Допускается не нумеровать мелкие иллюстрации (мелкие рисунки), размещенные 

непосредственно в тексте и на которые в дальнейшем нет ссылок. 

Допускается нумеровать иллюстрации в пределах раздела. В этом случае номер 

иллюстрации состоит из номера раздела и порядкового номера иллюстрации, разделенных 

точкой. Например — Рисунок 1.1. 

При ссылках на иллюстрации следует писать «… в соответствии с рисунком 2» 

при сквозной нумерации и «… в соответствии с рисунком 1.2» при нумерации в пределах 

раздела. 

Иллюстрации, при необходимости, могут иметь наименование и пояснительные 

данные (подрисуночный текст). Слово «Рисунок» и наименование помещают после 

пояснительных данных и располагают следующим образом: Рисунок 1 — Детали прибора. 

Приложения 

Каждое приложение следует начинать с новой страницы с указанием наверху 

посередине страницы слова «Приложение» и его обозначения, а под ним в скобках 

для обязательного приложения пишут слово «обязательное», а для информационного — 

«рекомендуемое» или «справочное». 

Приложения обозначают заглавными буквами русского алфавита, начиная с А, 

за исключением букв Ё, З, Й, О, Ч, Ь, Ы, Ъ. После слова «Приложение» следует буква, 

обозначающая его последовательность. 

Допускается обозначение приложений буквами латинского алфавита, 

за исключением букв I и О. В случае полного использования букв русского и латинского 
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алфавитов допускается обозначать приложения арабскими цифрами. Если в документе 

одно приложение, оно обозначается «Приложение А». 

Список литературы 

Требования к оформлению библиографических ссылок, согласно ГОСТ Р 7.0.5—

2008. 

 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА № 18 

Тема: «Зачетное занятие по теме «MS WORD» 
Цель занятия: закрепить навыки форматирования документа, создания разных разделов в 

документе, вставки колонтитулов в различные разделы, приемы работы с таблицей и 

графическими изображениями, технологии работы по подготовке документа к печати 

. 

                                                          Задания  

1. В редакторе WORD создать документ под именем Зачетная работа (Фамилия). 

2. Разметить страницу перед набором текста в соответствии с требованиями 

стандарта.  

3. В рабочем окне  редактора набрать два абзаца текста по десять строк в каждом, 

причем, текст первого абзаца набрать шрифтом Times New Roman размером 

символов 14,а текст второго абзаца набрать шрифтом Courier New с размером 

символов 16.  

4. Создать разные разделы в документе. Второй абзац дважды скопировать на 

вторую страницу этого рабочего окна, создав другой раздел, а первой абзац 

переместить на третью страницу. 

5. В 3-м  разделе набрать схему и пояснительный    текст. 

6. Сгруппировать рисунок и скопировать его в конец документа. 

7. Сформировать разные колонтитулы для четных и нечетных страниц. В верхнем 

колонтитуле нечетной страницы ввести текст Зачетная работа, в верхнем 

колонтитуле четной страницы ввести текст Студента группы …ФИО. 

8. На 5-й странице документа создать таблицу. Изменить ориентацию этой страницы 

на альбомную. 

9. На 6-й странице вставить текст, содержащий математическую формулу. 

10. Вставить номера страниц, причем в последнем разделе нумерацию начать с 

номера 117, во всех остальных продолжать нумерацию последовательно.    

Выполнить предварительный  просмотр документа.                                
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Практическая работа № 19 

Тема: «Создание буклета и визитки средствами программы Microsoft 
Publisher» 

Теория 

Буклет (фр. Bouclette - завитушка) - категория печатной продукции, особым 
образом сложенный лист глянцевой бумаги или полукартона с текстом и 
иллюстрациями на обеих сторонах листа. Буклеты обычно изготавливают на 
бумаге из листа формата А4 или А3, с 1 или 2 сгибами. 

Буклеты, как правило, носят рекламный характер. Их назначение привлечь 
внимание потребителя к рекламируемому товару, услуге. Поэтому буклеты 
должны быть яркими, содержать много иллюстраций и иметь краткий, но 
информативный текст. 

Буклеты могут складываться по-разному. Самый распространенный вид - 
двухсгибный буклет. Лист бумаги формата А4 сложен дважды - двумя 
параллельными сгибами. 

 

 

Задания 

Задание №1. Создать буклет, посвященный автомобилям фирмы Mazda. 

Порядок выполнения работы: 

1. Создать новый документ альбомной ориентации: Файл---Создать---Размеры 
пустых страниц---А4 (альбомная)---кн.СОЗДАТЬ 
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2. Добавить разметку трех областей: Расположение---направляющие разметки--
-Направляющие сетки 

 

 
3. Добавить на страницы геометрические фигуры, фигурный текст WordArt, 
картинки и другие элементы, согласно образцу (меню Вставка---Рисунок) 

 
4. Добавить вторую страницу: Вставка---Страница 

5. Добавить информацию на вторую страницу, согласно образцу: 
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6. Сохранить работу в папке вашего класса с именем «Буклет_Фамилия» 
 

 

 

 

 

Практическая работа № 20. 

Тема: «Создание календаря средствами программы Microsoft Publisher» 

 

Создать календарь с отслеживанием дат на период с сентября по декабрь 

включительно. 

 

 

Практическая работа №21 

Тема: Текстовые эффекты Photoshop 

Краткое содержание 

Adobe Photoshop - многофункциональный графический редактор, разработанный 

и распространяемый фирмой Adobe Systems. В основном, работает с растровыми 

изображениями, однако имеет некоторые векторные инструменты. Продукт является 

лидером рынка в области коммерческих средств редактирования растровых изображений, 

и наиболее известным продуктом фирмы Adobe. Часто эту программу называют просто 

Photoshop. В настоящее время Photoshop доступен на платформах Mac OS X/Mac OS и 

Microsoft Windows. Ранние версии редактора были портированы под SGI IRIX, но 

официальная поддержка была прекращена, начиная с третьей версии продукта. Для версии 

CS 2 возможен запуск под Linux с помощью альтернативы Windows API — Wine 0.9.54 и 

выше. 

http://ru.wikipedia.org/wiki/%D0%93%D1%80%D0%B0%D1%84%D0%B8%D1%87%D0%B5%D1%81%D0%BA%D0%B8%D0%B5_%D0%BF%D1%80%D0%BE%D0%B3%D1%80%D0%B0%D0%BC%D0%BC%D1%8B
http://ru.wikipedia.org/wiki/Adobe_Systems
http://ru.wikipedia.org/wiki/%D0%A0%D0%B0%D1%81%D1%82%D1%80%D0%BE%D0%B2%D0%B0%D1%8F_%D0%B3%D1%80%D0%B0%D1%84%D0%B8%D0%BA%D0%B0
http://ru.wikipedia.org/wiki/%D0%92%D0%B5%D0%BA%D1%82%D0%BE%D1%80%D0%BD%D0%B0%D1%8F_%D0%B3%D1%80%D0%B0%D1%84%D0%B8%D0%BA%D0%B0
http://ru.wikipedia.org/wiki/%D0%A0%D0%B0%D1%81%D1%82%D1%80%D0%BE%D0%B2%D0%B0%D1%8F_%D0%B3%D1%80%D0%B0%D1%84%D0%B8%D0%BA%D0%B0
http://ru.wikipedia.org/wiki/Mac_OS_X
http://ru.wikipedia.org/wiki/Mac_OS
http://ru.wikipedia.org/wiki/Microsoft_Windows
http://ru.wikipedia.org/wiki/SGI
http://ru.wikipedia.org/wiki/IRIX
http://ru.wikipedia.org/wiki/Linux
http://ru.wikipedia.org/wiki/Windows_API
http://ru.wikipedia.org/wiki/Wine
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Расширенная версия программы Adobe Photoshop Extended предназначена для 

более профессионального использования, а именно — при создании фильмов, видео, 

мультимедийных проектов, трехмерного графического дизайна и веб-дизайна, для работы 

в областях производства, медицины, архитектуры, при проведении научных 

исследований. 

В программе Adobe Photoshop Extended современных версий (CS4, CS5) можно 

открывать и работать с 3D-файлами, создаваемыми такими программами, как Adobe 

Acrobat 3D, 3ds Max, Maya и Google Earth. Photoshop поддерживает следующие форматы 

файлов 3D: U3D, 3DS, OBJ, KMZ и DAE. Возможно использовать трехмерные файлы для 

внедрения в двумерное фото. Доступны некоторые операции для обработки 3D-модели 

как работа с каркасами, выбор материалов из текстурных карт, настройка света. Также 

можно создавать надписи на 3D-объекте, вращать модели, изменять их размер и 

положение в пространстве. Программа включает в себя также команды по 

преобразованию плоских фотографий в трехмерные объекты определенной формы, такие 

как, например, банка, пирамида, цилиндр, сфер, конус и др. 

Задание 

1. По образцу создайте «Огненные буквы», «Каменные буквы», «Ледяные 

буквы», «Взрывные буквы». 

2. Создайте вашу фамилию в стиле огня, ваше имя в стиле льда, ваше 

отчество в стиле камня, вашу группу и курс в стиле взрывных букв. 

Огненные буквы 
1. Создайте новое изображение произвольного размера в цветовом режиме Grayscale 

(Градации серого), цвет фона должен быть белым. 

 

http://ru.wikipedia.org/wiki/Adobe_Acrobat
http://ru.wikipedia.org/wiki/Adobe_Acrobat
http://ru.wikipedia.org/wiki/3ds_Max
http://ru.wikipedia.org/wiki/Maya
http://ru.wikipedia.org/wiki/Google_Earth
http://ru.wikipedia.org/wiki/Universal_3D
http://ru.wikipedia.org/wiki/Obj
http://ru.wikipedia.org/wiki/KMZ
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2. Используя инструмент Type (инструмент «горизонтальный текст», напишите слово 

черным цветом. Деформируйте надпись с помощью кнопки Create Warped Text 

(деформировать текст..) на панели параметров. 

 

3. Склейте слой, на котором расположен текст, и слой фона с помощью команды 

Layer→Merge Down (Слой→Объединить с предыдущим). 

4. Примените к тексту фильтр кристаллизации с помощью команды 

Filter→Pixelate→Cristallize (Фильтр→Оформление→Кристаллизация) (размер ячейки 

кристаллизации 3–5 пикселов). 

 

5. Размойте изображение. Для этого воспользуйтесь фильтром Gaussian Blur:  

Filter→Blur→Gaussian Blur (Фильтр→Размытие→Размытие по Гауссу). Радиус размытия 

зависит от размера изображения и выбранного шрифта: чем больше буквы, тем больше 

должно быть значение радиуса. 
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6. Инвертируйте цвета рисунка: Image→Adjustments→Invert (Изображение→ 

Коррекция→Инверсия). 

 

7. Поверните изображение на 90º по часовой стрелке: Image→Rotate Canvas→90ºCW 

(Изображение→Повернуть холст→90º по часовой). 

8. Создайте язычки пламени с помощью фильтра Wind: Filter→Stylize→Wind 

(Фильтр→Стилизация→Ветер) (Направление выберите слева). Если пламя недостаточно 

велико, примените этот фильтр еще раз. 

 



72 

 

9. Добавьте в пламя колебание: Filter→Distort→Ripple (Фильтр→Искажение→Волна). 

 

10. Разверните изображение в обратную сторону: Image→Rotate 

Canvas→90ºCWW(Изображение→Повернуть холст→90º против часовой). 

 

11. Еще раз примените фильтр Ripple (Волна). 

12. Раскрасьте пламя. Для этого переведите изображение в режим индексированных 

цветов: Image→Mode→Indexed Color (Изображение→Режим→Индексированные цвета). 

Затем выполните команду Image→Mode→Color Table (Изображение→Режим→Таблица 

цветов). В раскрывающемся списке выберите таблицу Black Body (Абсолютно черное 

тело). 
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Ледяные буквы 

1. Создайте новое изображение произвольного размера в цветовом режиме Grayscale 

(Градации серого), цвет фона должен быть белым, цвет переднего плана – черным. 

2. Напишите текст. Шрифт лучше выбрать массивный, полужирного начертания. Под 

текстом оставьте место для сосулек. 

3. Склейте слой, на котором расположен текст, и слой фона с помощью команды 

Layer→Merge Down (Слой→Объединить с предыдущим). 

4. Выполните кристаллизацию букв Filter→Pixelate→Crystalize 

(Фильтр→Оформление→Кристаллизация), подобрав нужный размер ячейки 

кристаллизации. 

 

5. Так как ледяная поверхность не идеально гладкая, ей нужно придать шероховатость, 

причем этот эффект должен быть применен только к буквам, без фона. Выделите буквы 

(проще всего с помощью инструмента Magic Wand Tool (инструмент «волшебная палочка» 

выделить фон, а затем выполнить команду Select→Inverse (Выделение→Инверсия)), затем 

добавьте шум: Filter→Noise→Add Noise (Фильтр→Шум→Добавить шум). Задайте 
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значение Amount(Количество) равным 70% и установите флажок 

Monochromatic(Монохромный). 

 

6. Снимите выделение текста (Ctrl+D) и смягчите эффект, полученный при 

кристаллизации и добавлении шума, с помощью размытия: Filter→Blur→Gaussian Blur 

(Фильтр→Размытие→Размытие по Гауссу). 

7. Инвертируйте цвета изображения: Image→Adjustments→Invert 

(Изображение→Коррекция→Инверсия).  

 

8. Поверните изображение на 90º по часовой стрелке: Image→Rotate Canvas→90ºCW 

(Изображение→Повернуть холст→90º по часовой). 

9. Создайте сосульки с помощью фильтра Wind: Filter→Stylize→Wind (method – Wind, 

Direction – From the Right) (Фильтр→Стилизация→Ветер) (метод – ветер, направление – 

справа). 
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10. Переверните холст в исходное положение. 

11. Раскрасьте лед. Для этого переведите изображение в цветовой режим: 

Image→Mode→RGB Color (Изображение→Режим→ RGB), выполните команду 

Image→Adjustments→Hue/Saturation (Изображение→Коррекция→Цветовой 

тон/Насыщенность), установите флажок Colorize (Тонирование) и подберите остальные 

настройки по своему вкусу. 
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12. Увеличьте яркость и контрастность изображения, выполнив команду 

Image→Adjustments→Brightness/Contrast 

(Изображение→Коррекция→Яркость/Контрастность). 

Взрывающиеся буквы 

1. Создайте новое изображение в цветовом режиме RGB с фоном белого цвета. 

2. Буквами черного цвета напишите текст. Склейте слой с текстом со слоем фона. 

3. Смягчите контур текста: Filter→Blur→GaussianBlur (Фильтр→Размытие→Размытие 

по Гауссу) с радиусом размытия, равным 2. 

4. Примените еще один фильтр: Filter→Stylize→Solarize 

(Фильтр→Стилизация→Соляризация). В результате изображение станет черным, а от букв 

останутся светлые очертания. Сделайте буквы ярче: Image→Adjustments→Auto Levels 

(Изображение→Коррекция→Автоконтраст). 

5. Деформируйте текст: Filter→Distort→Polar Coordinates (Polar to Rectengular). 

Фильтр→Искажение→Полярные координаты (Полярные в прямоугольные) 

6. Поверните изображение на 90º по часовой стрелке и инвертируйте цвета командой 

Image→Adjustments→Invert (Изображение→Коррекция→Инверсия). 

 

7. Трижды примените к изображению фильтр Wind (Ветер). 
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8. Сделайте буквы ярче: Image→Adjustments→Auto Levels (Изображение→ 

Коррекция→Автоконтраст) и инвертируйте цвета командой Image→Adjustments→Invert 

(Изображение→Коррекция→Инверсия). 

 

9. Снова трижды примените фильтр Wind (Ветер). 

10. Поверните изображение против часовой стрелки. 

 

11. Вернитесь к обычным координатам: Filter→Distort→Polar Coordinates (Rectengular to 

Polar) Фильтр→Искажение→Полярные координаты  (Прямоугольные в полярные). 
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12. Раскрасьте изображение: Image→Adjustments→Hue/Saturations 

(Изображение→Коррекция→Цветовой тон/Насыщенность). 

 

Каменные буквы 

1. Создайте новое изображение в режиме RGB и напечатайте текст массивным шрифтом 

с четко выраженной формой (например, Times New Roman bold). Цвет фона может быть 

любым, цвет шрифта должен напоминать камень. Переведите слой с текстом в растр 

(Слой→Растрировать), выделите буквы с помощью инструмента Magic Wand (инструмент 

«волшебная палочка» , объедините все слои и примените фильтр для создания неровных 

краев текста: Filter→Distort→Ocean Ripple (Ripple Size 4-5, Ripple Magnitude 5-6) 

Фильтр→Искажение→Океанские волны (Размер волн 4-5, Сила волн 5-6). 

 

2. Немного сгладьте рваные края букв: Filter→Pixelate→Cristallize (Cell Size 4-7) 

Фильтр→Оформление→Кристаллизация (Размер ячейки 4-7). 
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3. Создайте шероховатую поверхность: Filter→Noise→Add Noise (Amount 20-30) 

Фильтр→Шум→Добавить шум (Количкство 20-30). Буквы при этом должны оставаться 

выделенными, иначе фильтр будет применен ко всему изображению. Не забудьте 

установить флажок Monochromatic, благодаря чему шум будет состоять из цвета, близкого 

к цвету букв. 

 

4. Создайте имитацию структуры камня: Filter→Texture→Cracuelure 

(Фильтр→Структура→Кракелюры). 

 

Домашнее задание 

Сделать отчет. 

Контрольные вопросы 

1. Как создать «Огненные буквы»? 

2. Как создать «Ледяные буквы»? 

3. Как создать «Взрывные буквы»? 

4. Как создать «Каменные буквы»? 
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Практическая работа №22. 

Тема: Создание текстовых эффектов в Photoshop 

Надпись огнём. Способ I 

1. Откройте приложение Adobe Photoshop 

2. Создайте новое изображение командой Файл ► Новый (<Ctrl>+<N>). Укажите 

следующие парамерты нового рисунка: 

Ширина: 10 см 

 
 

Окно Имя 

Высота: 7 см 

Разрешение: 72 пиксели/дюйм 

Режим: Чёрно-белое 

Содержание (фон): Белый 

3. Инструментом Текст  создайте надпись fire: 

Тип шрифта: Time New Roman 

 
 

Начертание: Bold Italic 

Размер: 150 пкс 

 

 

4. Инструментом Перемещение  выровняйте надпись ближе к нижнему краю 

изображения. 

 

 
5. Склейте слои командой Слой ► Слить с нижним (<Ctrl>+<E>). 

6. Кристаллизуйте надпись: Фильтр ► Pixelate ► Cristallize 

Cell Size (размер ячейки): 3-5 пикселя 
 

 

 
7. «Размойте» изображение: Фильтр ► Смазывание ► Смазывание Гаусса... 

Радиус: 1 пиксель 
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8. Инвертируйте 

изображение: Изображение ► Регулировки ► Инвертировать (<Ctrl>+<I>) 

 

 
9. Поверните изображение: Изображение ► Повернуть Холст ► 

90
o
против часовой стрелки 

 

 
10. Создайте язычки пламени: Фильтр ► Stylize ► Wind... 

Для усиления язычков примените фильтр несколько раз 
 

 

11.  

 
12. Для реалистичности добавьте колебания: Фильтр ► Distort ► Ripple... 

Amount (эффект): 50% 

 

 

Size (размер): Medium 

 

 
13. Поверните изображение: Изображение ► Повернуть Холст ► 

90
o
по часовой стрелке 

 

 
14. Примените ещё раз: Фильтр ► Distort ► Ripple... 
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Amount (эффект): 30% 

 

 

Size (размер): Lage 

15.  

16.  
17. Раскрасте пламя: Изображение ► Режим ► Индексированные Цвета 

Сопоставьте пламени цветовую модель: 

Изображение ► Режим ► Палитра. 

В окне Таблица цветов выберите BlackBody  

  
18.  

19.  
20. Готовое изображения сохраните в своей папке. 

 Надпись огнём. Способ II 

1. Откройте приложение Adobe Photoshop 

2. Создайте новое изображение командой Файл ► Новый (<Ctrl>+<N>). Укажите 

следующие парамерты нового рисунка: 

Ширина: 10 см 

 
 

Окно Имя 

Высота: 7 см 

Разрешение: 72 пиксели/дюйм 

Режим: Чёрно-белое 

Содержание (фон): Черный 

3. Инструментом Текст  создайте надпись fire: 

Тип шрифта: Time New Roman 

 
 

Начертание: Bold Italic 

Размер: 150 пкс 

Цвет: Белый 

4.  

5.  

6. Инструментом Перемещение  выровняйте надпись ближе к нижнему краю 

изображения. 
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7. Склейте слои командой Слой ► Слить с нижним (<Ctrl>+<E>). 

8. Поверните изображение: Изображение ► Повернуть Холст ► 

90
o
 по часовой стрелки 

 

 
9. Создайте язычки пламени: Фильтр ► Stylize ► Wind... 

Direction (направление): From the Left (слева) 

 

 

Для усиления язычков примените фильтр несколько раз 

10.  

11.  
12. Примените диффузию: Фильтр ► Стилизация ► Рассеивать... 

Режим:  нормальный 
 

 

13.  

14.  
15. Верните изображение: Изображение ► Повернуть Холст ► 

90
o
 против часовой стрелки 

 

 
16. Оживите пламя: Фильтр ► Distort ► Ripple... 

Amount (эффект):  100% 

 

 

Size (размер):  Medium 

17.  
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18.  
19. Раскрасте пламя: Изображение ► Режим ► Индексированные Цвета 

Сопоставьте пламени цветовую модель: 

Изображение ► Режим ► Палитра. 

В окне Таблица цветов выберите BlackBody  

  
20.  

21.  
22. Готовое изображения сохраните в своей папке. 

Надпись льдом 

1. Откройте приложение Adobe Photoshop 

2. Создайте новое изображение командой Файл ► Новый (<Ctrl>+<N>). Укажите 

следующие парамерты нового рисунка: 

Ширина: 10 см 

 
 

Окно Имя 

Высота: 7 см 

Разрешение: 72 пиксели/дюйм 

Режим: Чёрно-белое 

Содержание (фон): Белый 

3. Добавьте новый слой Слой ► Новый ► Слой... (<Shift>+<Ctrl>+<N>) и залейте 

его белым цветом с помощь. инструмента Заливка . 

4. Инструментом Текст  создайте надпись ice: 

Тип шрифта: Time New Roman 

 
 

Начертание: Bold Italic 

Размер: 180 пкс 

Цвет: Черный 

 

5.  

6. Инструментом Перемещение  выровняйте надпись ближе к верхнему краю 

изображения (внизу оставьте место для сосулек). 

 

 
7. Склейте слои командой Слой ► Слить с нижним (<Ctrl>+<E>). 

8. Кристаллизуйте надпись: Фильтр ► Pixelate ► Cristallize 
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Cell Size (размер ячейки):  6-8 пикселей 
 

 

9.  
10. Придайте шероховатость ледяной поверхности: Фильтр ► Шум ► Добавить 

шум: 

Количество: 70 

 
 

Окно Добавить шум 

Распределение: Гауссовское 

Одноцветный:  

11.  

12.  
13. Смягчите полученный эффект: Фильтр ► Смазывание ► Смазывание Гаусса... 

Радиус:  1,5-2 пикселя 
 

 

14.  

15.  
16. Произведите 

цветокоррекцию: Изображение ► Регулировки ► Кривые... (<Ctrl>+<M>) 
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17. Склейте слои командой Слой ► Слить с нижним (<Ctrl>+<E>). 

18. Инвертируйте 

изображение: Изображение ► Регулировки ► Инвертировать (<Ctrl>+<I>) 

 

 
19. Поверните изображение: Изображение ► Повернуть Холст ► 

90° против часовой стрелки 
 

 
20. Создайте сосульки: Фильтр ► Stylize ► Wind... 

Direction (направление): From the Right (Справа) 

 

 

 

21.  
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22.  
23. Верните изображение: Изображение ► Повернуть Холст ► 

90° против часовой стрелке 
 

 
24. Переведите изображение в цветовой режим: Изображение ► Режим ► RGB цвет 

25. Раскрасте изображение: 

Изображение ► Регулировки ► Тон/насыщенность 

Установить флажок 

Тонирование:  

 

 
 

 

Тон:  191 

Насыщенность:  77 
  

Яркость:  3 
  

26. Загрузитe кисти (Program_files/ Photoshop/ Goodies/ Brushes/ Assorted Brushes.abr). 

Выберите опцию Включить возможности пульверизатора  и создайте эффект 

искрящегося льда. 

 

 
27. Готовое изображения сохраните в своей папке. 

Надпись кровью 

1. Откройте приложение Adobe Photoshop 

2. Создайте новое изображение командой Файл ► Новый (<Ctrl>+<N>). Укажите 

следующие парамерты нового рисунка: 

Ширина: 15 см 

 
 

Окно Имя 

Высота: 7 см 

Разрешение: 72 пиксели/дюйм 

Режим: RGB цвет 

Содержание (фон): Чёрный 

3. Инструментом Текст  создайте надпись blood: 

Тип шрифта: Time New Roman 

 
 

Начертание: Bold Italic 

Размер: 150 пкс 

Цвет: Белый 

4.  
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5.  

6. Инструментом Перемещение  выровняйте надпись ближе к верхнему краю 

изображения (внизу оставьте расстояние для стекающей крови). 

 

 
7. Склейте слои командой Слой ► Слить с нижним (<Ctrl>+<E>). 

8. Поверните изображение: Изображение ► Повернуть Холст ► 

90° против часовой стрелки 
  

 

 
9. Примените 5 раз фильтр Ветер: Фильтр ► Stylize ► Wind... 

Direction (направление): From the Right (Справа) 

 

 

 

10.  

11.  
12. Верните изображение: Изображение ► Повернуть Холст ► 

90
o
 по часовой стрелке 

 

 
13. Примените: Фильтр ► Sketch ► Stamp 
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Light/Dark Balance: 5-6 

 

 

Smoothness: 1 

14.  

15.  
16. Инвертируйте 

изображение: Изображение ► Регулировки ► Инвертировать (<Ctrl>+<I>). 

 

 
17. Выделите изображение: Выделение ► Всё (<Ctrl>+<A>). 

18. Скопируйте выделенное в буфер 

обмена: Редактирование ► Копировать (<Ctrl>+<C>). 

19. На клавиатуре нажмите <Delete>. 

20. Перейдите в палитру каналов и создайте новый канал . 

 

 
21. Вставьте в новый канал содержимое буфера 

обмена:Редактирование ► Вставить(<Ctrl>+<V>). 

22. Перейдите в канал RGB и вернитесь к работе со слоями (<Ctrl>+<V>). 

23. Нажмите сочетание клавиш <Ctrl>+<Alt>+<4> (если понадобиться – инвертируйте 

выделение). 

 

 
24. Залейте область выделения подходящим цветом. 

 

 
25. Придайте надписи объём: 

Фильтр ► Sketch ► Bas Relief 
 

 
Окно Добавить шум 

26.  
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27.  
28. Готовое изображения сохраните в своей папке. 

Болотная надпись 

1. Откройте приложение Adobe Photoshop 

2. Создайте новое изображение командой Файл ► Новый (<Ctrl>+<N>). Укажите 

следующие парамерты нового рисунка: 

Ширина: 15 см 

 
 

Окно Имя 

Высота: 10 см 

Разрешение: 72 пиксели/дюйм 

Режим: RGB цвет 

Содержание (фон): Белый 

3. Залейте изображение тёмно-зелёным цветом. 

 

 
4. Перейдите в палитру каналов и создайте новый канал . 

 

 

5. Инструментом Текст  создайте надпись на новом канале slime: 

Тип шрифта: Time New Roman 

 
 

Начертание: Bold Italic 

Размер: 150 пкс 

Цвет: Белый 

6.  

7.  

8. Инструментом Перемещение  выровняйте надпись ближе к верхнему краю 

изображения (внизу оставьте расстояние для водорослей). 

 

 
9. Отмените выделение Выделение ► Убрать выделение (<Ctrl>+<D>). 

10. Перейдите на RGB канал. 
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11. Добавьте шум: Фильтр ► Шум ► Добавить шум 

Количество: 22% 

 

 

Распределение: Гауссовское 

Одноцветный:  

12.  

13.  
14. Примените 2 раз фильтр Ветер: Фильтр ► Stylize ► Wind... 

Direction (направление): From the Right (Справа) 
 

 

15.  

16.  
17. Перейдите к Альфа 1-каналу. 

18. Поверните изображение: Изображение ► Повернуть Холст ► 

90° против часовой стрелки 
 

 
19. Примените 3 разa фильтр Ветер: Фильтр ► Stylize ► Wind... 

Direction (направление): From the Right (Справа) 
 

 

20.  

21.  
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22. Добавьте колебания: Фильтр ► Distort ► Ripple... 

Amount (эффект):  5-6 

 

 

Size (размер):  Medium 

23.  

24.  
25. Верните изображение: Изображение ► Повернуть Холст ► 

90
o
 по часовой стрелке 

 

 
26. Перейдите на RGB канал. 

 

 
27. Примените: Фильтр ► Render ► Lighting Effects... со следующими параметрами: 

Style:   

 

 

Light 

type:  

On:  

Intensity: 45 

Focus: 69 

Gloss: 0 

Material: 69 

Exposure: 0 

Ambience

: 
8 

Texture 

channal:  

White is 

high:  

Height: 50 

28.  
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29.  
30. Удалите Альфа 1-канал. 

31. Готовое изображения сохраните в своей папке. 

Лазерная надпись (имитация неонового света) 

1. Откройте приложение Adobe Photoshop 

2. Создайте новое изображение командой Файл ► Новый (<Ctrl>+<N>). Укажите 

следующие парамерты нового рисунка: 

Ширина: 15 см 

 
 

Окно Имя 

Высота: 7 см 

Разрешение: 72 пиксели/дюйм 

Режим: RGB цвет 

Содержание (фон): Белый 

3. Инструментом Текст  создайте надпись на новом канале adobe: 

Тип шрифта: Time New Roman 

 
 

Начертание: Bold 

Размер: 150 пкс 

Цвет: Чёрный 

4.  

5.  

6. Инструментом Перемещение  выровняйте надпись по центру. 

 

 
7. Растрируйте изображние командой Слой ► Отрисовка ► Слой. 

8. Примените фильтр: Фильтр ► Artistic ► Plastic Warp... 

Highlight Strenght: 16 

 

 

Detail: 5 

Smoothness: 13 

9.  

10.  
11. Сделайте полосы более контрастными при помощи тоновых 

кривых: Изображение ► Регулировки ► Кривые. 

Постарайтесь построить кривую так, как показано на рисунке: 
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12. Сделайте лазерный луч цветным: Изображение ► Регулировки ► Выбор цвета 

Цвета:  

 

 

Голубой: 82 

Пурпурный: 1 

Жёлтый: -89 

Чёрный: 0 

Метод:  Абсолютный 

13.  

14.  
15. Перейдите к слою с фоном и залейте фон чёрным цветом 

 

 
16. Вернитесь к слою с надписью 

17. Сделайте сияние вокруг букв: Слой ► Эффекты слоя ► Внешний свет 

Режим перехода: 
 

 

 

Цвет света:      
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Полупрозрачнос

ть: 
75% 

Размер: 22 пкс 

18.  

19.  
20. Склейте слои 

21. Готовое изображения сохраните в своей папке. 

Буквы под снегом 

1. Откройте приложение Adobe Photoshop 

2. Создайте новое изображение: 

Ширина: 15 см 

 
 

Окно Имя 

Высота: 7 см 

Разрешение: 72 пиксели/дюйм 

Режим: RGB цвет 

Содержание (фон): Белый 

3. Залейте фон нежно-голубым цветом __. 

 

 
4. Напишите текст в оттенках тёмно-синего цвета __. 

 

 
5. Добавьте новый слой. 

6. На новом слое Кистью или Пульверизатором (аэрографом) с размытыми краями 

нанесите краску туда, где скопился бы снег, если бы он падал на надпись сверху. 

 

 

7. Инструментом Палец  смажьте края снега, как будто он под своей тяжестью 

стал нависать над буквами. 

Имитируйте наплывы снега, смазывая снег в вертикальном направлении. 

 

 
8. Добавьте шум: Фильтр ► Шум ► Добавить шум 

Количество: 16% 
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Распределение: Униформа 

Одноцветный:  
9.  

10.  
11. Примените фильтр: Фильтр ► Смазывание ► Смазывание... 

 

 
12. Нанесите снежинки Кистью 

 

 
13. Склейте слои 

14. Готовое изображения сохраните в своей папке. 

Надпись металлом 

1. Откройте приложение Adobe Photoshop 

2. Создайте новое изображение: 

Ширина: 15 см 

 
 

Окно Имя 

Высота: 7 см 

Разрешение: 72 пиксели/дюйм 

Режим: RGB цвет 

Содержание (фон): Белый 

3. В панели инструмента Текст выберите Horizontal Type Mask  

4. Напишите текст Metall 

 

 
5. Выровняйте надпись при помощи 

инструмента Выделение ► Преобразовать Выделение 

 

 
6. Установите цвет переднего плана чёрный, цвет фона – белый. 
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7. Залейте линейным Градиентом  буквы сверху вниз. 

 

 
8. Модифицируйте, точнее сузьте, 

выделение Выделение ► Модифицировать ► Сжать: 

Сжать на: 
3

 пикселя 

 

 

9. Залейте линейным Градиентом  буквы в обратную сторону (снизу вверх). 

 

 
10. Примените фильтр: Фильтр ► Texture ► Grain 

Itensity: 23 

Contrast: Униформа 

Grain Type:  
11.  

12.  
13. Добавьте шум: Фильтр ► Шум ► Добавить шум 

Количество: 21% 

 

 

Распределение: Гауссовское 

Одноцветный:  

14.  

15.  
16. Примените фильтр: Фильтр ► Резкозть ► Нечёткая маска 

Количество: 345% 

Радиус: 1,5 пикселя 

Порог: 45 уровней 

17.  
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18.  
19. Снимите выделение Выделение ► Убрать выделение (<Ctrl>+<D>). 

20. Инструментом Волшебная палочка  выделите белый фон. 

Обратная чувствительность: 0. 

(Не забудьте добавить выделение внутри букв). 

 

 
21. Инвертируйте 

выделение Выделение ► Инвертировать Выделение (<Shift>+<Ctrl>+<I>). 

22. Выполните копирование Редактирование ► Копировать (<Ctrl>+<C>) 

и вставку Редактирование ► Вставить (<Ctrl>+<V>). 

23. Примените эффект внешней тени : Слой ► Эффекты слоя ► Тень 

Режим смешивания:  

Мутноватость: 75% 

Угол: 120° 

Расстояние: 11 

Разброс: 5 

Размер: 10 

24.  

25.  
26. Склейте слои 

27. Готовое изображения сохраните в своей папке. 
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Практическая работа № 23.  

 

Тема: Создание коллажа в графическом редакторе. 

 

Цель: научиться создавать коллаж из портретной фотографии: мозаика 

 

В этой статье я расскажу, как превратить обычную фотографию в оригинальный коллаж. 

Лучше всего этот способ подойдёт для портретных фотографий и фото с фигурой одного 

человека. 

Урок очень простой и не требует каких-то особых знаний, достаточно иметь 

представление о слой-маске и панели слоёв Photoshop. 

Урок актуален для Photoshop версий CS2 и выше. 

Вот что получится в результате: 

 
Для начала, открываем фото в Фотошопе: онлайн. https://rugraphics.ru/photoeditor 

 
Открываем панель слоёв и дублируем фоновый слой (Ctrl+J). 

Создаём новый слой, нажав соответствующую иконку, расположенную внизу панели слоёв 

(показана на рисунке ниже), или нажав клавиши Ctrl+Shift+N, заливаем новый слой белым 

цветом (нажатие клавиши D, затем Ctrl+Delete) и с помощью мышки перетаскиваем белый 

слой между фоновым слоем и копией фонового слоя: 

https://rugraphics.ru/photoshop/chto-takoe-sloy-maska-v-photoshop
https://rugraphics.ru/photoshop/osnovy-raboty-v-paneli-sloyov
https://rugraphics.ru/photoshop/osnovy-raboty-v-paneli-sloyov
https://rugraphics.ru/photoshop/sloi-goryachie-klavishi#clon
https://rugraphics.ru/photoshop/osnovy-raboty-v-paneli-sloyov#add-l
https://rugraphics.ru/photoshop/fonovyy-sloy-v-photoshop
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Далее используем инструмент "Прямоугольная область" (Rectangular Marquee Tool) для 

создания прямоугольного выделения. Чтобы выделение получилось строго квадратным, 

перед созданием выделения надо зажать клавишу Shift. 

 
В панели слоёв выберите, если не выбран, верхний слой (у меня это "слой 1"). Добавьте к 

слою слой-маску, нажав на кнопу "Добавить слой-маску" (Add A Layer Mask). 

 
Это позволит добавить маску слоя к слою "слой 1", и, поскольку у меня была выделена 

часть изображения, то после добавления слой-маски Фотошоп оставит видимым только 

участок картинки, находящийся внутри выделения. Остальная часть изображения "слой 1" 

будет скрыта, в окне документа мы будем видеть только нижний белый слой. 

https://rugraphics.ru/photoshop/instrument-vydeleniya-pryamougolnaya-oblast
https://rugraphics.ru/photoshop/panel-sloyov-dobavlenie-elementov
https://rugraphics.ru/photoshop/chto-takoe-sloy-maska-v-photoshop
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В палитре слоёв на иконке маски мы видим белый прямоугольник в чёрном. Вся маска 

заполнена черным, кроме маленького квадратика. Этот белый квадрат является областью, 

которое видно в окне документа. 

Далее предпринимаем следующие действия. Кликаем по значку, указывающего на связь 

слой-маски со слоем, после чего он исчезнет, тем самым мы сделали слой-маску 

независимой от изображения, это нам понадобится для перемещения квадратика 

независимо от слоя и придания стиля именно квадратику: 

 
Кликаем по иконке маски на слое для её активации, вокруг иконки должна появиться 

рамка, указывающая на её активность (если нет уверенности в активации маски, то можно 

кликнуть по иконке слоя, а потом снова по маске, тогда будет видно исчезновение и 

появление прямоугольника-рамки вокруг иконок). 

Придадим стиль слоя маске, для того, чтобы были видны края квадрата. Далее в панели 

слоёв кликаем по иконке "Добавить стиль слоя"("New Adjustment Layer", значок в виде 

букв fx,находится рядом с иконкой "Добавить слой-маску"), в выпавшем меню выбираем 

"Внешнее свечение"(Outer Glow), и в открывшемся новом окне выбираем следующие 

параметры: 

https://rugraphics.ru/photoshop/panel-sloyov-dobavlenie-elementov
https://rugraphics.ru/photoshop/panel-sloyov-dobavlenie-elementov
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Белый слой нам больше не нужен, мы использовали его только для наглядности. Теперь 

можно отключить его видимость(клик по изображению глаза). Если мы всё сделали 

правильно, то должны получить такое изображение основного документа: 

 
Для создания следующего квадратика дублируем слой с маской, активировав его и нажав 

клавиши Ctrl+J. Слой копируется полностью со всеми свойствами и маской. Кликаем по 

иконке маски, чтобы активировать её. Воспользуемся инструментом Перемещение (Move 

tool) для перемещения квадрата с участком изображения. В окне главного документа 

перетянем его, к примеру вверх и влево. Если по ошибке мы выбрали не маску, а 

содержимое слоя, то перемещаться будет всё изображение. Ничего страшного в этом нет, 

нужно только нажать клавиши Ctrl+Z, при этом последнее действие отменится, а затем 

повторим попытку, кликнув по иконке маски слоя, и убеждаемся, что вокруг иконки 

маски появилась рамка, указывающая на активацию. 

Повторяем данное действие нужное количество раз. 

Также, можно менять размеры квадратиков, нажав на клавиши Ctrl+T, потянув за 

квадратики на появившейся рамке трансформации, а затем нажав Enter. 

https://rugraphics.ru/photoshop/osnovy-raboty-v-paneli-sloyov#visibility
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Убедившись, что новые квадратики нам больше не нужны, на всяк случай сохраняем 

файл. Затем выделяем все слои с масками (зажав клавишу Ctrl) и жмём клавиши Ctrl+E. 

Эти слои сольются в один самостоятельный слой уже без маски. 

Теперь займёмся фоновым слоем. Я придам ему размытость. Вкладка Фильтр --> 

Размытие --> Размытие по Гауссу, в диалоговом окне фильтра устанавливаем значение 

радиуса 2, а затем слегка уменьшим насыщенность, нажав клавиши Ctrl+U и уменьшив 

параметр "насыщенность" до -25 

Получилось вот это: 

 
 

 

 

 

 

Практическая работа № 24. 

Тема: Создание текстовых эффектов в графическом редакторе. 

Цель: научиться создавать интересные надписи средствами Photoshop, для успешного 

применения в дальнейшей работе. 

С развитием информационных технологий Фотошоп онлайн всё стремительнее догоняют 

возможности обычного. 

В этом материале я покажу, как в онлайн-Фотошопе создать простой креативный 

стильный, но при этом простой эффект для текста. 

Собственно, данный урок является повтором предыдущего, где я придал эффект тексту 

при помощи программы Adobe Photohop, а сейчас я сделаю то же самое, но уже в онлайне. 

Вот как выглядит готовый результат: 
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Ход работы 

1. Открываем Photoshop онлайн по этому адресу https://rugraphics.ru/photoeditor и 

создаём новый документ 500 на 500 пикселей. 

Берём инструмент "Градиент", выбираем вариант "Радиальный" и задаём ему цвета 

#717577 и #191918, на рисунке я показал последовательность кликов: 

 

Протащим градиент из центра в любой угол. 

Немного оживим фон. В верхнем горизонтальном (это главное меню) меню нажимаем на 

вкладку Фильтр --> Оформление, в диалоговом окне задаём максимальное значение 25: 

https://rugraphics.ru/photoeditor
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Этот фильтр соответствует фотошоповскому фильтру "Мозаика" (Mosaic). 

Инструментом "Обрезка" обрезаем нижнюю часть документа до высоты 175 пикселей. 

Размеры рамки обрезки можно посмотреть в панели "Навигатор", расположенной справа: 

 

Нажимаем клавишу Enter. С фоном всё. Можно сделать промежуточное сохранение файла, 

подробнее о сохранении фото онлайн рассказано здесь. 

2. Вставка текста 

Как сделать надпись на фото онлайн, подробно рассказано здесь. Вы можете использовать 

любые шрифты, имеющиеся в Вашем компьютере. 

Выбираем текстовый инструмент (на левой панели иконка в виде буквы "А"), кликаем по 

документу, появляется диалоговое окно ввода текста и габаритная рамка. Вписываю в поле 

ввода нужный мне текст, задаю цвет (белый), размер (54) и стиль (жирный), с помощью 

мышки перемещаю рамку в документе в желаемое место: 

https://rugraphics.ru/photoshop/sohranenie-fotografii-pri-redaktirovanii-onlayn
https://rugraphics.ru/forimage/nadpis-na-foto-onlayn
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После того, как закончите со вводом текста,нажмите кнопку "Да", чтобы закрыть 
диалоговое окно. 

 3. Добавление градиента к буквам 

В панели слоёв, расположенной справа, кликаем правой клавишей мыши по слою с 

текстом, в открывшемся меню нажимаем на строку "Растрировать слой". Зажимаем 

клавишу Ctrl и кликаем по миниатюре слоя, после чего в документе появится выделение 

по форме букв: 

 

Создаём новый слой кликом по кнопке внизу панели слоёв, берём инструмент "Градиент", 

ставим опцию "линейный", цвета на чёрный и белый и протягиваем снизу вверх, как 

показано на рисунке оранжевой стрелкой. Если результат не понравился, протащите 

градиент ещё раз, только измените положение начала и конца протягивания. Вот 

примерно что должно получиться: 
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Нажимаем Ctrl+D, чтобы снять выделение, либо Редактировать --> Отменить выделение. 

4. Добавление объёма к тексту 

Кликом по иконке внизу панели слоёв добавьте к тексту стиль слоя "Bevel" (Тиснение) со 

следующими настройками: 

 

5. Глянец 

Сделаем своеобразный глянец.Ещё раз, зажав Ctrl, кликните по иконке слоя с буквами (у 

меня он он после растеризации автоматически назвался называется "RuGraphics.ru") для 

получения выделения по контуру букв. Создайте новый слой. 

От центра протащите бело-чёрный радиальный градиент: 
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Снимите выделение, нажав Ctrl+D. 

Измените режим наложения слоя на Screen (Экран). Добавьте к слою слой-маску. 

Возьмите чёрную кисть, сделайте жёсткость 100%, зажмите Shift и кликните в трёх местах 

на тексте, как показано на рисунке синей стрелкой: 

 

Можно уменьшить непрозрачность этого слоя до 60-80%. 

Готовый результат 
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ПРАКТИЧЕСКАЯ РАБОТА № 25. 

Тема: «Назначение  презентаций. Создание  и сохранение  презентаций, 
основные операции со слайдами» 

Цель занятия: Изучение информационной технологии разработки презентации 

MS POWER POINT. 

Создание титульного слайда презентации. 

Порядок работы 

1. Запустите программу Microsoft Power Point. Для этого при стандартной установки 

MS Office выполните Пуск/Программы/ Microsoft Power Point. В открывшемся окне 

Power Point, предназначенном для открытия или выбора презентации, в группе 

полей выбора Создать презентацию, используя выберете Пустую презентацию и 

нажмите кнопку ОК.  

2. Следующим шагом будет появление окна Создание слайда, на котором 

представлены различные варианты разметки слайдов. 

3. Выберите самый первый тип – титульный слайд (первый образец слева в верхнем 

ряду). На экране появиться первый слайд с разметкой для ввода текста (метками – 

заполнителями). Установите обычный вид экрана (Вид/Обычный). 

4. Изучите интерфейс программы, подводя мышь к различным элементам экрана. 

5. Выберете цветовое оформление слайдов, воспользовавшись шаблонами дизайна 

оформления (Формат/Применить шаблон оформления). 

6. Введите с клавиатуры текст заголовка – Microsoft Office и подзаголовка – краткая 

характеристика изученных программ. Для этого достаточно щелкнуть мышью 

по метке – заполнителю и ввести текст, который автоматически будет оформлен в 

соответствии с установками выбранного шаблона. 

7. Сохраните созданный файл с именем «Моя презентация» в своей папке командой 

Файл/Сохранить. 

 

Создание второго слайда презентации – текста со списком. 

Порядок работы 

1. Выполните команду Вставка/Новый слайд. Выберете авторазметку – второй 

слева образец в верхней строке (маркированный список) и нажмите кнопку 

ОК. 

2. В верхнюю строку введите название программы «Текстовый редактор MS 

WORD». 

3. В нижнюю рамку введите текст в виде списка. Щелчок мыши по метке – 

заполнителю позволяет ввести маркированный список. Переход к новому 

абзацу осуществляется нажатием клавиши [ENTER]. 

Образец текста  

Текстовый редактор позволяет:  

 создавать текстовые документы; 

 форматировать текст и оформлять абзацы документов; 

 вводить колонтитулы в документ; 

 создавать и форматировать таблицы; 

 оформлять списки в текстовых документах; 

 представлять текст в виде нескольких колонок; 

 вставлять в документ рисунки; 

 готовить документ к печати. 

4. Выполните текущее сохранение файла. 

Создание третьего слайда презентации – текста в две колонки 

Порядок работы  
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1. Выполнить команду Вставка/Новый слайд. Выберите авторазметку  - третий 

слева образец в верхней строке (текст в две колонки) и нажмите кнопку ОК. 

2. В верхнюю строку введите название программы «Табличный процессор MS 

Excel». При необходимости уменьшить размер шрифта. 

3. Введите содержание в колонки. Щелчок мыши по метке - заполнителю 

колонки позволяет вводить в неё текст. 

Образец текста 

Возможности табличного процессора: 

 ввод данных в ячейки; 

 автозаполнение ячеек; 

 организация расчетов; 

 построение и 

форматирование 

диаграмм; 

 использование функций в 

расчетах; 

 применения 

относительной и 

абсолютной адресаций; 

 сортировка данных; 

 фильтрация данных и 

условное 

форматирование.
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4. Выполните текущее сохранение файла. 

Создание четвертого слайда презентации – текста с таблицей. 

Порядок работы  
1. Выполните команду Вставка/Новый слайд. Выберете авторазметку – первый 

справа образец в верхней строке (текст с таблицей) и нажмите кнопку ОК. 

2. В верхнюю строку введите название программы «СУБД MS Access». При 

необходимости измените размер шрифта. 

3. В нижней рамке выполните двойной щелчок – появиться окно задание 

параметров таблицы данных. Задайте количество столбцов – 2, строк – 5. 

4. В появившейся таблице выполните объединение ячеек в первой строке 

таблицы и заливку, используя панель инструментов. 

5. Введите исходные данные, представленные в табл. Для удобства работы 

откройте панель инструментов «Таблицы и границы» (Вид/Панели 

инструментов).  

Проектирование базы данных 

Таблицы для хранения данных 

Формы для ввода данных 

Запросы  для работ с данными 

Отчеты Для ввода информации из БД 

6. Выполните текущее сохранение файла. 

Создание пятого слайда презентации – текса с рисунком. 

Порядок работы  
1. Выполните команду Вставка/Новый слайд. Выберете авторазметку  - первый слева 

образец в нижней строке (текст и графика) и нажмите кнопку ОК. 

2. В верхнюю строку  введите название программы «MS Power Point». При 

необходимости шрифта. 

3. В левую рамку введите текст  по образцу. Выполните правостороннее 

выравнивание текста. 

Образец текста 

В большинстве случаев презентация готовиться для показа с использованием 

компьютера, ведь именно при таком показе презентации можно реализовать все 

преимущества электронной презентации. 

4. В правую рамку введите рисунок, выполнив двойной щелчок мыши по правой 

рамке, предназначенный для ставки рисунка. 

5. Перекрасьте рисунок. Для этого щелчком по рисунку выделите его (появиться 

маленькие квадратики по сторонам рисунка) и в панели Настройка изображения 

нажмите кнопку Изменение цвета рисунка. Для каждого цвета, используемого в 

рисунке, можно выбрать новый цвет. Изменения цвета будут отображены в окне 

предварительного просмотра. После завершения работы нажмите кнопку ОК. 

6. Щелчком по слайду уберите метки – квадратики рисунка, выполните текущее 

сохранение файла нажатием клавиш [Ctrl] - [S]. 

Создание седьмого слайда презентации – резюме. 

Вставьте новый слайд и введите текст резюме по образцу. 

Образец текста 

К достоинствам слайдовой презентации можно отнести: 

 Последовательность изложения; 

 возможность воспользоваться официальными шпаргалками; 

 мультимедийные эффекты; 

 копируемость; 

 транспортабельность. 

Выполните текущее сохранение файла. 

Дополнительное задание 

Задание. Изменить стиль заголовков. 
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Для этого выполните команду Вид/Образец/Образец слайдов. Щелкните по 

заголовку, измените тип шрифта (вместо Times New Roman используйте  Arial Cyr или 

наоборот). 

Вернитесь в слайд командой Вид/Обычный.  

Задание. Создать презентацию о своем учебном заведении.  

 

 

 

Практическая работа №26 

Тема: «Создание компьютерной презентации с помощью Шаблона в редакторе 

презентаций Microsoft Power Point» 

Цель работы: освоение практических навыков работы с Microsoft PowerPoint 

Ход работы. 

Запустите PowerPoint. Выберите в меню Справка команду Справка: Microsoft 

PowerPoint. В раскрывшемся затем окне Справка Microsoft PowerPoint выберите 

вкладку Содержание и изучите тему Приступая к работе, раздел Новые возможности в 

Microsoft PowerPoint. Открыв тему Получение справки, изучите разделы справочной 

информации о способах получения справочной информации во время работы. В разделе 

Создание презентаций изучите справку о различных способах создания презентаций. 

Выбрав вкладку Мастер ответов, задайте вопрос лсоздание презентаций╗ и 

щелкните кнопку лНайти╗. В списке найденных разделов изучите вариант Создание новой 

презентации на основе существующей. Выбрав вкладку Указатель, введите ключевое 

слово лшаблон╗, затем щелкните кнопку лНайти╗. Выбрав в списке ключевых слов 

шаблон, щелкните в списке найденных разделов на разделе Применение шаблона 

оформления. Изучив справочную информацию об использовании шаблонов, образцов, 

цветовых схем и макетов слайдов для управления внешним видом слайдов, закройте окно 

справки. 

Задание 1. Создать презентацию на тему Виды компьютерных программ. Для этого 

выполните следующую последовательность действий. 

1.    Для создания презентации выберите команду Создать вменю Файл, а затем в 

панели задачи Создать презентацию щелкните ссылку Новая презентация. В 

окне Создание слайда выберите автомакет Титульный слайд и щелкните кнопку лОК╗. 

2.    Щелкнув мышью в области заголовка слайда, введите заголовок презентации 

лВиды компьютерных программ╗. В подзаголовок слайда введите текст лПрограммным 

обеспечением называют организованную совокупность программ постоянного 

употребления, ориентирующую ЭВМ на тот или иной класс применений╗. 

Используя инструменты панели Форматирование, установите нужные параметры 

текстам заголовка и подзаголовка. 

3.    Для вставки нового слайда с организационной диаграммой выберите в панели 

задач Разметка слайда макет Объект. Щелкнув на макете Объект стрелку справа, 

выберите в контекстном меню команду Добавить новый слайд, как показано на рисунке 

1. 



113 

 

 

 Рис.1 Вставка слайда. 

Щелкнув на новом слайде в панели Рисование по кнопке  лДобавить 

организационную диаграмму╗. В появившемся окне Библиотека диаграмм выберите тип 

диаграммы, как показано на рис. 2. 

 

Введите заголовок диаграммы лТипы программного обеспечения╗, затем добавьте 

нужные фигуры и введите элементы диаграммы, как показано на рис. 3. 
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Рис.3 Создание организационной диаграммы. 

Для определения параметров текста можно использовать команды меню Текст. Для 

определения параметров элементов диаграммы применяйте команды контекстного 

меню Формат Автофигуры или инструменты из панели Рисование. 

 
Рис.4 Изменение стиля организационной диаграммы. 

Для изменения стиля организационной диаграммы щелкните кнопку 

лАвтоформат╗ в панели инструментов Организационная диаграмма и выберите стиль, как 

показано на рис. 4. Завершите создание организационной диаграммы и установите 

нужный размер вставленной диаграммы, используя маркеры объекта. 

4.    Для вставки нового слайда выберите в панели задачи Разметка 

слайда макет Заголовок, текст и графика и, щелкнув стрелку справа, выберите 

командуДобавить новый слайд. В область заголовка введите текст лПрикладные 

программы╗. В область текстовой рамки слайда введите текст о назначении прикладных 

программ, например, лПрикладное программное обеспечение -программы для решения 
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класса задач в определенной области применения систем обработки данных. Они 

непосредственно обеспечивают выполнение необходимых пользователям работ╗. 

В область графики вставьте картинку, для чего дважды щелкните кнопку лВставка 

картинки╗ на слайде, а затем в раскрывшемся окне Microsoft Clip Galleryвыберите 

нужный рисунок. Можно вставить рисунок из файла, для чего, указав область рисунка на 

слайде, выберите в меню Вставка команду Рисунок, а затем опцию Из файла. В 

окне Добавить рисунок найдите нужную папку и файл. Щелкнув кнопку лВставка╗, 

завершите вставку рисунка и задайте нужную позицию и размеры вставленному рисунку. 

5.    Действуя аналогично, добавьте слайды и введите текстовую и графическую 

информацию об остальных типах программного обеспечения. 

Задание 2. Оформите презентацию и настройте анимацию объектов. Для этого 

выполните следующую последовательность действий. 

1. Оформите презентацию с использованием готовых шаблонов оформления, 

для чего откройте в области задач панель Дизайн слайда. Выбирая в поле Применить 

шаблон оформления различные шаблоны оформления, просматривая варианты дизайна 

слайда, выберите подходящий шаблон. После этого выполнится настройка цветовой 

схемы, и все слайды презентации будут переоформлены в соответствии с выбранным 

шаблоном. 

2. Для настройки анимации слайдов откройте в области задач панель 

задачи Настройка анимации. Выбрав слайд и выбирая элемент слайда, настройте эффекты 

анимации. Для этого щелкните кнопку лДобавить эффект╗ и выполните одно или 

несколько следующих действий. Если во время показа слайдов требуется ввести текст или 

объект в сопровождении определенного визуального эффекта, укажите значок Вход, а 

затем выберите эффект. Если требуется добавить определенный визуальный эффект в 

текст или объект, находящиеся на самом слайде, укажите значок Выделение, а затем 

выберите нужный эффект. Если требуется добавить определенный визуальный эффект в 

текст или объект, который вызывает удаление текста или объекта со слайда в заданный 

момент, выберите значок Выход, а затем - нужный эффект (рис. 5). 

 
Рис. 5. Настройка анимации текста 

Для просмотра заданного эффекта анимации щелкните кнопку лПросмотр╗. Для 

изменения порядка появления анимации или ряда анимированных фрагментов, выбрав 
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параметр в списке настроек анимации, перетащите его в другое место списка. 

Для точной настройки параметров анимационных эффектов, щелкнув правой 

кнопкой мыши на стрелке справа строки с надписью эффекта в списке настройки 

анимации, откройте контекстное меню и выберите в нем команду Параметры эффектов. 

После этого откроется окно эффекта с вкладками Эффект, Время иАнимация объекта. 

Для уточнения назначения параметров воспользуйтесь подсказкой лЧто это такое?╗. 

Выбирая вкладки Эффект, Время и Анимация объекта, задайте нужные параметры и 

щелкните кнопку лОК╗. 

3. Для ввода заметок докладчика, указав слайд, щелкните в области заметок и 

введите текст заметок. 

4. Закончив работу над презентацией, выберите в 

меню Файл команду Сохранить. Открыв нужную папку, присвойте презентации имя, 

например, Виды компьютерных программ, и нажмите кнопку лСохранить╗. 

5. Для демонстрации презентации щелкните кнопку лПоказ слайдов╗ на 

панели инструментов. По окончании просмотра презентации закройте окно PowerPoint. 

Контрольные вопросы. 

1. Что такое компьютерная презентация?  

2. С каким расширением по умолчанию сохраняется файл презентации в MS Power 

Point 2007?  

3. Какая информация выводится в строке состояния?  

4. Где располагается и как настраивается панель быстрого доступа в окне MS Power 

Point 2007?  

5. Что такое слайд? Из чего он состоит?  

6. Каким образом можно создать новую презентацию?  

7. Что такое шаблон презентации?  

8. Что такое тема оформления  

9. Как добавить новый слайд в презентацию?  

10. Как удалить слайд?  

11. Как изменить порядок слайдов в презентации?  

12. Как изменить фон и цвета на слайде?  

13. Как изменить разметку слайда?  

14. Какие существуют режимы просмотра презентации?  

15. Как включить режим полноэкранного просмотра презентации?  

16. Как добавить на слайд картинку?  

17. Что такое рисунки Smart Art?  

18. Как добавить на слайд диаграмму?  

19. Как добавить на слайд таблицу?  

20. Как добавить на слайд текстовую надпись?  
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ПРАКТИЧЕСКАЯ  РАБОТА № 27 

Тема: «Вставка графических объектов в   презентацию (рисунков, таблиц, 
диаграмм)» 

 

Цель занятия: Изучение информационной технологии  ввода текста и его 

форматирования, вставки графических объектов (рисунков, таблиц, диаграмм) 

Задания 

Создать слайд, выбрав авторазметку Пустой слайд. 

Открыть текстовый документ  Практическая15.doc, находящийся в папке Материалы 1. 

1. Скопировать текст из этого документа в буфер обмена, а потом вставить его на 

слайд, как показано на рисунке. 

(Указание: вставлять текст в метку-заполнитель, чтобы он был 

форматируемым текстом, а не рисунком!) 

 
2. Вставить рисунки из графических файлов, также находящихся в папке 

Материалы 1. 

3. Сделать подписи к рисункам. 

4. Вставить диаграмму, используя материалы папки.  

5. Отформатировать текст, заголовок и подписи к рисункам, применяя кнопку 

Формат по образцу. 

 

____________________________________________________________________ 

 

 

Практическая работа № 28 

«Создание гиперссылки на произвольный показ или место в текущую 

презентацию» 

Цель: формирование умения создания навигации в презентации с помощью 

управляющих кнопок и гиперссылок. 

Задание: 

Необходимо создать презентацию «Компьютер, как исполнитель команд», в которой  

переход между слайдами будет осуществляться с помощью гиперссылок и управляющих 

кнопок. 

1. Создайте 7 пустых слайдов 

2. Сохраните презентацию под именем «Практическая работа №27» в своей 

папке. 

1 слайд 
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Данный слайд является титульным. 

Дизайн презентации:  

Разметка слайда: 

 
При помощи объекта «Надпись» на панели инструментов «Рисование» введите 

тему презентации. 

(выравнивание «По центру», шрифт Comic Sans MS, кегль 46, полужирное 

начертание). 

С помощью объекта «Надпись» введите информацию о разработчике данной 

презентации (выравнивание «По ширине», шрифт  Monotype Corsiva, кегль 28) 

Вставьте изображение компьютера. 

Переход с данного слайда будет осуществляться при помощи управляющих 

кнопок  «На следующий слайд» и  «Завершить показ 

презентации».  

Вставка управляющих кнопок осуществляется при помощи команды: Показ 

слайдов \ Управляющие кнопки. Выбираете нужную кнопку, растягиваете её на 

слайде, как обычный объект и определяете действие, которое будет происходить 

при активизации данной кнопки. 

1 слайд готов. 

2 слайд 

Разметка слайда: 
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Введите заголовок слайда «Схема компьютера» (выравнивание «По центру», 

шрифт Comic Sans MS, кегль 44, полужирное начертание). 

 
При помощи объекта «Надпись» создайте блоки схемы (выравнивание «По 

центру», шрифт Calibri, кегль 32, полужирное начертание). 

При помощи команды меню Формат \  Надпись \ Цвета и линии создайте 

границы и заливку объекта (Способы заливки – Градиентная), укажите два 

цвета (1 – желтый, 2 – белый). Нажмите Ok. 

В опции Линия  укажите цвет, шаблон, тип и толщину. 

Соедините блоки данной схемы стрелками (толщина линии 4,5 пт) 

Навигация данного слайда будет осуществляться при помощи управляющих 

кнопок и гиперссылок. 

В правой нижней части слайда вставьте кнопку  «На предыдущий слайд». 

 

Содержимое надписей будут являться гиперссылками. Для их создания 

необходимо:  

Выделить слово «Процессор», вызвать контекстное меню (правая кнопка 

мыши), выбрать пункт Гиперссылка. В левой части появившегося окна 

указать: Связать с: Местом в этом документе и выбрать 3 слайд. Нажать 

Ok. 

Точно так же создайте ещё 4 гиперссылки: 

1. Долговременная память 

2. Оперативная память 

3. Устройства ввода 

4. Устройства вывода 

При активизации ссылки «Долговременная память» будет происходить 
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переход на 4 слайд 

При активизации ссылки «Оперативная память» будет происходить переход 

на 5 слайд 

При активизации ссылки «Устройства ввода» - 6 слайд 

При активизации ссылки «Устройства вывода» - 7 слайд. 

Сравните с примером. 

2 слайд готов. 

3 слайд 

Разметка слайда: 

 

 

 

 

 

Введите заголовок слайда «Процессор» (выравнивание 

«По ширине», шрифт Comic Sans MS, кегль 44, полужирное начертание). 

 
В левый блок разметки вставьте изображение «Процессор». 

Правый блок заполните текстом (выравнивание «По ширине», шрифт Arial, кегль 

28, абзацный отступ 1 пт). 

В нижнюю правую часть вставьте управляющую кнопку . В 

появившемся диалоговом окне указать, что переход будет осуществляться 

на 2 слайд (обозначить: ПЕРЕЙТИ ПО ГИПЕРССЫЛКИ, выбрать из 

представленного списка СЛАЙД и указать 2 слайд). Добавьте правой 

кнопкой мыши слово «Назад». 

Сравните с примером. 

3 слайд готов. 

4 слайд 

Разметка слайда: 

 

 

 

 

 

Введите заголовок слайда «Долговременная память» 
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(выравнивание «По ширине», шрифт Comic Sans MS, кегль 44, полужирное 

начертание). 

 

 
 

Вставьте 4 изображения:  

Долговременная 1, долговременная 2, долговременная 3, долговременная 4. 

В нижнюю правую часть вставьте управляющую кнопку . В появившемся 

диалоговом окне указать, что переход будет осуществляться на 2 слайд. Добавьте 

правой кнопкой мыши слово «Назад». 

Сравните с примером. 

4 слайд готов. 

5 слайд 

Разметка слайда: 

 

 

 

 

Введите заголовок слайда «Оперативная память» 

(выравнивание «По ширине», шрифт Comic Sans MS, кегль 

44, полужирное начертание). 

Левый блок заполните текстом (выравнивание «По ширине», шрифт Arial, кегль 

28, полужирное начертание, абзацный отступ 1 пт). 
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В правый блок разметки вставьте из папки «Материалы» 3 изображения 

«Оперативная память 1»,  «Оперативная память 2», «Оперативная память 

3». 

 

В нижнюю правую часть вставьте управляющую кнопку . В появившемся 

диалоговом окне указать, что переход будет осуществляться на 2 слайд. Добавьте 

правой кнопкой мыши слово «Назад». 

Сравните с примером. 

5 слайд готов. 

6 слайд 

Разметка слайда: 

 

 

 

 

Введите заголовок слайда «Устройства ввода» 

(выравнивание «По ширине», шрифт Comic Sans MS, кегль 

44, полужирное начертание). 

Блок заполните текстом (выравнивание «По ширине», шрифт Arial, кегль 32). 
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В нижнюю правую часть вставьте управляющую кнопку . В появившемся 

диалоговом окне указать, что переход будет осуществляться на 2 слайд. Добавьте 

правой кнопкой мыши слово «Назад». 

Сравните с примером. 

6 слайд готов. 

7 слайд 

Разметка слайда: 

 

 

 

 

Введите заголовок слайда «Устройства вывода» 

(выравнивание «По ширине», шрифт Comic Sans MS, кегль 

44, полужирное начертание). 

Блок заполните текстом (выравнивание «По ширине», шрифт Arial, кегль 32). 

 

 

В нижнюю правую часть вставьте управляющую кнопку . В появившемся 

диалоговом окне указать, что переход будет осуществляться на 2 слайд. Добавьте 
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правой кнопкой мыши слово «Назад». 

Сравните с примером. 

7 слайд готов. 

 Запустите презентацию. Просмотрите эстетичность выполненной работы. 

Проверьте навигацию презентации. 

Контрольные вопросы. 

1. Как изменить маркировку пунктов списка на слайде?  

2. Как изменить шрифт для текста на слайде?  

3. Как изменить положение текстовой надписи на слайде? 

4. Для чего нужен режим «Сортировщик слайдов»?  

5. Как настроить анимацию объектов на слайде?  

6. Какие параметры эффектов анимации можно изменять при их настройке?  

7. Как добиться постепенного появления на экране рисунка Smart Art?  

8. Как настроить автоматическую смену слайдов во время полноэкранной 

демонстрации презентации?  

9. Как установить анимацию для смены слайдов при демонстрации презентации?  

10. Что такое репетиция просмотра презентации?  

11. С какого слайда может начинаться показ презентации?  

12. Что такое произвольный показ и как его создать?  

13. Какие действия можно настроить для объектов на слайдах? 

14. Как создаются управляющие кнопки? Для чего их можно использовать 

 

 

 

 

 

Практическая работа №29. 

Тема: Создание презентации «Обучающая презентация по работе с MS Power Point 

2007» с использованием графических объектов, анимации и гиперссылок. 

 

Цель работы: закрепить навыки работы в Power Point. 

Задание. 

Создать презентацию, которая должна содержать следующую информацию: 

Слайд 1. Титульный лист. 

Слайд 2. Содержание. 

Слайд 3. Запуск Microsoft PowerPoint 
Слайд 4. Просмотр презентации. 

Слайд 5. Редактирование текста презентации. 

Слайд 6. Режимы просмотра. 

Слайд 7. Создание презентации с помощью шаблона оформления 
Слайд 8. Реорганизация слайдов в презентации 
Слайд 9. Ввод и изменение текста слайдов. 

Слайд 10. Выравнивание текста и изменение интервалов 
Слайд 11. Проверка правописания и исправление текста. 

Слайд 12. Печать презентации. 

 

Презентация должна содержать графики объектов, анимацию и гиперссылки. 

 



125 

 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА № 30 

 

Тема: «Создание тематических презентаций. Настройка анимации. Показ 
слайдов»  

 
Презентацию можно создать несколькими способами. Воспользоваться мастером 

автосодержания, который на основе полученных ответов создает презентацию требуемого 

содержания и дизайна (на основе шаблонов презентации, которые включают в себя 

образцы слайдов с текстовыми заполнителями и дизайн презентации). 

Можно создать презентацию на основе шаблона, определяющего дизайн (но не 

содержание) презентации. Также можно открыть имеющуюся презентацию и на ее базе 

создать новую презентацию.Кроме того, можно создать новую презентацию без разметки, 

т.е. презентацию на базе пустых слайдов или применить разметку к пустым слайдам 

(макеты текста, макеты содержимого или макеты текста и содержимого). 

 

Мастер автосодержания 

Для создания презентации любым способом необходимо: 

1. В открытом окне приложения PowerPoint выбрать команду Файл/Создать, в 

области задач откроется панель Создание презентации. 

 
 

2. При создании презентации с помощью мастера автосодержания, требуется в области 

задач выбрать команду «Из мастера автосодержания», который позволяет создать набор 

слайдов определенного формата на выбранную тему. 

 

3. На первом шаге работы мастера отображается окно мастера с вводной информацией по 

созданию новой презентации, в котором следует нажать кнопку Далее. 
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4. Второй шаг предполагает выбор одного из стандартных видов презентации, которые 

определяют ее основную идею и содержание (доклад, учебный курс и т.д.). 

 
 

5. На следующем этапе необходимо определить способ вывода презентации 

(стиль), например, презентации на экране или презентации в Интернете. 

6. Затем следует указать заголовок презентации, а также выбрать объекты, 

которые будут размещаться на каждом слайде (нижний колонтитул, № слайда, дата 

последнего изменения). 

7. Последнее окно мастера содержит информацию о том, что все требуемые 

данные указаны. Для завершения работы по созданию презентации следует нажать кнопку 

Готово, после чего будет создана новая презентация, которая будет отображаться в режиме 

Обычный. Название слайда, презентации появляется на панели слайдов. Полная 

презентация, включая текстовые заполнители, которые есть на каждом слайде, 

отображается на панели структуры слева в окне PowerPoint. 
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8. Теперь можно приступить к работе с презентацией, замещая текстовые 

заполнители на слайдах нужными сведениями. Для этого нужно щелкнуть левой клавишей 

мыши в текстовом поле и ввести новый текст. 

 

Шаблон оформления 

В PowerPoint существует два вида встроенных шаблона – шаблоны презентации и 

шаблоны оформления, которые базируются на образце слайдов и образце заголовков. При 

работе с мастером автосодержания используется шаблон презентации. Этот шаблон 

включает в себя набор слайдов по стандартным видам презентаций, а слайды включают в 

себя как дизайн (форматирование слайда), так и образцы слайдов, которые содержат 

текстовые заполнители.  

 
Что касается шаблона оформления, то в нем содержатся только средства 

форматирования слайдов презентации, т.е. с его помощью можно назначить только стиль 

слайда, а разметку слайдов надо осуществлять с помощью панели «Разметка слайдов» в 

области задач. Другими словами шаблоны оформления – это шаблоны, которые 

представляют собой набор параметров шрифтов, используемых в слайдах, цвет фона, 

цветовые схемы слайдов презентации т.д. 
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Чтобы приступить к созданию новой презентации, используя шаблон оформления, 

необходимо: 

 

1. Загрузить приложение PowerPoint. По умолчанию Power Point открывается в режиме 

Обычный. То есть в окне приложения будет отображаться титульный слайд в режиме 

Обычный, в области Структуры/Слайды появится эскиз первого слайда, а в области задач 

будет отображаться панель «Приступая к работе». 

 

2. Затем необходимо выполнить команду Файл/Создать, в результате чего в области задач 

появится панель «Создание слайда». 

 

3. Далее на панели «Создание слайда» требуется выбрать команду «Из шаблона 

оформления», и в области задач появится панель «Дизайн слайда». В разделе «Применить 

шаблоны оформления» представлены все шаблоны оформления, которые представляют 

собой средства форматирования слайдов. Для назначения стиля титульному слайду 

необходимо щелкнуть на требуемый шаблон в области задач. Таким образом, будет 

отформатирован первый слайд с применением выбранного шаблона оформления. 

4. Теперь можно редактировать отформатированный слайд заголовка. 

5. После этого можно создать следующий слайд, щелкнув на на пиктограмме «Создать 

слайд» на панели инструментов. В области слайдов появится второй слайд в стиле первого 

слайда, а в области задач откроется панель «Разметка слайда», с помощью которой можно 

назначить разметку второму слайду, используя макеты текста, макеты содержимого или 

макеты текста и содержимого. 

6. Аналогично создаются последующие слайды презентации. 

Следует отметить, что шаблон оформления может быть применен не только к создаваемой, 

но и к уже имеющейся презентации. Для этого следует открыть требуемую презентацию и 

затем воспользоваться командой Формат/Оформление слайда. После выбора нужного 

шаблона в области задач следует нажать кнопку ОК, чтобы он был применен ко всем 

слайдам открытой презентации. 

 

Новая презентация 

Создание новой презентации без дизайна и разметки слайдов, т.е. без применения 

встроенных шаблонов презентации и оформления является сложной задачей. Этот способ 

создания презентации следует использовать лишь в том случае, когда пользователь ясно 

представляет себе внешний вид создаваемой презентации, а также формат слайдов, 

которые будут входить в ее состав. 

Для создания новой (пустой) презентации необходимо: 
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1. В открытом приложении PowerPoint выполнить команду Файл/Создать, а в области 

задач выбрать команду «Новая презентация». В результате этих действий в области задач 

откроется панель «Разметка слайда». 

 

2. Для создания презентации на базе пустого слайда необходимо щелкнуть на 

пустой слайд в разделе «Макеты содержимого» панели «Разметка слайда». Титульный 

слайд, который отображался в главном окне приложения, очистится и станет пустым. 

3. Далее можно самостоятельно вводить на пустой слайд: текст, рисунки, таблицы, 

диаграммы, звуки и т.д., а также самостоятельно разработать дизайн слайда. 

 
 

Для создания слайдов новой презентации можно также применить типовую разметку 

слайдов (макеты текста, макеты содержимого и т.д.), которая осуществляется с помощью 

команд на панели «Разметка слайдов» в области задач. 

Задания  

Создать презентации по одной  из тем:  

1. Необычные отели мира 

2.Стили оформления  гостиниц (классика, хай-тек, восточный стиль, модерн…) 

3. Установить настройку  анимации.    

4. Моя будущая профессия.   

 

 

 

 

Практическая работа № 31. 

Тема: Зачетное занятие по теме: «Презентации MS PowerPoint».Создание портфолио 

по профессии. 
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ПРАКТИЧЕСКАЯ  РАБОТА  № 32 

Тема: «Форматирование и редактирование  данных в ячейках таблицы MS 
Excel» 

Цель работы:  

- научиться выполнять вычисления, используя формулы; 

 -использовать при вводе формул относительные и абсолютные ссылки; 

- отработать навык копирования формулы; 

- закрепить навыки форматирования таблицы. 

 

Краткие  теоретические  сведения 

 

Ввод формул. Формулы представляют собой выражения, по которым выполняются 

вычисления. Формула всегда начинается со знака равно (=). Формула может включать 

функции, ссылки на ячейки или имена, операторы и константы. 

Формулы можно вводить с использованием клавиатуры и мыши при работе в 

любой вкладке Excel. С использованием клавиатуры вводят операторы (знаки действий), 

константы, скобки и, иногда, функции. С использованием мыши выделяют ячейки и 

диапазоны ячеек, включаемые в формулу. 

1. Выделите ячейку, в которую требуется ввести формулу. 

2. Введите = (знак равенства). 

3. Выделите мышью ячейку, являющуюся аргументом формулы. 

4. Введите знак оператора. 

5. Выделите мышью ячейку, являющуюся вторым аргументом формулы. 

6. При необходимости продолжайте ввод знаков операторов и выделение ячеек. 

7. Подтвердите ввод формулы в ячейку: нажмите клавишу Enter или Tab или 

кнопку Ввод (галочка) в строке формул. 

Задания и рекомендации по выполнению работы 

1. Изучить структуру электронной  таблицы   MS Excel.  Обратите  внимание  на 

вкладку Главная, найдите  кнопки Объединить ячейки, Вставить строки 

(столбцы), Формат ячеек,  Автоподбор ширины столбца (высоты  строки). 

Изучите справочный  материал. 

2. Создать таблицы и ввести  произвольные данные  (каждую таблицу  на новом 

листе). 

3. Переименовать листы  рабочей книги в  зависимости от содержания   находящихся 

на них таблиц. 

4. Сохранить файл рабочей  книги  в папке под своей  фамилией. 

5. Выполнить  вычисления  по формулам. 

6. Скопируйте формулы в нужном направлении.  (Выделите ячейку и протащите вниз 

маркер заполнения). 
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7. Просмотрите таблицу в режиме отображения значений и режиме отображения 

формул.   Что произойдет, если изменить несколько значений введенных с 

клавиатуры чисел? 

8. Выделите первую строку на одном листе и вставьте строку выше. Объедините 

несколько ячеек на первой строке и запишите в них название таблицы. 

9. Так же оформите  и остальные листы  рабочей книги. 

10. Сохраните таблицу и закройте окно Excel.  

 

Лист 1. Финансовая сводка за неделю  

Дни недели  Доход   Расход  Финансовый 

результат  

Понедельник     

Вторник     

    

    

Общий  финансовый результат  за неделю:   

 

Лист 2. Накладная  

№ 

п/п 

Наименование товара  Цена  Количество  Стоимость  

1     

2     

3     

4     

5     

  

 

Лист 3.Расчет премии  

№ 

п/п 

ФИО  

работника  

Оклад   Премия, 25 %  НДФЛ, 13 

% 

Сумма к выдаче  

1      

2      

3      

4      

5      

Лист 4. Движение  товаров  

 

№ п/п 

 
Наименование товара 

Приход Расход Остаток 

Ц
ен

а 

К
о
л
и

ч
е
ст

в
о

 

ст
о
и

м
о

ст
ь
 

п
р
и

х
о
д

а 

ко
л
и

ч
е
ст

в
о

 

ст
о
и

м
о

ст
ь
 

п
р
и

х
о
д

а 

ко
л
и

ч
е
ст

в
о

 

ст
о
и

м
о

ст
ь
 

п
р
и

х
о
д

а 

2         

3         

4         

5         

  

Лист 5. Анализ продаж  продукции  фирмы «М-Видео» за текущий месяц 
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Наименование  

продукции  

Цена, руб.  Продажи Выручка от 

продажи, 

руб.  
Безналичные 

платежи, шт.  

Наличные 

платежи, шт.  

Всего, шт.  

Радиотелефон  

 

     

Сканер       

Принтер       

Максимальные  продажи:     

Минимальные  продажи:    

 

 

 

 

Практическая работа №33. 

Тема: «Создание, редактирование и форматирование информации. Выполнение 

вычислений в электронной таблице. Копирование формул» 

 

Цель: освоить выполнение вычислений в электронных таблицах. 

Ввод текстовых данных 

Задание 1. В диапазоне ячеек A1:E3 создайте копию, приведенной ниже таблицы. 

  

 A 
B C D E 

1 Выравнивание 
Текст т 

е 
к 
с 
т 
 

Т
Е

К
С

Т
   Т

ек
ст 

2 текста 

3 
в Excel 

Методические указания. 

Введите необходимый текст в нескольких ячейках, предварительно объединив 

ячейки B1:B3, C1:C3, D1:D3, E1:E3, и расположите его различными способами в 

различных форматах. 

Для объединения ячеек используйте режим отображения объединение ячеек 

вкладки выравнивание команды Формат/Ячейки.  

Для направления текста в ячейках нужно выбрать нужную ориентацию вкладки 

выравнивание команды Формат/Ячейки 

Для форматирования текста воспользуйтесь командой Формат/ячейки/шрифт, 

для задания границ - Формат/ячейки/граница 

 Задание 2. Введите в одну ячейку A1 листа 2 предложение и отформатируйте 

следующим образом: 

ЭЛЕКТРОННЫЙ ПРОЦЕССОР  

EXCEL  

ПРЕДНАЗНАЧЕН ДЛЯ ОБРАБОТКИ ДАННЫХ, 

представленных в ТАБЛИЧНОЙ ФОРМЕ. 

Методические указания. 

Для добавления новой строки в ячейку используется комбинация клавиш ALT + 

ENTER. Для расположения текста в ячейке в несколько строк также можно применить 
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вкладку выравнивание команды Формат/Ячейки и установить флажок Переносить по 

словам. 

Задание 3.  На листе 3 постройте таблицу следующего вида: 

 

(текущая дата) (текущее время) 

Список студентов группы 
№ п/п Фамилия и.о. Дата рождения Средний балл 

1.  Иванов И.И. 12.05.1982 7,0 

2.  Петров П.П. 23.07.1981 8,0 

3. Сидоров С.С. 01.12.1982 7,5 

Средний балл группы 7.5 

 

Методические указания. 

Для объединения ячеек  в 1, 2 и последней строке необходимо выделить 

соответствующие ячейки и воспользоваться кнопкой объединить на панели 

инструментов. 

Для ввода текущей даты необходимо нажать комбинацию клавиш  

              + 

  

Для ввода текущего времени необходимо нажать комбинацию клавиш 

             +                 +          
 

Для задания границ воспользуйтесь кнопкой Границы на панели инструментов. 

Для задания заливки воспользуйтесь функциями вкладки Вид  команды 

Формат/ячейки или кнопкой цвет заливки на панели инструментов. 

 

Задание 4.  На листе 4  

a) Записать в ячейки A1-A12 названия всех месяцев года, начиная с января. 

b) Записать в ячейки B1-G1 названия всех месяцев второго полугодия 

c) Записать в ячейки A13-G13 названия дней недели 

 

Методические указания. 

Ввести первое значение и воспользоваться маркером автозаполнения (маленький 

квадратик, расположенный в правом нижнем углу активной ячейки или выделенной 

области). 

 

Ввод и заполнение числовых данных 

 

Задание 5. На листе 5 

a) Введите в ячейку С1 целое число 125,6. Скопируйте эту ячейку в ячейки C2, C3, С4, 

С5 и отобразите ячейку С1 в числовом формате, ячейку С2 в экспоненциальном, 

ячейку С3 в текстовом, ячейку С4 в формате дата, ячейку С5 в дробном формате; 

b) Задайте формат ячейки С6 так, чтобы положительные числа отображались в ней 

зеленым, отрицательные - красным, нулевые – синим, а текстовая информация 

желтым цветом (см. пояснения); 

c) Заполните диапазон A1:A10 произвольными дробными числами и сделайте формат 

процентный; 

d) Скопируйте диапазон A1:A10  в диапазон D1:D10, увеличив значения в два раза. 

Установите для нового диапазона дробный формат; 

Ctrl ; 

 Ctrl 

 

Shift ; 

http://bsu.name/Excel/3_01_help.html
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e) При помощи встроенного калькулятора вычислите среднее значение, количество 

чисел, количество значений и минимальное значение построенного диапазона А1:А10 

и запишите эти значения в 15-ю строку. 

 

Методические указания. 

Для задания формата отображения числа воспользуйтесь нужным форматом 

вкладки Число команды Формат/ячейки или определите свой (пользовательский) формат. 

При выделенном диапазоне чисел в строке состояние появляется значения калькулятора 

текущей функции. Изменить функцию калькулятора  можно посредством вызова 

контекстного меню (правая кнопка мыши) для строки состояния. 

Задание 6. На листе 6 необходимо 

a) Заполнить ячейки A1:A10 последовательными натуральными числами от 1 до 10 

b) Заполнить диапазон B1:D10 последовательными натуральными числами от 21 до 50 

c) Заполнить диапазон Е1:Е10 последовательными нечетными числами от 1 до 19 

d) Заполнить 27 строку числами 2, 4, 8, 16,…   (20 чисел) 

e) Скопировать диапазон A1:D10 в ячейки A16:D25 

f) Обменять местами содержимое ячеек диапазона A1:A10 с ячейками D1:D10 и 

содержимое ячеек диапазона A16:D16 с ячейками A25:D25 

 

Методические указания. 

Для заполнения чисел воспользуйтесь командой Правка/заполнить/прогрессия 

или используйте маркер автозаполнения. 

 

Задание 7.  На листе 7 построить таблицу Пифагора (таблицу умножения). Скопировать 

полученную таблицу на свободное место листа, уменьшив значения в три раза. 

 

Задания для самостоятельной работы 

 

Задание 1С. Ввести: 

1. в физически крайние угловые ячейки рабочей таблицы 1) название факультета, 2) 

название специальности, 3) номер группы, 4) фамилию, имя и отчество соответственно 

(физически крайние ячейки - A1, A65536, IV1, IV65536); 

2. в ячейку AB10001, текст “Пример 1”, расположив его по диагонали; 

3. в предпоследнюю ячейку первого столбца число 0,25, так чтобы оно отобразилось в 

ячейке как ¼; 

4. в последнюю ячейку второй строки рабочей таблицы название учебного заведения, 

расположив каждое слово в новой строке данной ячейки; 

5. Задайте формат ячейки С6 так, чтобы числа из отрезка [-10;10] отображались в ней 

зеленым, из интервала (10; 500] - красным, а остальные – синим цветом. Для каждого 

случая выбрать свой фон (используйте Условный формат - Меню Формат/Условное 

Форматирование). 

 

Задание 2С. Заполнить ячейки диапазона А1:A10000 нового листа: 

1 числом 123,45; 

2 последовательными целыми числами, начиная с –100 (см. пояснения для заданий 

2,3,4); 

3 последовательными нечетными целыми числами, начиная с 7 

4 последовательными целыми числами, которые при делении на 3 дают в остатке 1, 

начиная с 10; 

Задание 3С. Заполнить ячейки A1:A100 первой строки нового листа 

http://bsu.name/news/2010/03/14/180/
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1. символом “*” так, чтобы в первой строке не было пустого места; 

2.  дробными числами, начиная с 0.1 с шагом 0, 05; 

3. группой чисел  (-5; 8; 34), повторив ее нужное количество раз; 

4. Числами ½; ¼; 1/8; … 

 

Задание 4С. Заполнить ячейки диапазона A1:A100 произвольными числами. Не прибегая 

к помощи формул (используя Меню Правка/Специальная вставка), заполнить ячейки 

диапазона B1:B100 

1 удвоенными значениями массива А; 

2 уменьшенными в 10 раз значениями массива А; 

3 Значениями равными 1/Ai + Ai; 

4 Значениями равными Ai
2

 +2*AI+5. 

 

Контрольные вопросы. 

1. Что такое электронная таблица? 

2. Что такое электронный процессор? 

3. Какие структурные элементы содержит электронная таблица? 

4. Как задается адрес ячейки, адрес диапазона ячеек? 

5. С какими типами данных работает MS EXCEL? 

6. Какой символ нужно нажать в MS EXCEL, чтобы начать ввод формул? 

7. В чем отличие между абсолютными и относительными ссылками в MS EXCEL? 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА № 34. 

Тема: «Выполнение вычислений в  таблице. Использование абсолютных и 
относительных ссылок» 

 

 

1. Научиться использовать в  формулах ЭТ абсолютные и относительные ссылки. 

2. Изучить возможности создания формата пользователя. 

3. Научиться применять формат пользователя для оформления табличных документов. 

Краткие теоретические сведения 

 

 

 

Поле ввода нового 

формата 
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Рис. 1. Вид окна «Формат ячейки» при задании формата пользователя. 

 

 

Чаще всего для указания вида числового значения в ячейке с целью ее последующего 

вывода используется один формат для всех числовых значений, который устанавливается 

из диалогового окна Формат ячейки. Реже используются форматы для диапазонов 

числовых значений одной ячейки, например в формате можно указать выделение красным 

цветом шрифта отрицательных значений. Такой формат называется пользовательским. 

Образцы этого формата находятся в списке Числовые форматы (Все форматы) 

диалогового окна Формат ячейки. Иначе формат может быть набран пользователем в 

строке ввода Тип этого окна (см.рис.1). 

Ввод пользовательского формата производится с помощью окна Формат ячейки, 

вкладки «Числовой формат», в которой из списка «Числовые форматы» выбирается строка 

«Все форматы». В поле ввода числового формата вводится строка, задающая формат 

(рис.1). 

 

Шаблоны для отображения дат 

Д – отображает число даты без ведущего нуля (1 - 31). 

ДД – отображает число даты с ведущим нулем (01 - 31). 

М – отображает цифры месяца без ведущих нулей (1 - 12). 

ММ – отображает цифры месяца с ведущим нулем (01 - 12). 

МММ – трехбуквенное название месяца (янв, фев, мар и т.д.) 

ММММ – полное название месяца. 

ГГ – две младшие цифры года. 

ГГГГ – все четыре цифры года. 

ДДД – двухбуквенное название дня недели (пн, вт, ср и т.д.) 

ДДДД – полное название дня недели. 

чч – часы с ведущим нулем (00 – 23) 

мм – минуты с ведущим нулем (00 – 59) 

сс – секунды с веду3щим нулем (00 – 59) 

Примеры форматов дат: 
ДД.МММ.ГГГ ч:мм – дата 13.03.03 отображается как 13.мар.2003 0:00. 

ДДДД ДД.МММ - дата 14.03.03 отображается как пятница 14.мар. 

Пример задания. 

Составить таблицу расчета оплаты за квартиру для жильцов четырех квартир. Величины 

оплаты должны выводиться в денежном формате с разделением на группы разрядов по 3 в 

различном оформлении: c 200 до 1000 – синим, c 1000 р. – красным, другие – черным с 1 

разрядом после запятой. 

Исходные данные: площадь каждой квартиры и количество проживающих в ней. 

Известны также тарифы оплаты за газ и отопление.  

Правила расчета: 
Оплата = количество жильцов * тариф за газ + площадь квартиры * тариф за отопление. 

Планируемый результат работы приведен на рис.1. 
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Рис.2. Таблица расчета квартплаты с использованием формата пользователя. 

Порядок работы  

Этап №1. Открыть файл «Квартплата»,  созданный ранее  при выполнении 

работы №2 (или создать таблицу заново).  

Этап №2. Задание формата ячеек.  

 Разработать пользовательский формат на основе анализа задания.  

Диапазон числовых значений разделяется на 3 интервала: >=1000 р., <200р. и остальные. 

Поэтому формат будет содержать 3 части. Для оформления значения из каждого интервала 

нужно указать: цвет, сам интервал, вид числа и подпись. Для задания вида числа 

используем символы # и пробел для отделения разрядов тысяч. Желаемый формат : 

[Красный][>=1000]# ###р.;[Синий][<200]# ###р.;[Черный]0,0р. 

Цвет 
Диа-

пазон 

Вид 

числа 
Цвет 

Диа-

пазон 

Вид 

числа 
Цвет 

Вид 

числа 

Часть 1 Часть 2 Часть 3 

Выделить диапазон ячеек D6:D9. 

Выбрать пункт меню Формат/Ячейки, вкладку «Число», пункт «Все форматы». Вид 

окна «Формат ячейки» представлен на рис.1. 

Перейти в поле ввода нового формата, ввести разработанный на этапе два формат, 

нажать ОК. Вид рабочего листа должен совпадать с рис.2 

Этап №3. Сохранить документ под новым именем «Пример пр4+фамилия».  

 

Задания  

Вариант 1. 

1. Откройте рабочую книгу МS Excel.  

2. В открытом окне создайте таблицу следующего вида: 

 

 A B C D E F 

1  Накладная Курс доллара   

2 № Наименование 

товара  

Цена, руб. Количество  Стоимость, руб. Стоимость, $ 

3 1      

4 2      

 

3. Введите 15 наименований товара, его цену и количество. 

4. Введите формулу для подсчета стоимости в рублях в ячейку  Е3. 
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 = C3*D3.   Скопируйте эту формулу вниз. Просмотрите таблицу в режиме 

отображения значений. Как изменились адреса при копировании? 

5. Введите формулу для подсчета стоимости в долларах в ячейку F3.  =E3/E$1 (Чтобы 

адрес ячейки не изменялся при копировании, применяем знак   $  - последовательно 

нажмите клавишу F4 и посмотрите, как изменится ссылка на ячейку в  формуле). 

6. Просмотрите таблицу в режиме отображения значений. Как изменились адреса при 

копировании? 

Ответьте на вопросы:  

 В каких случаях применяются абсолютные, а в каких – относительные ссылки? 

 Какие ссылки используются по умолчанию?  

 Как ввести абсолютную ссылку? 

 

Вариант 2. 

Задание: пользуясь возможностями Excel создать таблицу для расчета оплаты за 

проживание в гостинице. 

Исходные данные: цены мест в номерах, даты заезда и выезда, дата оплаты. 

Правила расчета: 

Оплата: 

Сумма = цена места * (оплата По – дата заезда) 

Доплата: 

Дней = дата выезда – оплата По 

Сумма = цена места * доплата дней 

Возврат: 

Дней = дата выезда – оплата По 

Сумма = цена места * возврат дней 

ВНЕШНИЙ ВИД РАБОЧЕГО ЛИСТА  

 

Порядок работы  

1. Составить таблицу по образцу для расчета оплаты проживания 8 человек, для 

которых придумать фамилии, номера, цену места, даты.  

2. Заполнить первую строку формулами для расчета согласно заданным правилам.  

3. Проверить правильность расчета для первого человека. 

4. Размножить формулу по ячейкам остальных машин. 

5. Задать пользовательский формат ячеек столбцов «Доплата» так, чтобы: 

a. В столбце «дней» при получении положительной величины значение выводилось 

красным цветом с подписью «Доплата за …дн.». При получении других значение – не 

выводится ничего (пустые кавычки в формате). 

b. В столбце «сумма» при получении положительной величины значение выводилось 

красным цветом с подписью «р.». При получении других значение – выводился пробел 

(см.внешний вид листа). 

6. Задать пользовательский формат ячеек столбцов «Возврат» так, чтобы: 
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a. В столбце «дней» при получении отрицательной величины значение выводилось 

синим цветом с подписью «Возврат за …дн.». При получении других значение – 

выводился пробел (см.внешний вид листа). 

b. В столбце «сумма» при получении отрицательной величины значение выводилось 

синим цветом с подписью «р.». При получении других значение – выводился пробел 

(см.внешний вид листа). 

7. Оформить рабочий лист согласно образцу, используя возможности форматирования 

ячеек. 

 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА  № 35. 

 

Тема: «Использование функций электронной таблицы. Применение 

логических функций» 

 

Цель работы:  

- научиться использовать при вводе формул относительные и абсолютные 

ссылки; 

- сформировать навык  применения стандартных функций, работы  с Мастером 

функций; 

-рассмотреть использование  логических функций. 

- закрепить навыки форматирования таблицы. 

 

Краткие  теоретические  сведения 

 

 

Создать копию листа можно из контекстного меню (щелчком п.к.м. на ярлычке 

листа)  Переместить/Скопировать обязательно ставим флажок Создать копию, можем 

также указать, где поместить копию  ОК. 

  
Рис.1. Создание  копии листа. 

При вводе абсолютной  ссылки можно ввести знак $ с клавиатуры, но проще 

нажать функциональную клавишу F4. (Введите  какую-либо формулу в ячейку  и 

посмотрите, что произойдет при последовательном нажатии этой клавиши). 
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Запустить Мастер функций можно щелчком по кнопке  fx, расположенной  в 

строке  формул, или на вкладке Формулы. Можно также щелкнуть л.к.м. по кнопке  

Автосумма  на вкладке Главная, или на вкладке Формулы, и в  подменю выбрать 

Другие функции. 

 
Рис. 2. Подменю кнопки  (Автосумма). 

Раскрыв окно Мастера функций, выбираем нужную, и вводим ее аргументы.

 
Рис.3 Диалоговое  окно Мастера Функций. Категории функций. 

 

Задание № 1.  

 

1. Средствами табличного процессора Excel сформировать на седьмом  листе 

рабочей книги таблицу: 
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3  Шт.          

4  Шт.          

5  Шт.          

 Итого:          

 

2. Установить финансовый формат числа в столбце, где указана закупочная цена. 

3. С помощью кнопки Формат по образцу применить данный  формат к  тем 

столбцам, где указаны денежные суммы. 

4. Произвести все необходимые расчеты. 

5. Скопировать таблицу на следующий лист и изменить некоторые данные. 

 

Задание  №3. 

2.    В открытом окне на следующем листе создайте таблицу предложенного вида: 

 

 A B C D E F G 

1 № Фамилия Стаж Оклад  Премия  НДФЛ Сумма к 

выдаче 

2 1       

3 2       

4 3       

  

3. Введите  в столбцы В, С, D произвольные данные.  

4. В ячейку Е2  введите формулу для начисления премии, исходя из условий: если стаж 

менее 5 лет, премия составляет 15 % от оклада, в остальных случаях – 25 %.  Для этого в 

ячейку Е2 введите формулу = если (С2 <10,  D2*0,35; D2*0,25). 

5. В ячейку F2 введите формулу для подсчета НДФЛ (13 %). 

6. В ячейку G2 введите формулу для подсчета суммы к выдаче.  

7. Ответьте на вопросы:  

 Как изменится содержание ячеек в столбцах E,F,G, если изменить данные в 

столбце В? в столбце C? в столбце D? 

 Какие ссылки используются в данной таблице?  

 Используются  ли  в данной  таблице  абсолютные ссылки? Обоснуйте, 

почему. 

8. Создайте  3 копии последнего листа и измените формулы для  подсчета премии, 

используя другие  условия. Что изменилось, а что осталось неизменным?  

 

ПРАКТИЧЕСКАЯ РАБОТА  № 36 

Тема: «Проведение расчетов с вложенными функциями» 
Цели работы:  
1. Научить применять  вложенные функции для вычислений.  

2. Изучить средства контроля ввода данных. 

3. Научиться применять средства контроля данных в своих документах. 

4. Усвоить применение вложенных функций логических функций для вычислений, 

закрепить навыки работы с мастером функций; научиться вводить формулы с 

использованием вложенных логических функций  ЕСЛИ, И, ИЛИ. 

Краткие теоретические сведения 

При работе с табличными документами достаточно часто важным является правильность 

ввода данных в таблицы. Например, количество рабочих дней в месяце или количество 

отработанных часов имеет четко определенные границы и при вводе данные должны 

контролироваться на соответствие этим границам. Другой пример – название организации 
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«АО Путешествия». Оно должно всегда вводиться в одном и том же виде, т.к. если  

предполагается последующая сортировка, группировка или другое обобщение данных, то 

названия «Путешествия», «Путешествия АО» и «АО Путешествия» система сочтет 

именами разных организаций и подведет по ним три разных итога. 

В Excel имеются средства контроля ввода данных, которые пользователь может закрепить 

за определенными ячейками таблицы. Они доступны через меню Данные/Проверка. При 

этом открывается окно Проверка вводимых значений, состоящее из трех вкладок (рис.48). 

 

С помощью вкладки Параметры 

(на переднем плане) 

определяются условия, 

проверяемые системой при 

вводе, вкладки Сообщение для 

ввода – подсказка при вводе в 

контролируемую ячейку, вкладки 

Сообщение об ошибке – 

сообщение, выдаваемое 

пользователю, если он ввел 

неправильное значение. 

 

Сообщения об ошибке может 

быть трех видов (перечислены в 

порядке жесткости реакции 

системы): 

 

I. Останов. Самая жесткая 

реакция. Здесь пользователь может либо повторить ввод, но уже правильно (кнопка 

Повторить)  или отказаться от ввода (кнопка Отмена).  

II. Предупреждение. Пользователь может игнорировать предупреждение системы (Да) 

и оставить введенное значение, вернуться для исправления ввода (Нет) или совсем 

отказаться от него (Отмена). 

III. Сообщение – Пользователь может оставить введенные данные (Ок) или отказаться 

от них (Отмена). 

Примеры использования средств контроля:  

I. Нужно в ячейку А1 ввести дату рождения работника предприятия. Ясно, что он не 

может быть моложе 16 лет и старше 80-ти. Пусть при входе в контролируемую ячейку 

выводится подсказка «Дата рождения: от 16-ти до 80-ти лет». Поэтому для 2000 года будем 

считать самой ранней датой рождения 01.01.1920, а самой поздней – 01.01.1984.  

Для задания условий, проверяемых системой, используется вкладка Параметры: 

1. Строка Тип данных: Дата 

2. Строка Значение: Между 

3. Строка Минимум: 01.01.1920  (т.е. минимальный возраст работника) 

4. Строка Максимум: 01.01.1984 (т.е. максимальный возраст работника) 

5. Можно установить флаг Распространить изменения на другие ячейки с тем же 

условием. При этом включается режим, когда изменение условий для одной ячейки 

вызывает идентичные изменения в других  с  теми же условиями. 

6. Установить флаг Игнорировать пустые ячейки. Это подавляет вывод сообщения об 

ошибке при вводе пустого значения в контролируемую ячейку (оно не проверяется). 

Для задания подсказки служит вкладка Сообщение для ввода: 

1. Строка Заголовок: Дата рождения: 

2. Строка Сообщение: от 01.01.1923 до 01.01.1987  

Для задания реакцию системы на ошибочный ввод используется вкладка Сообщение об 

ошибке: 

Рис.48. Окно Проверка вводимых значений 

 



143 

 

1. Строка Вид: Останов  

2. Строка Заголовок: Ошибка 

3. Строка Сообщение: Неверная дата рождения! 

II. Усовершенствовать пример I: сделать так, чтобы условие проверки вводимых данных 

реагировало на естественное течение времени и автоматически определяло даты в 

зависимости от текущего года. Условие, что дата должна лежать между 01.01.1920 и  

01.01.1984 годится только для 2000 г.  

Для этого требуется изменить содержимое вкладки Параметры: 

1. Строка Тип данных: Другой 

2. Строка Формула: =И((СЕГОДНЯ()-А1)/364>16;(СЕГОДНЯ()-А1)/364<80). В формуле 

записано выражение: разница между текущим количеством дней и значением даты 

ячейки А1 должна быть больше 16 И меньше 80.  

III. Нужно, чтобы в ячейку вводилась фамилия сотрудника, содержащаяся в заданном 

списке. Список содержит 3 фамилии: Иванов Н.П., Петров С.А., Смирнов Е.Н. 

Содержимое вкладки Параметры: 

1. Строка Тип данных: Список 

2. Строка Источник: Иванов Н.П., Петров С.А., Смирнов Е.Н. (можно вводить адрес 

блока) 

При входе в ячейку с таким контролем справа от нее возникает кнопка вызова списка со 

стрелкой вниз. При введение другой фамилии выдается сообщение об ошибке вида 

Останов. Это режим по умолчанию. 

Практические задания 

 Задание   1  

1. Откройте рабочую книгу МS Excel.  

2.    В открытом окне создайте таблицу следующего вида: 

 

№ Фамилия Стаж Оклад  Премия  НДФЛ Сумма к 

выдаче 

1       

2       

3       

       

       

 Итого:      

 3. Введите  в столбцы В, С, D произвольные данные.  

4. В ячейку Е2  введите формулу для начисления премии, исходя из условий: если стаж 

менее 10 лет, премия составляет 10 % от оклада,  если стаж от 10 до 15 лет, премия 

составляет 20 % от оклада,   в остальных случаях – 30 %.  

5. В ячейку F2 введите формулу для подсчета НДФЛ (13 %). 

6. В ячейку G2 введите формулу для подсчета суммы к выдаче.  

7. Ответьте на вопросы:  

 Как изменится содержание ячеек в столбцах E,F,G, если изменить данные в 

столбце В? в столбце C? в столбце D? 

 Какие ссылки используются в данной таблице?  

 Как ввести абсолютную ссылку? 

     

 

Задание   2 

1. Откройте рабочую книгу МS Excel.  

2.    В открытом окне создайте таблицу следующего вида: 

 

№ Фамилия Стаж Оклад  Премия  НДФЛ Сумма к 
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выдаче 

1       

2       

3       

       

       

       

       

  

3. Введите  в столбцы В, С, D произвольные данные.  

4. В ячейку Е2  введите формулу для начисления премии, исходя из условий: если стаж 

менее 5 лет, премия составляет 10 % от оклада, если стаж от 5 до  10 лет включительно, 

премия составляет 800 руб., в остальных случаях – 25 %.  

5. В ячейку F2 введите формулу для подсчета НДФЛ (13 %). 

6. В ячейку G2 введите формулу для подсчета суммы к выдаче.  

 

Задание 3  

Пользуясь  возможностями Excel создать таблицу для расчета с клиентами на 

туристическое обслуживание их семей, включая перемет и проживание в месте отдыха, 

т.е. найти цену путевки. 

Исходные данные: фамилии клиентов, число детей и человек в семье, оплата отеля 

и перелета, скидки на детей. 

Правила расчета: 

Оплата отеля: итого = количество взрослых * оплата отеля за человека + 

количество детей * оплата отеля за человека с учетом скидки на ребенка 

Оплата полета: итого = количество взрослых * оплата полета за человека + 

количество детей * оплата полете за человека с учетом скидки на ребенка  

Цена путевки = оплата полета итого + оплата отеля итого 

Контроль ввода: 

Столбец «Число детей»:  

Параметры (условие проверки): Число детей < количества человек в семье 

Сообщение для ввода:  

Заголовок: Число детей: 

Сообщение: меньше числа человек в семье 

Реакция на ошибку – Останов, сообщение – Количество детей: Детей должен 

сопровождать хотя бы один взрослый! 

Столбцы «Оплата отеля за человека», «Оплата полете за человека»:  

Параметры (условие проверки): оплата > 0 

Сообщение для ввода:   

Заголовок: Оплата: 

Сообщение: больше 0 

Реакция на ошибку – Останов. 

Правила оформления: 

Строка клиента должна выделяться синим полужирным шрифтом, если число детей 

не равно 0. 

А также, если число человек в семье больше 5, то строка выделяется красным 

полужирным шрифтом. 

ВНЕШНИЙ ВИД РАБОЧЕГО ЛИСТА  



145 

 

 
 

 

ПРАКТИЧЕСКАЯ  РАБОТА № 37 

Тема: «Построение графиков  и диаграмм» 
 

Цель: научиться  строить и форматировать диаграммы  и графики. 

 

Краткие  теоретические  сведения 

 Excel предоставляет широкие возможности для создания деловой графики – 

диаграмм и графиков. Они отображают данные нагляднее, чем числа в ячейках таблицы. 

Рассматривая диаграммы или графики, можно сразу проводить анализ данных в таблице. 

Диаграмма – это графическое представление данных в таблице. 

Диаграммы строятся на основе уже готовых таблиц. 

Excel позволяет использовать более 30 типов диаграмм и графиков, многие типы 

имеют еще и подтипы. 

1.         Построение диаграмм 

1.Выделить данные, по которым будет строиться диаграмма. 

2.Нажать кнопку МАСТЕР ДИАГРАММ или ВСТАВКАДИАГРАММА 

Мастер диаграмм – это серия диалоговых окон, позволяющих создать 

новую диаграмму или отредактировать уже существующую. 

3.В диалоговом окне №1 выбрать тип диаграммы. Типы диаграмм расположены на двух 

вкладках – СТАНДАРТНЫЕ и НЕСТАНДАРТНЫЕ. После выбора типа и подтипа, можно 

нажать на кнопку ПРЕДВАРИТЕЛЬНЫЙ ПРОСМОТР и убедиться, что эта диаграмма 

будет выглядеть красиво. Иначе – выбрать другой тип. Нажать кнопку ДАЛЕЕ. 

4.В диалоговом окне №2 можно уточнить диапазон данных, по которым строиться 

диаграмма. Переключатели Ряды в строках или столбцах позволяют выбрать направление 

данных для построения диаграммы в том случае, если выбранный диапазон представляет 

собой  прямоугольную область.  

Ряды данных – наборы данных, представленные графически столбиками, 

секторами или линиями диаграммы.  

Нажать кнопку ДАЛЕЕ. 

5. В диалоговом окне №3 устанавливаются параметры диаграммы. Это окно может иметь 

различный вид, в зависимости от типа диаграммы.  

Общие для всех типов элементы: 

ЗАГОЛОВОК – можно ввести заголовок диаграммы. 

Легенда – область, в которой  расшифровываются цвета и узоры, 

соответствующие определенным данным в диаграмме. Для того, чтобы в 

легенде были осмысленные обозначения, необходимо выделять числовые 
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данные вместе с заголовками строк и столбцов в таблице. 

ПОДПИСИ ДАННЫХ – числовые, процентные или текстовые подписи возле каждого 

элемента диаграммы. 

ТАБЛИЦА ДАННЫХ – под диаграммой помещается фрагмент исходной таблицы с 

данными для диаграммы. 

Вкладки ОСИ и ЛИНИИ СЕТКИ не появляются для круговых и кольцевых диаграмм. 

После установки параметров диаграммы, нажимаем кнопку ДАЛЕЕ. 

6. В диалоговом окне №4 выбираем, где будет расположении диаграмма – на отдельном 

листе или на том же, что и исходная таблица. 

Все – диаграмма готова. 

2.            Форматирование диаграммы 

Готовую диаграмму можно в любой момент времени изменить и оформить по 

своему вкусу. Для этого служат панель инструментов ДИАГРАММЫ (она появляется 

автоматически после щелчка в любом месте диаграммы) и команда меню ДИАГРАММА. 

Она тоже появляется в строке меню после выделения диаграммы. 

Команда меню ДИАГРАММА содержит 7 команд: 

Первые 4 команды соответствуют названиям 4 диалоговых окон мастера диаграмм 

и открывают эти окна: ТИП ДИАГРАММЫ, ИСХОДНЫЕ ДАННЫЕ, ПАРАМЕТРЫ 

ДИАГРАММЫ и РАЗМЕЩЕНИЕ. Остальные команды позволяют выполнить такие 

действия: 

ДОБАВИТЬ ДАННЫЕ – можно добавить данные в диаграмму. 

Добавить линию тренда – в столбиковые и некоторые другие типы диаграмм 

добавляется плавная линия типа дополнительного графика. 

ОБЪЕМНЫЙ ВИД – можно настроить объем для некоторых типов диаграмм, 

например, для трехмерной гистограммы или для объемной линейчатой диаграммы. 

Панель инструментов ДИАГРАММЫ служит для изменения внешнего вида 

диаграммы. С ее помощью можно изменить цвет элементов диаграммы, шрифт подписей, 

выполнить заливку фона диаграммы и т.д. Выделяем нужный элемент, нажимаем кнопку 

ФОРМАТ на панели инструментов и устанавливаем нужные свойства. Либо щелкнуть 

правой кнопкой мыши на нужном элементе диаграммы и в контекстном меню выбрать 

нужную команду. 

 Ход работы: 

 Задание № 1 

 1.Открыть файл Практическая работа 2, лист Функция. 

2.Построить график функции по данным таблицы.. 

3.Сохранить сделанные изменения. 

 Задание № 2 

 1.Открыть новую рабочую книгу. 

2.Ввести информацию в таблицу по образцу. 

3.Выполнить соответствующие вычисления (использовать абсолютную ссылку 

для курса доллара). 

4.Отформатировать таблицу. 

5.Построить сравнительную круговую диаграмму цен на товары и диаграмму 

любого другого типа по количеству проданного товара. 

6.Диаграммы красиво оформить, сделать заголовки и подписи к данным. 
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7.Лист1 переименовать в "Оценка стоимости". Сохранить в файле Практическая 

работа (фамилия) 

 Расчет стоимости проданного товара 

 

 
  

Задание № 3 

 1.Перейти на Лист2. Переименовать его в Успеваемость. 

2.Ввести информацию в таблицу. 

Успеваемость 

 

 3. Вычислить средние значения по успеваемости каждого ученика и по 

предметам. 

4.Построить гистограмму по успеваемости по предметам. 

5.Построить пирамидальную диаграмму по средней успеваемости каждого 

ученика 

6.Построить круговую диаграмму по средней успеваемости по предметам. 

Добавить в этой диаграмму процентные доли в подписи данных. 

7.Красиво оформить все диаграммы. 

 

http://www.i-ias.ru/service_appraisal.html
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Практическая работа №38. 

Тема: Сортировка и фильтрация данных при обработке документа. Поиск 

оптимального решения 

Цели работы: 

 познакомиться с использованием электронной таблицы в качестве базы данных; 

 научиться осуществлять поиск информации в базе данных по различным критериям; 

 научиться производить сортировку информации; 

 ознакомиться с использованием форм для заполнения баз данных, поиска и 

корректировки записей в Excel 

 

Задание 1. Заполните таблицу, содержащую информацию о планетах Солнечной системы 

согласно Рис. 1. 

 

Планета Период Расстояние Диаметр Масса Спутники 

Венера 0,615 108 12 4,86 0 

Меркурий 0,241 58 4,9 0,32 0 

Земля 1 150 12,8 6 1 

Плутон 247,7 5900 2,8 0,1 1 

Нептун 164,8 4496 50,2 103,38 2 

Марс 1,881 288 6,8 0,61 2 

Уран 84,01 2869 49 87,2 14 

Юпитер  11,86 778 142,6 1906,98 16 

Сатурн 29,46 1426 120,2 570,9 17 

 

Рис.1. 

Единицы измерения, используемые в таблице: 

 период обращения по орбите - в земных годах; 

 среднее расстояние от Солнца - в млн. км; 

 экваториальный диаметр - в тыс. км; 

 масса – в 10
24

 кг. 

 

Основные понятия баз данных 

 Область таблицы A1:F10 можно рассматривать как базу данных. Столбцы A, B, С, 

D, Е, F этой таблицы называются полями, а строки с 2 по 10 - записями. 

Область A1:F1 содержит имена полей. 

Существуют ограничения, накладываемые на структуру базы данных: 

 первый ряд базы данных должен содержать неповторяющиеся имена полей; 

 остальные ряды базы данных должны содержать записи, которые не являются 

пустыми рядами; 

 информация по полям (столбцам) должна быть однородной, т. е. только цифры 

или только текст. 

Основная работа с любой базой данных заключается в поиске информации по 

определенным критериям. С увеличением количества записей поиск информации 

затрудняется. MS Excel позволяет упростить этот процесс путем фильтрации данных. 

Фильтрация данных 

 Команды Данные-> Фильтр  позволяют выделять (фильтровать) нужные записи. 

Фильтрация возможна как через автоматический фильтр – Автофильтр, так и через 
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ручной Расширенный. 

Автофильтр 

 При использовании Автофильтра необходимо переместить курсор в область, 

содержащую базу данных, или выделить ее. Затем нужно выполнить команды Данные-> 

Фильтр-> Автофильтр. На именах полей появятся кнопки с изображением стрелок вниз. 

Нажимая на кнопки, можно задавать критерии фильтрации. В появляющемся подменю 

пункт Все отключает фильтрацию, а пункт Настройка вызывает диалоговое окно, в 

котором можно установить параметры фильтрации. Для одного поля могут быть заданы 

два условия одновременно, связанные логическим И или ИЛИ. 

 

Задание 2. С использованием Автофильтра осуществить поиск планет, начинающихся на 

букву С или букву Ю с массой менее 600*10
24

 кг. 

 

2.1. Выполните команды Данные-> Фильтр-> Автофильтр. 

2.2. Нажмите на кнопку в поле Планета. Выберите пункт Условие. 

2.3. В диалоговом окне задайте критерий отбора:  равно с* или равно ю*. 

Проверьте! В базе данных осталась информация о планетах  Юпитер, Сатурн. 

2.4. Нажмите на кнопку на поле Масса. Выберите пункт Условие. 

2.5. В диалоговом окне задайте критерий:  меньше 600. 

Проверьте! Остался только Сатурн. 

2.6. Выполните команды меню Данные-> Фильтр-> Отобразить все. 

Задание 3. С использованием Автофильтра самостоятельно: 
 осуществите поиск планет, имеющих экваториальный диаметр менее 50 тыс. км. 

и массу менее 50*10
24

. кг (ответ: Меркурий, Венера, Земля, Марс, Плутон); 

 осуществите поиск планет, находящихся от Солнца на расстоянии не менее 100 

млн. км, имеющих массу в диапазоне от 3*10
24

 кг. до 600 *10
24

. кг, а также не 

более 2 спутников (ответ: Венера, Земля, Нептун). 

 

Задание 4. 

 

Заполните таблицу: 
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 С помощью автофильтра выберите в списке такие принтеры, цена которых не 

превышает 200 у.е. 

 Выберите из списка такие компьютеры, цена на которые превышает 2000 у.е. 

Расширенный фильтр 

 

 При использовании Расширенного фильтра необходимо сначала определить 

(создать) три области (см. рис. 2): 

 интервал списка - область базы данных (А1:F10);   

 интервал критериев - область, где задаются критерии фильтрации (A13:F14); 

 интервал извлечения - область, в которой будут появляться результаты фильтрации 

(A17:F19). 

 

Планета Период Расстояние Диаметр Масса Спутники  
Венера 0,615 108 12 4,86 0  
Меркурий 0,241 58 4,9 0,32 0  
Земля 1 150 12,8 6 1  
Плутон 247,7 5900 2,8 0,1 1  
Нептун 164,8 4496 50,2 103,38 2  
Марс 1,881 288 6,8 0,61 2  
Уран 84,01 2869 49 87,2 14  
юпитер  11,86 778 142,6 1906,98 16  
Сатурн 29,46 1426 120,2 570,9 17  

       
       

Планета Период Расстояние Диаметр Масса Спутники Спутники 
  >10       >2  <17 

       
       

Планета Период Расстояние Диаметр Масса Спутники  
Уран 84,01 2869 49 87,2 14  

интервал 

списка 

интервал 

критериев 

интервал 

извлечения 
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юпитер  11,86 778 142,6 1906,98 16  

 

Рис. 2 

 

 Имена полей во всех интервалах должны точно совпадать. 

 Для выполнения действий по фильтрации необходимо воспользоваться командами 

меню Данные-> Фильтр-> Расширенный фильтр. В диалоговом окне надо указать 

координаты всех запрошенных интервалов. 

 Если необходимо получать результаты фильтрации в интервале извлечения, нужно 

выбрать Скопировать результат в другое место. 

Задание 5. 

 С использованием Расширенного фильтра осуществить поиск планет с периодом 
обращения более 10 земных лет и количеством спутников не менее 2. 
4.1. Создайте интервал критериев и интервал извлечения (см. рис.2). 

4.2. Запишите критерии поиска в интервал критериев. 

4.3. Поместите курсор в область базы данных. 

4.4. Выполните команды Данные-> Фильтр-> Расширенный фильтр. 

4.5. Установите скопировать результат в другое место. Установите Поместить 

результат в диапазон. 

4.6. Укажите исходный диапазон, диапазон условий и диапазон результата (A17:F21). 

Нажмите кнопку ОК. 

Проверьте! Должны быть найдены планеты Юпитер, Сатурн. Уран, Нептун. 

Задание 6. С использованием Расширенного фильтра сделать самостоятельно: 
 найдите планеты, имеющие период обращения более 2  лет и экваториальный 

диаметр менее 50 тыс. км (ответ: Уран, Плутон); 

 осуществите поиск планет, находящихся от Солнца на расстоянии более 100 

млн. км., а также имеющих более 1 спутника (ответ: Марс, Сатурн, Уран, 

Нептун, Юпитер). 

 

Задание 7.  
 

 С помощью Расширенного фильтра отобразите фамилии сотрудников некоторой 

фирмы, которые получают свыше 500 000 руб. или чей возраст превышает 50 лет. 

 

  

 A B C D E 

1 Фамилия Имя Возраст Оклад Стаж 

2 Пашков Игорь 50 322.000 25 

3 Андреева  Анна 33 573.000 8 

4 Ерохин Владимир 48 494.000 20 

5 Попов Алексей 43 420.000 15 

6 Тюньков Владимир 58 332.900 30 

7 Ноткин Евгений 39 599.500 12 

8 Кубрина Марина 38 367.000 10 

 

 

 Для этой же исходной таблицы отобразите фамилии сотрудников, чей возраст не 

превышает 45 лет и чей стаж работы свыше 12 лет. 
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 Сортировка данных 

 Команды Данные-> Сортировка позволяют упорядочивать (сортировать) базу 

данных. Для выполнения сортировки необходимо выделить область базы данных или 

поместить в нее курсор, а затем выполнить команды Данные-> Сортировка. В 

появившемся диалоговом окне выбрать названия полей, по которым нужно производить 

сортировку, указать метод сортировки: по возрастанию или по убыванию и установить 

параметр Идентифицировать поля по подписям.  

После указанных действий база будет упорядочена. Символьные поля упорядочиваются в 

алфавитном порядке. 

Задание 8.  
 Отсортируйте данные в таблице в порядке убывания количества спутников 

 Отсортируйте данные в таблице в алфавитном порядке названий планет. 

 Отсортируйте данные в порядке увеличения их расстояния от Солнца 

Задание 9.  
 Введите данные о сотрудниках организации в соответствии с нижеприведенной 

таблицей: 

 

 A B C 

1 Фамилия Должность  Стаж 

2 Иванов Зав. отдела 25 

3 Петров математик 12 

4 Сидоров экономист 8 

5 Иванов инженер 5 

6 Победоносцев менеджер 3 

7 Приблудин наладчик 16 

8 Иванов инженер 8 

9 Казаков бухгалтер 22 

10 Ржевский программист 10 

11 Петров математик 6 

12 Казаков менеджер 4 

13 Сидоров экономист 3 

14 Победоносцев бухгалтер 7 

15 Иванов наладчик 20 

16 Петров наладчик 12 

 

Проведите сортировку списка сотрудников по фамилиям, затем по должностям и, в 

последнюю очередь, – по стажу.  

 

Создание и ведение списков с помощью Форм  

 

 Всегда можно вносить новую информацию в список, переходя к первой пустой 

строке в нижней части списка (т.е. путем ввода данных с клавиатуры). Однако проще 

делать это с помощью команды Форма меню Данные, которая выводит одну строку 

списка. Перед ее использованием необходимо выделить любую ячейку в списке. Команда 

Данные –> Форма открывает окно диалога. 

В верхней части формы Excel выводит имя листа, содержащего список, ниже находятся 

все заголовки столбцов списка. В правом верхнем углу формы выводится информация 

об общем количестве строк в списке и номере строки, отображаемой в форме в данный 

момент. В правой части формы находится несколько кнопок, предназначенных для 

работы со списком. 
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Чтобы вставить в список новую строку, нужно нажать кнопку Добавить. Excel 

выведет пустую форму, в которой можно ввести значения для этой строки. Чтобы 

вернуться в лист, нужно нажать кнопку Закрыть.  

Чтобы изменить некоторое значение в списке, нужно использовать для перехода к 

нужной строке полосу прокрутки в окне формы и внести изменения в соответствующее 

поле ввода. 

Для удаления строки из списка переходят к ней с помощью полосы прокрутки и 

нажимают кнопку Удалить.  

 

Поиск строк с помощью Формы 

Для поиска нужной строки с помощью Формы необходимо: 

 

 Выделить щелчком любую заполненную ячейку списка (таблицы). 

 Выполнить команду Данные  –> Форма. 

 В появившемся окне щелкнуть на кнопке с надписью Критерии. 

 Заполнить поля Формы условиями поиска. Чем больше полей вы заполните, тем 

точнее будет поиск и тем меньше придется просматривать записей. 

 Установить указатель мыши на кнопку Найти следущее  и нажимать левую кнопку 

мыши до тех пор, пока не появится нужная запись. 

 После нахождения нужной строки (записи) щелкнуть на команде Закрыть. 

Задание 10. 
Заполните с помощью формы таблицу: 

 

 
 

 

(Указание: данные в ячейки A1:E1 введите обычным образом, в остальные – с помощью 

Формы).В режиме Формы найдите в списке фамилию Бобиков и замените ее на Шариков, 

затем удалите запись с фамилией Трепало. Введите с помощью формы еще 5–7 записей, 

продублируйте фамилию Иванов. Произведите поиск всех записей, содержащих эту 

фамилию. 

 

 

Практическая работа №39. 

Тема: Использование сценариев модели «что-если», средств подбора параметров и 

поиска решения для анализа данных. 

Цель работы: научиться использовать сценарий модели «что - если». 

Задание 1 . 

 Создать таблицу, показанную на рисунке. 
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 А В С 

1 Функции Дата и время 

2 Начало работы   

3 Системная (текущая) дата и время   

4 Сегодня   

5 Конец месяца   

6 Конец года   

7 Осталось до конца месяца   

8 Осталось до конца года   

9    

10 День рождения   

11 Прожил дней   

12 Сегодня + 100 дней   

13 Сегодня + 365 дней   

 

Алгоритм выполнения задания. 

1. Записать указанный текст обозначений в столбец А. 

2. В ячейку В2 записать дату и время своей работы строго соблюдая формат, например, 

15.01.07 10:15 (т.е. 15 января 2007 года 10 часов 15 минут) 

3. В ячейку В3 вставить текущую дату с помощью Мастера функций: 

3.1. Выделить ячейку В3, щёлкнуть значок fx на панели инструментов Стандартная 

или выполнить команду Вставка/Функция.  

3.2.В диалоговом окне Мастер функций в левом поле Категория выбрать Дата и 

время, в правом поле Функция найти и выбрать ТДАТА, нажать Ок и ОК. 

4. В ячейку В4 вставить текущую дату с помощью Мастера функций, выбрав функцию 

СЕГОДНЯ. 

5. В ячейки В5 и В6 записать даты конца месяца и конца года, например, 31.01.07 и 

31.12.07. 

6. В ячейку В7 записать формулу =В5-В4 (получим разность в формате ДД.ММ.ГГ). 

7. В ячейку В8 записать формулу =В6-В4 (получим разность в формате ДД.ММ.ГГ). 

Примечание. Программа некорректно обрабатывает количество месяцев, завышая его на 

единицу. 

8. В ячейку В10 записать дату своего дня рождения, например, 29.12.90. 

9. Вычислить число прожитого времени по формуле =В4-В10 (в формате ДД.ММ.ГГ и 

учётом примечания). 

10. Вычислить даты в ячейках В12 и В13, самостоятельно записав нужные формулы. 

11. Преобразовать дату в ячейке В13 в текстовый формат, для этого: 

11.1. Выделить ячейку В13, выполнить команду Формат/Ячейки/Число.  

11.2. В диалоговом окне в поле Числовые форматы выбрать Дата, в поле Тип выбрать 

формат вида «14 март, 2001», нажать ОК.  

12. Скопировать диапазон ячеек В4:В6 в диапазон С4:С6, для этого: 

12.1. Выделить диапазон В4:В6. 

12.2. Щелкнуть кнопку Копировать на панели инструментов Стандартная или 

выполнить команду Правка/Копировать. 

12.3.  Выделить ячейку С4, щёлкнуть кнопку Вставить на панели инструментов 

Стандартная или выполнить команду Правка/Вставить.  

13. Преобразовать формат даты в ячейке С6 в текстовый, выполнив команду 

Формат/Ячейки/Число и выбрав Тип «Март 2001». 

14. Преобразовать формат даты в ячейке С5 в текстовый, выполнив команду 

Формат/Ячейки/Число и выбрав Тип «14 мар». 

15. Преобразовать формат даты в ячейке С4 в текстовый, выполнив команду 

Формат/Ячейки/Число и выбрав Тип «14 мар 01». 
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16. Установить в ячейке С3 отображение секундомера системных часов, для этого: 

16.1. Выделить ячейку С3, щёлкнуть значок fx на панели инструментов Стандартная 

или выполнить команду Вставка/Функция. 

16.2. В диалоговом окне Мастер функций в левом поле Категория выбрать Дата и 

время, в поле Функция найти и СЕКУНДЫ, нажать ОК. 

16.3. В диалоговом окне СЕКУНДЫ ввести в поле Дата_как_число адрес В3, ОК. 

16.4. Значения секунд в ячейке С3 будут изменяться при нажатии клавиши F9. 

17. Вычислить длительность выполнения работы, для этого: 

17.1.Выделить ячейку С2, записать формулу =В3-В2, нажать Enter, результат будет 

записан в формате ДД.ММ.ГГ ЧЧ:ММ. 

17.2.Преобразовать значение в ячейке С2 в формат ЧЧ:ММ:СС, для этого: 

17.2.1. Выделить ячейку С2, выполнить команду Формат/Ячейки/Число.  

17.2.2. В поле Числовые форматы выбрать (все форматы). 

17.2.3. В поле Тип выбрать [ч]:мм:сс, нажать ОК. 

17.2.4. Значения секунд в ячейке С2 будут изменяться при нажатии клавишиF9. 

18. Сравнить вычисленные значения с показанием системных часов на Панели задач. 

Задание 2. 
Создать таблицу, показанную на рисунке. 

 А В C L С D E 

1 Ведомость начисления заработной платы 

2 № 

п/п 
Фамилия Оклад 

Материальная 

помощь 
Сумма к выдаче 

3 1 Сидоров 1850   

4 2 Петров 1000   

5 3 Глухов 2300   

6 4 Смирнов 950   

7 5 Галкин 1100   

8 6 Иванов 4500   

9 7 Авдеев 3400   

10 8 Горшков 2800   

11  Всего:    

Алгоритм выполнения задания. 

1. В ячейке А1 записать название таблицы. 

2. В ячейках А2:Е2 записать шапочки таблицы с предварительным форматированием 

ячеек, для этого: 

2.1. Выделить диапазон ячеек А2:Е2. 

2.2. Выполнить команду Формат/Ячейки/Выравнивание. 

2.3. Установить переключатель «переносить по словам». 

2.4. В поле «по горизонтали» выбрать «по центру». 

2.5. В поле «по вертикали» выбрать «по центру». 

2.6. Набрать тексты шапочек, подбирая по необходимости ширину столбцов 

вручную. 

3. Заполнить графы с порядковыми номерами, фамилиями, окладами. 

4. Рассчитать графу Материальная помощь, выдавая её тем сотрудникам, чей оклад 

меньше1500 руб., для этого: 

4.1. Выделить ячейку D3, вызвать Мастер функций, в категории Логические 

выбрать функцию ЕСЛИ. 

4.2. В диалоговом окне функции указать следующие значения: 

Логическое выражение С3<1500 

Значение_если_истина 150 

Значение_если_ложь 0 
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4.3. Скопировать формулу для остальных сотрудников с помощью операции 

Автозаполнение. 

5. Вставить столбец Квалификационный разряд. 

5.1. Выделить столбец Е, щёлкнув по его заголовку. 

5.2. Выполнить команду Вставка/Столбцы. 

5.3. Записать шапочку Квалификационный разряд. 

5.4. Заполнить этот столбец разрядами от 7 до 14 произвольно так, чтобы были 

все промежуточные разряды. 

6. Вставить и рассчитать столбец Премия, используя логическую функцию ЕСЛИ, 

выдавая премию в размере 20% оклада тем сотрудникам чей разряд выше 10. 

 

Логическое выражение Е3>10 

Значение_если_истина С3*0,2 

Значение_если_ложь 0 

7. Рассчитать графу Сумма к выдаче так, чтобы в сумму не вошёл 

Квалификационный разряд. 

8. Рассчитать итоговые значения по всем столбцам, кроме столбца 

Квалификационный разряд. 

9. Проверить автоматический перерасчёт таблицы при изменении значений: 

9.1. Изменить оклады нескольким сотрудникам, проверить изменение таблицы. 

9.2. Изменить квалификационные разряды нескольким сотрудникам. 

10. Изменить условие начисления премии: если Квалификационный разряд выше 12, 

то выдать Премию в размере 50% оклада. 

 

 

ПРАКТИЧЕСКАЯ РАБОТА № 40  

Тема: «Создание комплексных документов. Специальная вставка» 
 

Цель занятия: Закрепление и проверка навыков создания комплексных текстовых 

документов с встроенными расчетными таблицами и графиками. 

 

Задание. 

Применяя все известные вами приемы создания и форматирования текстовых и табличных 

документов, выполните задания по образцу, стараясь создать по внешнему виду документ 

как можно ближе к оригиналу задания. 

Создать «Акт о порче товарно-материальных ценностей». 

   Текстовую часть документа создайте в текстовом редакторе MS World, таблицу расчёта 

стоимости товарно-материальных  ценностей (ТМЦ) для списания создайте в MS Excel, 

скопируйте в текстовом документ. 

    Создать «Акт о порче товарно-материальных ценностей». Текстовую часть создайте   в  

документе  MS Word, таблицу расчета    стоимости ТМЦ – в MS Excel, проведите расчёты.  

Выполнить связывание  документов  с  помощью команды Специальная вставка. 

 

Образец  задания  

Наименование организации  

Отдел 

 «Утверждаю»   

Руководитель организации 

« ___ » __________  201_  г. 

 

АКТ 

О ПОРЧЕ ТОВАРНО-МАТЕРИАЛЬНЫХ ЦЕННОСТЕЙ 

                         ОТ «   »                                             201__  г. 
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       Комиссия в составе: председатель                          ,  

                                      члены комиссии         

  на основании приказа от    ____   №   __________       составила настоящий акт в том, что 

указанные ниже ценности пришли в негодность и подлежит списанию 

 

Итого по акту _______ наименований  на сумму _____ р. ____ к. 

_____________________________________________________________ 

(прописью по розничным ценам или по ценам приобретения) 

Председатель комиссии:    ___________________________ 

члены  комиссии:              ____________________________ 

____________________________ 

 

 

ПРАКТИЧЕСКАЯ РАБОТА № 41 

Тема: «Вывод на печать. Предварительны просмотр. Редактирование таблицы в 
режиме  предварительного просмотра» 

 

Цель занятия: научиться оформлять страницы документа перед печатью: устанавливать 

параметры страницы, нумерацию страниц, колонтитулы; научиться просматривать 

документ перед печатью; настраивать параметры печати; научиться составлять отчёты и 

печатать сводные таблицы. 

 

Краткие  теоретические  сведения  

№ 

п/п 

 

 

Наименование 

Ед. 

изме- 

рения 

Кол-во Стоимость Причины и 

характер 

порчи и дата 

заключения 

Розничная Оптовая 

Цена 
Стоимост

ь 

Цен

а 

Стоимос

ть 

1 Стол шт. 15 250 
? 

 
? 

№7 от  

15.03.04 

2 Стулья шт. 28 45 
? 

 
? 

№2 от  

15.02.04 

3 Скатерти шт. 45 20 
? 

 
? 

№1 от 

15.01.04 

4 Шторы шт. 10 75 
? 

 
? 

№5 от 

1.03.04 

5 Двери шт. 12 120 
? 

 
? 

№8 от 

5.03.04 

6 Компьютер шт. 1 5200 
? 

 
? 

№9 от 

15.04.04 

7 Калькулятор шт. 5 100 
? 

 
? 

№11 от 

15.04.04 

8 Телевизор шт. 1 4300 
? 

 
? 

№12 от 

15.04.04 

10         

 Итого ?       
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Установка параметров страниц документа перед печатью. 

Для установки параметров команда Файл/Параметры страницы. Появится 

диалоговое окно Параметры страницы, содержащее 4 вкладки: 

 на вкладке Страница задаётся книжная или альбомная ориентация листа, масштаб 

относительно оригинала, формат бумаги и разрешение в точках на дюйм (качество 

печати), как и на каком количестве страниц должен быть расположен документ; 

 на вкладке Поля можно задать размеры полей страницы и выровнять содержимое 

документа по центру; 

 на вкладке Колонтитулы можно выбрать стандартный или задать новый колонтитул, 

причём для создания нового колонтитула предоставляется много шрифтов и 

изображений; 

 вкладка Лист предназначена для выбора области печати, определения сквозных строк и 

столбцов для указания заголовков, указания порядка вывода страниц на печать. Здесь 

же можно задать печать сетки, чёрно-белую или черновую печать, ввести комментарии. 

Замечание: на каждой вкладке доступны три кнопки управления, назначение которых 

понятно из их названий: Печать, Просмотр и Свойства. 

Рассмотрим подробнее некоторые вышеописанные параметры. 

Полем называется пустое пространство на листе за пределами области печати. По 

умолчанию размер левого и правого полей 1,9см, верхнего и нижнего – 2,5см. Эти цифры 

меняются на вкладке Поля. Также устанавливается расстояние между колонтитулами и 

краями листа. В окне Предварительного просмотра можно щёлкнуть на кнопке Поля, 

чтобы удостовериться в корректности выполненных установок. Чтобы выровнять 

документ по центру страницы нужно установить флажки По горизонтали и По вертикали в 

области Центрировать на странице. 

Электронная таблица, подготовленная к печати, может не помещаться на одном листе 

бумаги. Тогда программа автоматически разобьёт таблицу на несколько прямоугольных 

диапазонов ячеек, которые будут выводиться на печать на отдельных листах бумаги. На 

экране все диапазоны помечаются пунктирной линией. На вкладке Лист диалогового окна 

Параметры страницы задаётся последовательность вывода на печать многостраничных 

таблиц. Задание параметров печати в области Печать на каждой странице позволяет 

вывести на каждой странице одинаковые строки или столбцы, которые в дальнейшем 

будут применяться в качестве заголовков (Сквозные строки или Сквозные столбцы). 

Чтобы вывести на печать диапазон ячеек, его нужно предварительно выделить, затем 

выполнить команду Файл/Область печати/Задать. Проще на вкладке Лист щёлкнуть на 

значке Выводить на печать диапазон, а затем выделить мышью нужный диапазон. Если 

выделить диапазон непосредственно перед печатью, затем выполнить команду Печать, 

затем в диалоговом окне Печать поставить флажок Выделенный диапазон, то все 

предыдущие установки будут отменены. 

Колонтитулы применяются, чтобы на каждом листе разместить информацию общего 

и специального назначения. Это может быть название всего документа или его рубрик, 

имя автора или дата создания документа. Колонтитулы можно добавить командой 

Вид/Колонтитулы или с помощью диалогового окна Параметры страницы. В любом 

случае можно создать верхний и нижний колонтитулы и выровнять их содержимое по 

левому краю, по правому и по центру. Текст колонтитула вводится и редактируется как в 

обычном текстовом редакторе, а графические изображения и коды полей добавляются с 

помощью кнопок, расположенных в центре диалогового окна Колонтитулы. С помощью 

этих кнопок возможно: 

 установить параметры шрифта для текста колонтитула; 

 вставить номер текущей страницы; 

 вставить общее число страниц документа; 

 вставить дату печати рабочего листа; 

 вставить время печати рабочего листа; 
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 вставить полное имя файла рабочей книги (включая путь к файлу); 

 вставить имя рабочей книги; 

 вставить имя рабочего листа; 

 вставить изображение; 

 открыть диалоговое окно редактирования вставленного изображения. 

Коды полей представляют собой специальные символы, которые при печати 

документа заменяются определёнными значениями. Например, код (&[Файл]) заменяется 

именем файла; код (&[Дата]) заменяется текущей датой. 

Размещение листа на странице. 

В программе Excel существует возможность печатать страницы не только в 

натуральную величину, но и в уменьшенном или в увеличенном виде. Для изменения 

размера печатаемого листа применяют элементы управления, расположенные в области 

Масштаб вкладки Страница диалогового окна Параметры страницы. 

Чтобы пропорционально изменить размер документа относительно его натуральной 

величины нужно установить переключатель Установить и задать в его поле значение 

диапазона от 10 до 400. Если это значение больше 100, документ печатается в 

увеличенном виде, а если меньше 100 – в уменьшенном. 

Выбор переключателя Разместить не более чем на позволяет задать количество 

страниц, на которых необходимо разместить печатаемую таблицу, тогда программа 

подбирает масштаб документа автоматически. Чтобы быть компактным и читабельным, 

документ должен удовлетворять трём условиям: 

1. логически связанные данные нужно располагать рядом, а не на разных страницах; 

2. при размещении информации на одной странице документ должен оставаться удобным 

для чтения и наглядным; 

3. нужно, чтобы все страницы документа были по возможности одинаково заполнены. 

Настройка параметров печати. 

Командой Файл/Параметры страницы можно установить ориентацию страницы, её 

размер и масштаб, качество печати принтера и номер первой страницы. По умолчанию 

задана книжная ориентация страницы. Выводимый на печать текст по умолчанию 

разбивается таким образом, чтобы полностью заполнить страницу. Но автоматическая 

разбивка на страницы может быть выполнена некорректно (например, имена полей 

оторваны от значений). Чтобы увидеть, в каких местах будут разрывы страниц, нужно 

выполнить команду Вид/Разметка страницы. Можно щёлкнуть на кнопке Разметка 

страницы в окне Предварительного просмотра (в данном режиме выводятся не только 

выводимые на печать данные, но и номера страниц). 

На Рабочем листе разрывы страниц отображаются пунктирными линиями. Можно 

выделить строку или столбец, снизу или справа которого требуется поместить линию 

разрыва, затем в контекстном меню выбрать команду Добавить разрыв страницы. 

Разрывы, установленные вручную, отображаются на экране как сплошные синие линии. 

Можно менять диапазон печати, перемещая линии разрывов. 

В режиме разметки страница редактируется также как в обычном режиме. Вернуться 

в Обычный режим можно командой Вид/Обычный. Сбросить все разрывы, установленные 

вручную, можно командой контекстного меню Сброс разрывов страницы. 

В окне Параметры страницы можно задать порядок вывода страниц на печать, 

получить несколько копий, установить качество печати, вывести на печать номера строк и 

названия столбцов. 

Предварительный просмотр документа. 

Кнопка Предварительный просмотр установит данный режим. В данном режиме 

отображается только одна страница. Для просмотра следующих страниц есть кнопки 

Далее и Назад, которые недоступны, если в документе всего одна страница. Можно 

просмотреть несколько рабочих листов, выделив их перед командой Предварительного 
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просмотра. Можно просмотреть диапазон ячеек в увеличенном виде с помощью кнопки 

Масштаб. Замечание 1: в окне Предварительного просмотра можно перемещать 

диаграммы, в нём доступны все операции по подготовке документа к печати, причём сразу 

можно отправить документ на печать. 

Замечание 2: в режиме предварительного просмотра можно изменять размеры полей и 

колонтитулов, а также ширину столбцов. 

 

Печать документа. 

Для вывода документа на печать выполнить команду Файл/Печать или щёлкнуть на 

кнопке Печать на Стандартной панели инструментов, после чего на экране откроется 

диалоговое окно Печать. 

В диалоговом окне Печать можно задать для печати Выделенный диапазон, 

Выделенные листы или Всю книгу, задать количество копий для печати и поставить 

флажок Разобрать по копиям, задать диапазон страниц для печати. 

Замечание: на вкладке Лист диалогового окна Параметры страницы есть три способа 

сокращения времени вывода документа на печать: печать в черновом режиме, в чёрно-

белом режиме, без отображения сетки. 

Диспетчер отчётов и печать сводной таблицы. 

Таблицу можно вывести на печать в виде отчёта, при составлении которого 

использовалось несколько сценариев. Сценарием называется именованный набор 

входных значений, который подставляется в электронную таблицу. В виде сценария в 

листе рабочей книги сохраняются различные группы значений. Листы, представления и 

сценарии объединяются в сводные отчёты. Сформированный таким образом отчёт 

сохраняется вместе с книгой, поэтому его можно распечатать и позднее. Команды для 

просмотра сценариев и отчётов находятся в меню Вид, хотя в используемой версии 

программы их может не быть. Представлением называется именованный набор 

параметров отображения и печати, который можно применить к книге. Для создания и 

сохранения представления используется команда Вид/Представления. В книге можно 

создать несколько представлений. В представлении сохраняются области печати, 

установленные ранее для листов книги. Если лист не содержит эти области, он будет 

напечатан целиком. Для печати отчёта сводной таблицы нужно выделить диапазон 

ячеек, содержащих нужный отчёт. В окне Параметры станицы установить параметры 

страницы: поля, заголовки, колонтитулы. Чтобы заголовки отчёта повторялись на каждой 

странице, нужно указать сквозные строки и столбцы на вкладке Лист окна Параметры 

страницы. При необходимости установить на рабочем листе принудительные разрывы 

страниц. Посмотреть страницу, внести изменения, если нужно, повторно задать разметку 

и отправить на печать. 

ПОРЯДОК ВЫПОЛНЕНИЯ РАБОТЫ 

1. Откройте файл Зарплата из предыдущей работы.     

2. Задайте поля документа по 3 см, альбомную ориентацию листа. 

3. Создайте нижний колонтитул, добавьте в него текущее значение даты и времени, 

выровненные по левому краю, и название рабочего листа, выровненное по правому 

краю. Сохраните изменения. 

4. Создайте верхний колонтитул, добавьте в него своё имя и имя файла книги. Сохраните 

изменения. 

5. Вызовите команду Предварительный просмотр и в появившемся окне щёлкните на 

кнопке Поля, чтобы убедиться в корректности выполненных установок. 

6. Изучите способы размещения листа на странице. 

7. Изучите настройку параметров печати. 

8. Посмотрите документ в режиме Предварительного просмотра. Изучите возможности 

панели инструментов в режиме предварительного просмотра. 
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9. Измените поля документа в режиме Предварительного просмотра. 

10. В нижний колонтитул добавьте рисунок и сохраните изменения. 

11. Изучите опции диалогового окна Печать: печать в черновом режиме, печать в чёрно-

белом режиме, печать без линий сетки. 

Требования к отчёту: 

1.Какой командой быстро переключиться в режим Разметки страницы? Чем отличается 

этот режим от Обычного режима? 

2.Изучите кнопки для создания колонтитулов диалогового окна Нижний колонтитул или 

Верхний колонтитул. Зарисуйте и запишите описание этих кнопок. 

3.Запишите, как вставить разрыв в документ. 

4.Изучите кнопки панели инструментов окна Предварительного просмотра, зарисуйте их и 

запишите описание этих кнопок. 

5.Как задать нумерацию страниц для документа? 

6.Что означает опция «Разрешение при печати» и где её задать? 

7.Какой командой задать области печати? 

8.Как уменьшить время печати? Выпишите данные из пункта11. 

Содержание  отчёта: 

номер практического занятия, название практического занятия, цель занятия, развёрнутые 

письменные ответы на вопросы Требования к отчёту. 

Контрольные вопросы. 

1. Для чего предназначены вкладки диалогового окна Параметры страницы? 

2. Как выбрать сквозные строки и столбцы, которые на каждой странице будут печататься 

в качестве заголовков? 

3. Как вывести на печать диапазон ячеек? 

4. Для чего применяются колонтитулы? 

5. Что такое коды полей? 

6. Как распечатать лист в программе Excel в уменьшенном или увеличенном виде? 

7. Как добавить разрывы страницы вручную? 

8. Какие возможности доступны в окне предварительного просмотра? 

9. Какие возможности печати есть на вкладке Лист диалогового окна Параметры 

страницы? 

Для чего используется функция Диспетчер отчётов? 

 

 

 

ПРАКТИЧЕСКАЯ РАБОТА № 42 

 

Тема: Зачетное занятие по теме: «Электронные таблицы MS Excel» 
 

 

Варианты  заданий 

  Задание  1 

   В MS Excel  создайте таблицу следующего вида: 

№ Фамилия Стаж Оклад  Премия  НДФЛ Сумма к выдаче 

1    ? ? ? 

2    ? ? ? 
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…    ? ? ? 

15    ? ? ? 

 Итого:   ? ? ? 

 ведите  в столбцы В, С, D произвольные данные.   Формула  для начисления 

премии: если стаж менее 10 лет, премия составляет 30 % от оклада, в остальных 

случаях – 50 %. Подсчитайте  итоговую сумму. 

  

 Задание  2 

 

Выполнить в  ЭТ MS Excel  расчеты, используя  относительные   и абсолютные  

ссылки.  

 Накладная Курс доллара   

№ Наименование 

товара  

Цена, руб. Количество  Стоимость, руб. Стоимость, $ 

1      

2      

 

Ввести  15 записей. Рассчитать итоговую строку. 

 

 

 

Задание  3 

Используя  MS  Excel,  создайте  на листе  рабочей  книги следующий  документ: 

1. Практическое  задание  

1) Вычислить размер заработка 10 продавцов фирмы. Известны: разряды 

продавцов, сумма продаж для каждого продавца, норма продажи, оклады 

разрядов. 

2) Правила расчета: 

3) Премия: Если объем продаж > норма * 2, то премия = 10% от Продаж + 1000руб. 

4)    иначе, если объем продаж меньше нормы, то премия составляет 10% от Продаж; 

5)    иначе (т.е. если объем продаж > нормы, то) премия составляет 20% от Продаж; 

2. Зарплата = Оклад (зависит от разряда) + Премия (зависит от объема продаж) 

3. Контроль ввода: 

4. Ячейки «Разряд»– {1, 2, 3, 4}, ячейки «Продано» - положительные значения. 

5. Правила оформления: 
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6. Строки продавцов, у которых величина «Продано» больше нормы в 2 раза, должны 

выделяться красным курсивным шрифтом. 

7. А также, если величина «Продано» меньше нормы, то строка продавца должна 

выделяться фоном. 

 

 

Задание  4 
1. Выполнить в  ЭТ MS Excel  расчет материального пособия  работникам.  

Начислите пособие, исходя из условий: если стаж менее 5 лет, размер пособия 

составляет 25 % от оклада, в остальных случаях –5 000 руб.  

Ввести не  менее 15 записей. Рассчитать итоговую строку. 

№ Фамилия Стаж Оклад  Премия  НДФЛ Сумма к 

выдаче 

1    ? ? ? 

2    ? ? ? 

…    ? ? ? 

15    ? ? ? 

 Итого:   ? ? ? 

Задание  5 

 

1. Практическое  задание  

Пользуясь  возможностями Excel создать таблицу для расчета оплаты за 

проживание в гостинице. 

Исходные данные: цены мест в номерах, даты заезда и выезда, дата оплаты. 

Правила расчета: 

Оплата: 

Сумма = цена места * (оплата По – дата заезда) 

Доплата: 

Дней = дата выезда – оплата По 

Сумма = цена места * доплата дней 

Возврат: 

Дней = дата выезда – оплата По 

Сумма = цена места * возврат дней 

 
1) Составить таблицу по образцу для расчета оплаты проживания 8 человек, для 

которых придумать фамилии, номера, цену места, даты.  

2) Заполнить первую строку формулами для расчета согласно заданным правилам.  

3) Проверить правильность расчета для первого человека. 
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4) Размножить формулу по ячейкам остальных машин. 

5) ячеек столбцов «Доплата» произвольным образом. 

6) Оформить рабочий лист согласно образцу, задать пользовательский формат, 

используя возможности форматирования ячеек. 

Задание  6  

Средствами табличного процессора Excel сформировать на листе рабочей книги 

таблицу: 

 

Накладная 

№  

п/п 

 

Наименование 

товара 
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1  Шт.          

2  Шт.          

3  Шт.          

4  Шт.          

5  Шт.          

 Итого:          

 

 Установить финансовый формат числа в столбце, где указана закупочная цена. 

 С помощью кнопки Формат по образцу применить данный  формат к  тем 

столбцам, где указаны денежные суммы. 

 Произвести все необходимые расчеты. 

 Скопировать таблицу на следующий лист и изменить некоторые данные. 

 Защитить  2 лист  книги, оставив незащищенными ячейки с закупочной  ценой. 

Внести 3 изменения в  данные 2  листа. 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА № 43 

Тема: «СУБД Access: интерфейс, основные приемы  работы. Изучение  структуры 

рабочего окна, использование справочника. Создание файла базы данных и таблиц. 

Работа с данными таблицы: поиск, замена и фильтрация данных таблицы.» 

 

Цель: Ознакомиться с созданием таблиц, типами полей, правилами их задания; 

сформировать навыки, создание базы данных и таблиц, работы с таблицей в режимах 

Таблицы и Конструктора  

Теоретический материал 

База данных (БД) - упорядоченная совокупность данных, предназначенных для 

хранения, накопления и обработки с помощью ЭВМ. Дня создания и ведения баз данных 

(их обновления, обеспечения доступа по запросам и выдачи данных по ним 

пользователю) используется набор языковых и программных средств, называемых 

системой управления базами данных (СУБД)'. 

Объекты базы данных Access 

К объектам базы данных Access относятся: 
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1. Таблицы- предназначены для упорядоченного хранения данных. 

2.Запросы- предназначены для поиска, извлечения данных и выполнения 

вычислений. 

3. Формы- предназначены для удобного просмотра, изменения и добавления данных 

в таблицах. 

А.Отчеты - используются для анализа и печати данных. 

5. Страницы доступа к данным – предназначены для просмотра, ввода, обновления и 

анализа данных через сеть или из любого места компьютера. 

6. Макросы- используются для выполнения часто встречающегося набора 

макрокоманд, осуществляющих обработку данных. 

7 .Модули – предназначены для описания инструкций и процедур на языке V ВА. 

Основным объектом базы данных является таблица, которая состоит из записей 

(строк) и полей (столбцов). На пересечении записи и поля образуется ячейка, в которой 

содержатся данные. 

Каждому полю таблицы присваивается уникальное имя, которое может содержать 

более 64 символов. В каждом поле содержатся данные одного типа. 

 

Тип Описание 

Текстовый Используется для хранения символьных или числовых данных, не 

требующих вычислений. В свойстве Размер поля задается мак-

симальное количество символов, которые могут быть введены в 

данное поле. По умолчанию размер устанавливается в 50 знаков. 

Максимальное количество символов, которые могут содержаться в 

текстовом поле, - 255 

Поле MEMO Предназначено для ввода текстовой информации, по объему пре-

вышающей 255 символов; может содержать до 65 536 символов 

Числовой Предназначен для хранения числовых данных, используемых в 

математических расчетах. На вкладках Общие и Подстановка 

можно установить свойства числового поля, среди которых Размер 

поля, Формат поля, Число десятичных знаков 
Дата/Время Используется для представления даты и времени. Выбор кон-

кретного формата даты или времени устанавливается в свойстве 

Формат даты 

Денежный Предназначен для хранения данных, точность представления ко-

торых колеблется от 1 до 4 знаков после запятой. Целая часть мо-

жет содержать до 15 десятичных знаков 

Счетчик Предназначен для автоматической вставки уникальных последо-

вательных (увеличивающихся на 1) или случайных чисел в каче-

стве номера новой записи. Номер, присвоенный записи, не может 

быть удален или изменен. Поля с этим типом данных использу-

ются в качестве ключевых полей таблицы 

Логический Предназначен для хранения одного из двух значений, интерпре-

тируемых как «Да /Нет», «Истина /Ложь», «Вкл. /Выкл.» 
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Поле объекта 

OLE 

Содержит данные, созданные в других программах, которые ис-

пользуют протокол OLE. Это могут быть, например, документы 

Wond, электронные таблицы Excel, рисунки, звуковые и видеоза-

писи и др. Объекты OLE связываются с базой данных Access или 

внедряются в нее. Сортировать, группировать и индексировать поля 

объектов OLE нельзя 

Гиперссылка Специальный тип, предназначенный для хранения гиперссылок 

Мастер 

подстановок 

Предназначен для автоматического определения поля. С его по-

мощью будет создано поле со списком, из которого можно выби-

рать данные, содержащиеся в другой таблице или в наборе по-

стоянных значений 

 

 

Задания 

1 .Запустите MicrosoftAccess2007. 

2. Нажмите на кнопку    

3. Задайте имя новой базы данных - «Записная книжкаAccess». 

4.На вкладке ленты Создание в панели инструментов Таблицы нажмите на кнопку 

Конструктор таблиц. 

5. Введите имена полей и укажите типы данных, к которым они относятся. 

Имя поля Тип данных 

№  Счетчик 

Фамилия Текстовый 

Имя Текстовый 
Адрес Текстовый 
Индекс Числовой 
Телефон Текстовый 
Хобби Текстовый 
Эл. почта Гиперссылка 

6. Выйдите из режима Конструктора, предварительно сохранив таблицу под именем 

«Друзья»; ключевые поля не задавайте. 

7.Откройте таблицу «Друзья» двойным щелчком мыши и заполните в ней 10 строк. 

8. Добавьте поля «Отчество »и «Дата рождения», для этого: 

1)установите курсор на поле,  перед которым нужно вставить новый столбец; 

2) выполните команду: вкладка ленты Режим таблицы — панель инструментов Поля и 

столбцы — Вставить; 

3) щелкну в два раза на поле1, переименуйте его в «Отчество», а Поле2 -  в «Дата 

рождения». 

9.Перейдите в режим Конструктора командой: вкладка ленты Главная — Режимы — 

Конструктор. 

10. Для поля «Дата рождения» установите тип данных Дата /время; в свойствах 

поля выберите Краткий формат даты. 

11 .Отформатируйте таблицу следующим образом: 

а) цвет сетки - темно-красный; 

б) цвет фона - голубой; 

в) цвет текста - темно-красный, размер - 12 пт, начертание- курсив. 

г) Переименуйте поле «Хобби» в «Увлечения». 

д) Удалите запись под номером 8. 

14. Измените размер ячеек так, чтобы были видны все данные. Для этого достаточно 
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два раза щелкнуть левой кнопкой мыши на границе пол ей. 

15. Расположите поля в следующем порядке: «№», «Фамилия», «Имя», «Отчество», 

«Телефон», «Дата рождения», «Увлечения», «Адрес», «Индекс», «Фото», «Эл_почта». 

16.Заполните пустые ячейки таблицы. 

17.В режиме Конструктора добавьте поле «Семейное положение», в котором будет 

содержаться фиксированный набор значений - замужем, не замужем, женат, не женат. Для 

создания раскрывающегося списка будем использовать Мастер подстановок 

а) установите тип данных Мастер подстановок 

б) в появившемся диалоговом окне выберите строку «Будет введен 

фиксированный набор значений»» нажмите кнопку Далее; 

в) число столбцов- 1; 

г) введите данные списка - замужем, незамужнем, женат, неженат; 

д) нажмите кнопку Готово. 

18. С помощью раскрывающегося списка заполните новый столбец. Поскольку 

таблица получилась широкая, то при заполнении данного столбца возникают некоторые 

неудобства: не видно фамилии человека, для которого заполняется поле «Семейное 

положение». Чтобы фамилия был а постоянно видна при заполнении таблицы, необходимо 

воспользоваться командой Закрепить столбцы из контекстного меню поля «Фамилия». 

19.Покажитеработу преподавателю. 

 

Контрольные вопросы 

1. Что называется базой данных (БД)? 

2. Что такое система у правления базами данных (СУБД)? 

3. Чем отличается Microsoft Excel от Microsoft Access? 

4.Какиеобъектыбазыданных Micro soft Access вы знаете?  

5.Какой объект в базе данных является основным? 

6. Что называется полями и записями в БД? 

7.Какие типы данных вызнаете? 

8. Как можно переименовать поле? 

9.Как можно создать поле с раскрывающимся списком? 

10.С каким расширением сохраняется файл MS Access? 

11. Чем отличаются режимы Конструктора и Таблицы? 

12. Для чего используется тип Мастер подстановок? 

Выполнить отчет по практической работе. 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА № 44-45 

Тема: «Создание схем данных.  Установление связей между таблицами. Типы 
связей» 

 

Цель работы: научиться создавать связи между таблицами, закрепить умение 

создания  объектов в  СУБД,  основные знания  о структуре БД, таблиц, режимах работы.  

 

Краткие  теоретические  сведения  

Установление связей между таблицами. 
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1. Щелкнуть кнопку «Схема данных» в пункте «Режим таблицы» или в пункте «Работа 

с БД». 

2. Выбрать обе таблицы и щелкнуть кнопку «Добавить». 

3. Переместить клавишу мыши ключевое поле таблицы «Персонал» на одноименное 

поле второй таблицы. 

4. В диалоговом окне включить все режимы и сохранить установленную связь, 

щелкнув по кнопке «Создать». 

Чтобы таблицы связывались без проблем, необходимо перед выполнением этой 

операции в рабочей области окна закрыть все таблицы.              

  5. Внести изменения в таблицу «Персонал» и убедиться, что эти изменения 

выполнились и в другой таблице. 

 

Сортировка записей таблицы по значению какого – либо поля. 

 

1. Пометить то поле, по которому ведется сортировка (поле 2 «Фамилия» в таблице 

«Персонал»), щелкнуть л.к.м. (жирной стрелкой) по имени поля в таблице. 

2. Щелкнуть кнопку сортировки по возрастанию или убыванию на ленте. 

3. Сохранить изменения, щелкнув кнопку «Сохранить» в строке заголовка. 

4. Форматирование структуры таблицы и самой таблицы. 

1. Изменение структуры таблицы:  

а) добавления нового поля (пометить поле, выше которого вставляется новое, 

«Конструктор» - «Вставить строку»). 

б) удаление поля (Конструктор – удалить строку). 

в) перемещение поля. 

г) переименование поля. 

2. Редактирование и форматирование данных в режиме «Таблица»: 

а) изменение ширины столбца (в строке заголовка выбрать         ) 

б) задание минимальной ширины столбца (двойной щелчок л.к.м. на правой границе 

поля в строке заголовка). 

в) перемещение столбца. 

г)  переименование поля (двойной щелчок л.к.м. по имени). 

д) добавление поля (Режим таблицы --- Вставить). 

е) удаление поля (Режим таблицы - Удалить) отменить удаление нельзя. 

 

 

Фильтрация. 

Поставить курсор в тот столбец, по которому ведется фильтрация. Главная – 

Фильтр – пометить галочкой те значения, по которым ведется фильтр и ОК. 

Для отмены фильтра:  Главная – Применить фильтр. 

Главная – Фильтр – Числовые фильтры – позволяет задать сложную фильтрацию. 

Далее необходимо выбрать операнды для фильтрации, в диалоговом окне 

сформировать условие фильтра. 

 

Создание списков для ввода данных 

    

Если в какое – либо поле надо вводить повторяющиеся данные, то эти данные можно 

предварительно оформить в виде списка и настроить таблицу таким образом, чтобы в 

процессе заполнения полей таблицы можно было выбирать значения из этого списка. 

Например, если требуется вводить значение месяца, то в режиме конструктора при выборе 

типа поля «Месяц» выбрать тип «Мастер подстановок». В диалоговом окне задать «будет 

введен фиксированный набор значений» и «Далее», вести значение списка (название 

месяцев), переходя по столбцу вниз с помощью клавиши со стрелкой и «Далее», вести имя 

столбца подстановки «Месяц» и «Готово». 
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Открыть таблицу для заполнения, когда курсор окажется в поле «Месяц», то в нем 

появится указатель списка, щелкнуть по этому указателю, выбрать нужное значение из 

развернувшегося списка и нажать Enter. 

1. Сформировать таблицу «Отпуск», используя список месяцев года для заполнения 

значений поля таблицы с именем «Месяц». 

                Таблица «Отпуск». 

Имя поля  Тип поля  

Табельный номер Числовое 

Фамилия Текстовое 

Имя Текстовое 

Месяц Текстовое , размер – 15 

Продолжительность 

отпуска  

Числовое, целое 

При заполнении таблицы значения полей: табельный номер, фамилия, имя, 

отчество скопировать из таблицы «Персонал» (Пометить копируемые поля в месте с 

именами, Главная --- Копировать, пометить поля, в которые копируются данные тоже 

вместе с именами, Главная – Вставить). 

2. Связать эту таблицу с ранее созданными таблицами по полю «Табельный номер»: 

а)  щелкнуть кнопку «Схема данных» или выполнить команду «Сервис» --- «Схема 

данных»; 

б) в диалоговом окне щелкнуть правой клавишей мыши на свободном месте; 

в) выбрать команду «Добавить таблицу»; 

г) из списка выбрать таблицу «Отпуск» и щёлкнуть «Добавить»; 

д) связать эту таблицу таблицей «Персонал» по полю «Табельный номер». 

 

Практические  задания 

1. Загрузить Ассеss. 

2. Щелкнуть «Новая база данных». 

3.  Указать имя файла БД и «Создать». 

4. Выбираем режим «Конструктор», указываем имя таблицы. 

5. Указать имена таблицы, тип данных, выбрать ключевое поле. 

                         Таблица «Персонал» 

Имя поля Тип поля 

Табельный номер Ключевое, числовое, размер – целое, число десятичных 

знаков – 0, условие назначение - >0 and < 100, обязательное 

– да, индексированное – да (совпадения не допускаются). 

Фамилия Текстовое, размер – 25, обязательное – да. 

Имя Текстовое, размер – 20, обязательное – да. 

Отчество Текстовое, размер – 25, обязательное – да. 

Год рождения Дата/ время, формат – краткий формат даты, обязательное – 

да. 

Адрес Текстовое, размер – 50, обязательное – да. 

   

                           Таблица «Штатное расписание»  

Имя поля Тип поля 

Табельный номер Ключевое, числовое, размер – целое, число десятичных знаков 

– 0, условие назначение - >0 and < 100, обязательное – да, 

индексированное – да (совпадения не допускаются). 

Должность Текстовое, размер – 30, обязательное – да. 

Стаж Числовое, размер – целое, обязательное – да. 
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Оклад Числовое, размер – длинное целое, число десятичных знаков – 

2, обязательное – да. 

 

 6. Перейти в режим «Таблица». 

 7. Внести в каждую таблицу по 15 записей. Установление связей между 

таблицами. 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА № 46 

Тема: «Создание  запросов. Создание запросов на выборку  данных» 
 

Цели работы: 

- закрепить  знания  о назначении СУБД, основных объектах, их структуре; 

- сформировать практические  навыки работы  с таблицами в  режиме Конструктора  и 

Таблицы, создания  форм и запросов, вводить информацию  в  различных режимах; 

- выполнять сортировку  и фильтрацию данных, задавать условия фильтра. 

 

Краткие  теоретические  сведения 

Системы управления базами данных (СУБД) – это специальная программа, 

необходимая для организации базы данных (хранилища информации) и работы с ней 

пользователей информационной системы. Основной  объект – таблица.  

 

 Выполнение  задания  в  MS Access 

Используя СУБД ACCESS, решить следующую задачу: 

На основании сведений о студентах Вашей группы, хранящихся в таблице СТУДЕНТЫ 

(структура данных дана ниже), необходимо создать: 

1. Форму для ввода приказа о зачислении в колледж 

2. Список студентов, проживающих в г. Курске 

3. Список студентов по датам рождения 

 

Структура данных таблицы СТУДЕНТЫ 

Название поля Тип поля 

ФИО студента Текстовый 

Номер зачетки Числовой 

Где живет Текстовый 

Номер приказа о зачислении Числовой 

Дата приказа Дата 

Дата рождения Дата 
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Ход  работы 

1. Создаем  базу  данных MS Access. 

2. Создаем таблицу  (Создание – таблица). Затем  на вкладке Главная выбираем режим  

Конструктор, вводим  имена  полей, типы  данных, задаем их свойства (см. рис.1). 

3. Для заполнения  таблицы  выбираем Режим таблицы, вводим произвольные значения 

(рис.2). 

4. Выбираем Создание – Форма, на основании открытой  таблицы появляется форма 

(рис.3). 

5. Заполнять таблицу  мы  можем как  в режиме  таблицы, так  и в  режиме  формы.  

  

Рис.1. Таблица  в  режиме  Конструктора  

 

Рис.2. Таблица  в  заполненном виде (режим таблицы). 
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 Рис.3 .Форма для ввода  приказа  

6. Внесем несколько данных  в  режиме  формы (рис.4), и убедимся, что они появятся  и  в  

созданной  вначале  таблице  (рис.5). Для  этого закроем формы, сохранив  изменения, и 

откроем  таблицу Данные  о студентах.  

 

 Рис. 4. Заполнение  таблицы  в  режиме  формы. 

 

 Рис.5.Изменения отображены и  в  таблице, на  основе  которой создана форма. 

Вводить сведения  в  режиме формы  гораздо  удобнее, т.к. легче  ориентироваться и 

исключается возможность ошибки  при вводе  информации по конкретному  студенту. 
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7. Выполним запросы. Легче  это сделать  в  режиме  Конструктора  запросов. 

Создание – Конструктор запросов. 

  

 Рис. 7. Конструктор запросов 

8. В диалоговом окне Добавление  таблицы  выбираем нужную таблицы  и 

закрываем окно (кнопка  Закрыть). 

  

Рис. 8 Диалоговое окно. 

9. Щелчком л.к.м. выбираем нужные поля (рис.9). 

 

Рис. 9. Формирование  запроса  на выборку. 

Список  студентов  по датам рождения – простой  запрос  на  выборку. Нажимаем 

кнопку  Выполнить  и получаем нужную информацию. Сохраняем запрос под именем 
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Даты  рождения  студентов.  

Рис.10. Сохранение  запроса. 

10.  Список студентов, проживающих  в  г. Курске можно выполнить несколькими 

способами. Например, отфильтровать данные исходной  таблицы. 

  

Рис. 11 Задание условий  фильтра 

 

Рис.12  Результаты  фильтрации. 

Контрольные вопросы 

1. Что называется базой данных (БД)? 

2. Что такое система у правления базами данных (СУБД)? 

3. Чем отличается Microsoft Excel от Microsoft Access? 

4.Какиеобъектыбазыданных Micro soft Access вы знаете?  

5.Какой объект в базе данных является основным? 

6. Что называется полями и записями в БД? 

7.Какие типы данных вызнаете? 

8. Как можно переименовать поле? 

9.Как можно создать поле с раскрывающимся списком? 

10.С каким расширением сохраняется файл MS Access? 

11. Чем отличаются режимы Конструктора и Таблицы? 

12. Для чего используется тип Мастер подстановок? 
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Выполнить отчет по практической работе. 

 

 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА № 47 

Тема: «Создание  запросов с параметром» 
Цели работы: 

- закрепить  знания  о назначении СУБД, основных объектах, их структуре; 

- сформировать практические  навыки работы  с таблицами в  режиме Конструктора  и 

Таблицы, создания  форм и запросов, вводить информацию  в  различных режимах; 

- выполнять сортировку  и фильтрацию данных, задавать условия фильтра. 

 

Краткие  теоретические  сведения 

 

Можно также выполнить запрос  с  параметром.  В строке  условие  отбора ввести 

конкретное  значение – Курск, или же в  квадратных скобках ввести поясняющее 

выражение. В  этом  случае можно  при выполнении запроса  (открытии таблицы) задавать 

любое нужное нам значение. 

                  

Рис.13. Запрос с  параметром:  а) конкретное условие отбора;  б) выбор варианта  

отбора. 

Нажав Выполнить, получим искомую информацию. 
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Рис.14. Запрос выполнен – Список  студентов, проживающих  в г. Курске.  

Контрольные вопросы 

1. Что называется базой данных (БД)? 

2. Что такое система у правления базами данных (СУБД)? 

3. Чем отличается Microsoft Excel от Microsoft Access? 

4.Какиеобъектыбазыданных Micro soft Access вы знаете?  

5.Какой объект в базе данных является основным? 

6. Что называется полями и записями в БД? 

7.Какие типы данных вызнаете? 

8. Как можно переименовать поле? 

9.Как можно создать поле с раскрывающимся списком? 

10.С каким расширением сохраняется файл MS Access? 

11. Чем отличаются режимы Конструктора и Таблицы? 

12. Для чего используется тип Мастер подстановок? 

Выполнить отчет по практической работе. 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА № 48 

Тема: «Вычисление в запросах. Создание итогового запроса» 
 

Цели работы: 

- закрепить  знания  о назначении СУБД, основных объектах, их структуре; 

- сформировать практические  навыки работы  с таблицами в  режиме Конструктора  и 

Таблицы, создания  форм и запросов, вводить информацию  в  различных режимах; 

- выполнять сортировку  и фильтрацию данных, задавать условия фильтра. 

 

Краткие  теоретические  сведения  

 

С помощью Access могут быть созданы различные виды запросов: 

Запрос на выборку выбирает данные из разных таблиц и других готовых запросов. 

Таблицы должны быть связаны. На основе запроса на выборку строятся другие виды 

запросов; 

Запрос-изменение изменяет или перемещает данные. К этому типу относятся запрос на 

добавление, запрос на удаление, запрос на обновление; 

Запрос на создание таблицы сохраняет результаты выборки в отдельной таблице; 

Перекрестные запросы предназначены для группирования данных и представление их в 

компактном виде. 

Запрос можно создать самостоятельно или воспользоваться Мастером запросов. 

Ход работы 

Задание 1. Открытие учебной базы данных, изготовленной на прошлом занятии. 

В базе данных должны быть три таблицы: Список учеников, Личные данные, Группы. В 

случае их отсутствия импортируйте эти таблицы из чужой базы данных (например, из 

эталонной базы данных учителя). 

Задание 2. Создание запроса на выборку с именем Номера телефонов. 
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Предположим, что вы хотите создать телефонную книгу учеников, используя 

конкретную базу данных. 

Выберите вкладку Запросы, находитесь в другом диалоговом окне. Щелкните  по 

кнопке Создать. 

В появившемся диалоговом окне выберите пункт Создание запроса в режиме 

конструктора, щелкните по кнопке Открыть. 

Добавьте нужные таблицы (Личные данные и Список учеников), выбирая их и щелкая 

по кнопке Добавить. Так как таблицы связанны, то между ними появится линия “один к 

одному”, что представлено на рис. 1. 

Закончите выбор, щелкнув по Закрыть. Появится возможность выбора полей из 

разных таблиц. Выберите поля “Фамилия”,“Имя”, “Отчество” из таблицы “Список 

учеников” и “ Номер телефона ” из таблицы “Личные данные”(рис 2). Для этого 

достаточно дважды щелкать по именам полей. Второй вариант- перетаскивать мышью 

названия в клетки запроса. 

 

 
5. Сохраните запрос, щелкнув по кнопке Сохранить. Введите имя запроса – 

“Номера телефонов”- и щелкните по кнопке ОК 

6. Щелкните по кнопке ! для представления запроса .Это самый простой вид 

запроса на выборку. В результате вы получаете новую таблицу с другим набором полей. 

Замечание. Условие отбора можно включать аналогично включению фильтра 

.Например, телефонная книга для всех учащихся , фамилии которых начинаются на букву 

В, может быть получена с помощью включения условия LIKE “В*” 

7. Получите этот запрос (он представлен на рис 3.). 
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8. Щелкните по кнопке ! для представления запроса. 

9. Измените имя запроса. Для этого выберите в меню пункт Файл, Сохранить как и 

в появившемся диалоговом окне наберите новое имя запроса “Выборка по В”. Теперь в 

меню базы данных в окне Запросы будет показано два запроса. 

Самостоятельное задание. 

А) Составьте запрос на выборку адресов только девочек, имя которых –Анна. 

Сохраните запрос под именем “Анна” 

Б) Составьте запрос на выборку номеров телефонов учащихся, отчество которых 

начинается на букву А. Сохраните запрос под именем “Выборка по А”. 

Справочная информация 
Элементы выражения, представляющего собой условие отбора, могут быть связаны 

операторам: 

1 арифметическими: ,+,-,/ , 

2 сравнения: <, <=, >, >=, “” 

3 логическими: and (N), not ( НЕ) or (ИЛИ); 

Like – для определение записей, фрагмент текста в которых совпадает с заданным 

текстом; 

In – для определения, содержится ли элемент данных в списке значений; 

Between … And – для выбора значений из определенного интервала. 

Между условиями в разных ячейках одного столбца выполняется логическая 

операция Or. 

Логическая операция Or истина, когда истинно хотя бы одно из входящих в список 

условий. 

Между условиями в разных ячейках одной строки выполняется логическая 

операция And. 

Логическая операция And истинна тогда и только тогда, когда истинны все 

входящие в список условия. 

Задание 3. Создание запроса с использованием логических операций в условии 

отбора. 

Предположим, что вам нужно составить ведомость для выплаты стипендии всем 

ученикам, которые учатся без троек. Для этого нужно выбрать записи, в которых оценки 

по предметам – “4” или “5”. 

Выберите вкладку Запросы, если находитесь в другом диалоговом окне. 

Щелкните по кнопке Создать. 

В появившемся диалоговом окне выберите пункт Конструктор и щелкните по 

кнопке ОК. 

Добавьте нужные таблицы (“Личные данные” и “Список учеников”), выбирая их и 

щелкая по кнопке Добавить. Так как таблицы связаны, между ними на экране появляется 
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линия “один–ко-одному”. Если ее нет, таблицы нужно связать. 

Закончите выбор, щелкнув по кнопке Закрыть. Появится возможность выбора 

полей из разных таблиц. Выберите поля “Фамилия”, “Имя”, “Отчество” из таблицы 

“Список учеников” и поля “Word”, “Excel”, “Access” из таблицы “Личные данные”. Для 

этого достаточно дважды щелкать по именам полей. Второй вариант – перетаскивать 

мышью названия полей в клетки запроса. 

В строке Условия отбора под полями “Word”, “Excel”, “Access” введите условие 4 

Or 5. 

Задание 4. Создание запроса на выборку с использованием Построителя 

выражений. 

Выберите вкладку Запросы, если находитесь в другом окне. 

Выделите запрос “Номера телефонов”. 

Щелкните по кнопке Конструктор. 

Смените поле “Номера телефонов” на поле “Адрес”. 

Сохраните запрос под именем “Адрес”. 

Установите курсор в строку Условие отбора под столбцом “Фамилия”. 

Щелкните по кнопке  Построить . Появится окно, в котором можно строить 

сложные запросы. 

Щелкните по кнопке Not, это слово появится в верхнем окне. Фамилию Баранова в 

кавычках введите вручную. 

Щелкните по кнопке ОК. В строке Условие отбора появится данное выражение. 

Щелкните по кнопке  для представления запроса. 

Закройте запрос, сохранив его под именем “Не_Баранова”. 

Задание 5. Создание вычисляемых полей. 

Выберите вкладку Запросы, если находитесь в другом диалоговом окне. Щелкните 

по кнопке Создать. 

В появившемся диалоговом окне выберите пункт Конструктор, щелкните по кнопке 

ОК. 

Добавьте нужные таблицы (“Личные данные” и “Список учеников”), выбирая их 

щелкая по кнопке Добавить. 

Завершите выбор, щелкнув по кнопке Закрыть. 

Выберите поля “Фамилия” и “Имя” из таблицы “Список учеников” и поля “Word” и 

“Excel” из таблицы “Личные данные”. 

Установите курсор в ячейку правее Excel (в строке Поле). 

Щелкните по кнопке  Построить . 

В появившемся окне введите вручную выражение, представленное на рис.5, и 

щелкните по кнопке ОК. 

 
Рис. 5. 

Это выражение подставится в новом поле. Нажмите клавишу Enter. 

 Сохраните запрос под именем “Среднее”. 

Щелкните по кнопке  для представления запроса. Новое поле будет иметь имя 

“Среднее”. 

Закройте запрос. 

Предъявите преподавателю на экране запросы “Номера телефонов”, “Выборка по 
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В”, “Анна”, “Выборка поА”, “Успеваемость1”, “Успеваемость2”, “Успеваемость3”, 

“Не_Баранова”, “Среднее”. 

Задание 6. Завершение работы с программой Access. 

Выполните команду Файл, Выход. 

Если вы производили редактирование в базе данных, появится вопрос о сохранении 

изменений. Ответьте не него положительно. 

 

Дополнительное задание  

 

Создание запроса с вычисляемым полем 

Запрос «Материальное пособие» 

Задание: Работникам с окладом <5000 начислить материальное пособие, равное 

35% от оклада. 

Создание---Конструктор запросов--- Ок ---Добавить таблицу «Персонал»  и 

«Штатное расписание»---Закрыть---Выбрать поля: табельный номер, фамилия, имя, 

отчество, оклад- Создаём вычисляемое поле: в строке поле вводим: материальное 

пособие: {оклад}*0,35--- в строке условие отбора в поле «Оклад» вводим <5000- 

Выполнить (!). 

Самостоятельно: 

 

В таблицу «Отпуск» добавить поле «Зарплата на 12 месяцев», ввести значение 

этого поля в записи. Начислить отпускные работникам в запросе: «Отпускные», 

используя поля таблицы «Отпуск». Вычисляемое поле: сумма отпускных: 

{Зарплата за 12 месяцев}*{продолжительность отпуска}/12/29,4. 

Для ввода данных этого поля с двумя знаками после запятой надо пометить это 

поле в режиме конструктора и по команде Вид – Свойства диалоговом окне 

выбрать формат вывода - фиксированный. 

 

 

Контрольные вопросы 

1. Что называется базой данных (БД)? 

2. Что такое система у правления базами данных (СУБД)? 

3. Чем отличается Microsoft Excel от Microsoft Access? 

4.Какиеобъектыбазыданных Microsoft Access вы знаете?  

5.Какой объект в базе данных является основным? 

6. Что называется полями и записями в БД? 

7.Какие типы данных вызнаете? 

8. Как можно переименовать поле? 

9.Как можно создать поле с раскрывающимся списком? 

10.С каким расширением сохраняется файл MS Access? 

11. Чем отличаются режимы Конструктора и Таблицы? 

12. Какие  типы запросов вы знаете? 

Выполнить отчет по практической работе. 

 

ПРАКТИЧЕСКАЯ  РАБОТА № 49 

Тема: «Разработка отчетов. Просмотр отчета. Вывод отчета на печать» 
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Краткие  теоретические  сведения  

Отчет (отчет) — это объект базы данных, который используется для вывода на экран, в 

печать или файл структурированной информации. Отчетs позволяют извлечь из таблиц 

или запросов базы данных необходимую информацию и представить ее в виде удобном 

для восприятия. Отчет содержит заголовок, область данных, верхний и нижний 

колонтитулы, примечание и разбит на страницы. 

В Microsoft Access 2007 для создания отчетов можно использовать различные средства 

(рис. 1): 

 Мастер отчетов 

 Конструктор отчетов 

 Инструмент Отчет 

 Пустой отчет 

 
Рис. 1. 

Отчеты целесообразно выполнять с помощью Мастера или других указанных 

инструментов, а дорабатывать их, т.е. вносить необходимые изменения можно в режиме 

макета или конструктора. В Microsoft Access 2007 предусмотрено два режима внесения 

изменений и дополнений в отчетs: режим макета и режим конструктора. 

Режим макета — это более наглядный режим редактирования и форматирования 

(изменения) отчетов, чем режим конструктора. В тех случаях, когда в режиме макета 

невозможно выполнить изменения в отчете, то целесообразно применять режим 

конструктора. 

Мастер отчетов. Для создания отчета при помощи Мастера отчетов необходимо 

выполнить следующие действия: 

 В окне базы данных Access щелкнуть на вкладке Создание и затем щелкнуть на кнопке 

Мастер отчетов в группе Отчеты. Появится диалоговое окно Создание отчетов. 

 В поле Таблицы и отчеты щелкнуть на стрелке и выбрать в качестве источника данных 

таблицу Студенты. 

 Щелкнуть на кнопке ОК (в результате получим вид окна "Создание отчетов", 

представленный на рис. 2). 

 Все "Доступные поля" переведем в "Выбранные поля", выделив их и щелкнув на кнопку 

>>. 

 На следующем шаге (Добавить уровни группировки?) щелкаем далее. 

 На шаге "Выберите порядок сортировки записей". В раскрывающемся списке выберем 

"Фамилия" для сортировки по возрастанию. 

 На шаге "Выберите вид макета для отчета". Выбираем: Макет - блок, ориентация - 

книжная. Щелкнуть на кнопке Далее. 

 На шаге " Выберите требуемый стиль". Выбираем - Изящная. 

 Следующий шаг - "Задайте имя отчета". Вводим имя - Студенты мастер_отчетов. 

Дальнейшие действия: Просмотреть отчет; Изменить макет отчета. Выбираем 

Просмотреть, щелкаем на кнопке Готово. Отчет открывается в режиме Предварительного 

просмотра, который позволяет увидеть, как будет выглядеть отчет в распечатанном виде 

(Рис. 3). 

 Перейдите в режим Конструктора и выполните редактирование и форматирование отчета. 

Для перехода из режима предварительного просмотра в режим конструктора необходимо в 

области переходов щелкнуть правой кнопкой мыши на имени отчета и в контекстном 
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меню выбрать режим конструктора. На экране появится отчет в режиме Конструктора 

(Рис. 4). 

 
Рис. 2. 

 

 
Рис. 3. 

 

 
Рис. 4. 

Редактирование: 

 удалите поля КодСтудента в верхнем колонтитуле и области данных; 

 удалите поля КодГруппы в верхнем колонтитуле и области данных; 

 На место поля КодГруппы переместить поле "Название" из списка "Группы студентов"; 

 переместите влево все поля в верхнем колонтитуле и области данных; 

 Измените надпись в заголовке страницы, введите НТУ «ХПИ» и нажмите Enter; 
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 Переместите Надпись. В Нижнем колонтитуле выделить поле =Now() и перетащить его в 

Заголовок под название Студенты. Дата будет отображаться под заголовком. 

Форматирование: 

1. Выделите заголовок Студенты НТУ «ХПИ» 

2. Измените гарнитуру, начертание и цвет шрифта, а также цвет заливки фона. Отчет в 

режиме конструктора примет вид, представленный на рисунке 5. 

 
Рис. 5. 

3. Перейдите в режим предварительного просмотра. Для перехода в режим 

предварительного просмотра необходимо щелкнуть правой кнопкой мыши на названии 

отчета в области переходов и в контекстном меню выбрать режим "Предварительный 

просмотр" (рис 6). 

 
Рис. 6. 

Инструмент Отчет. Для быстрого создания отчета, т.е. создания одним щелчком мыши 

можно воспользоваться инструментом Отчет. В этом случае отчет формируется на базе 

существующей таблицы или запроса. В созданном отчете будут отображаться все записи 

таблицы или запроса, на базе которых создается отчет. Но созданный отчет можно будет 

изменить в режиме макета или конструктора. 

Для создания отчета необходимо выполнить следующее. В области переходов надо 

выделить таблицу (например, Студенты), на основе которой нужно создать отчет. Затем 

перейти на вкладку Создание и щелкнуть на пиктограмме Отчет. На экране будет 

отображен простой Отчет на основе текущей таблицы Студенты. 

Средство Пустой отчет. Инструмент "Пустой отчет" позволяет создавать отчетs с нуля в 

режиме макета. Для этого надо щелкнуть Пустой отчет в группе Отчеты на вкладке 

Создание. В окне редактирования Access 2007 появится Отчет1 с пустой областью данных, 

а в правой части окна будет отображаться область "Список полей" существующих таблиц. 
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Щелкнув на знак "+" таблицы (например, Студенты), откроется список необходимых 

полей. 

Перетащите требуемые поля из этого списка в отчет, нажав и удерживая левую клавишу 

мыши. С помощью инструментов из группы "Элементы управления" на вкладке Формат, 

можно доработать отчет, добавив заголовок, номера страниц, дату и время. При 

необходимости его можно доработать в режиме конструктора. Сохраните отчет. 

 

 

Практические задания  

Расчётная ведомость отпускных 

 

Создание-Мастер отчётов - Выбрать запрос «Отпускные» -- Выбрать поля: фамилия, имя, 

отчество, продолжительность отпуска, сумма отпускных – Далее ---Далее- Задать 

сортировку по полю «Фамилия» от А до Я --- Далее – выбрать макет «табличный» и 

ориентацию «книжная» --- далее – Выбрать стиль «выделенный» --- Далее – Задать имя 

отчёта «Расчётная ведомость отпускных» --- Готово. 

 

Подсчитать итоговую сумму по полю «сумма отпускных» 

Итоговые значения подсчитываются в разделе «Примечание отчёта»: 

1) Щёлкнуть кнопку «Аа» (надпись), в поле фамилия начертить  и написать «Итого»; 

2) Щёлкнуть кнопку «Аб» (поле), в поле «сумма отпускных» начертить , в которой 

формулу: = SUM({сумма отпускных}) и нажать Enter. 

 

Создание отчёта с группировкой записей по какому-либо полю. 

Расчётная ведомость по материальному пособию. 

(Сгруппировать записи отчёта по полю «Должность») 

Команда: Создание --- Мастер отчётов--- выбрать запрос «Материальное пособие»--- 

выбрать поля: фамилия, имя, отчество, должность, материальное пособие --- Далее--- 

добавить уровни группировки по полю «Должность»--- Далее--- при необходимости 

установить сортировку записей по какому-либо полю и щёлкнуть кнопку Итоги--- 

включить режим «Данные и итоги» (если итоги надо подводить и по группам и по всему 

отчёту), иди включить режим «только итоги »(если надо подводить итоги только по всему 

отчёту), установить подсчёт итоговой суммы по полю «Материальное пособие»--- ОК---

Далее---выбрать макет «Ступенчатый», ориентацию «Книжную»---Далее ---выбрать стиль 

«Выделенный»---Далее---указать название отчёта «Ведомость по материальному 

пособию»---Готово. 

 

Самостоятельно: 

На основании запроса «материальное пособие» создать отчёт (без группировки записей) 

«Расчётная ведомость по материальному пособию», подсчитать итоговое значение по 

полю: «Материальное пособие». 

 

Контрольные вопросы 

1. Что называется базой данных (БД)? 

2. Что такое система у правления базами данных (СУБД)? 

3. Чем отличается Microsoft Excel от Microsoft Access? 

4.Какиеобъектыбазыданных Microsoft Access вы знаете?  

5.Какой объект в базе данных является основным? 

6. Что называется полями и записями в БД? 

7.Какие типы данных вызнаете? 

8. Как можно переименовать поле? 
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9.Как можно создать поле с раскрывающимся списком? 

10.С каким расширением сохраняется файл MS Access? 

11. Какие средства для создания отчетов существуют  в Microsoft Access? 

12. Какие  типы запросов вы знаете? 

 

 

ПРАКТИЧЕСКАЯ РАБОТА № 50 

Тема: Зачетное  занятие по теме: «СУБД MS ACCESS» 

Индивидуальные задания  

Выделены и подчеркнуты имена полей, являющихся ключевыми. 

  

№ варианта Задание  

 

 
Имена таблиц Поля таблиц 

1,6,11, 16,21, 

26,31 

Студент, Группа Студент (фамилия, имя, отчество, номер 

группы,   курс, специальность, номер 

зачетной книжки). Группа (номер группы, 

куратор) 

2, 7, 12, 17, 22, 

27,32 

Сотрудник, Отдел Сотрудник (фамилия, имя, отчество, 

должность, зарплата, номер отдела, номер 

пропуска). Отдел  (номер отдела, фамилия 

начальника) 

3,8,13, 18,23, 

28,33 

Врач, Прием Врач (код врача, фамилия, имя, отчество, 

специализация врача, оклад врача, стаж 

врача), Прием (номер кабинета, часы 

приема врача, код врача) 

1
 4, 9, 14, 19,24, 

29, 34 

Поставка, Фирма Поставка (код товара, наименование 

товара, количество товара, дата поставки, 

код фирмы), Фирма (код фирмы-

поставщика, название фирмы-поставщика, 

адрес фирмы-поставщика, телефон фирмы-

поставщика,) 

5, 10, 15, 20, 25, 

30,35 

Преподаватель, Урок Преподаватель (номер паспорта, фамилия, 

имя, отчество, степень, звание), Урок (код 

урока, день недели, время начала урока, 

номер группы, предмет, номер паспорта) 

 

 

 

 

 

Практическая работа № 51-52 
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Тема: Создание базы данных в Excel по клиентам с примерами и шаблонами 

(2практические) 

Многие пользователи активно применяют Excel для генерирования отчетов, их 

последующей редакции. Для удобного просмотра информации и получения полного 

контроля при управлении данными в процессе работы с программой. 

Внешний вид рабочей области программы – таблица. А реляционная база данных 

структурирует информацию в строки и столбцы. Несмотря на то что стандартный пакет 

MS Office имеет отдельное приложение для создания и ведения баз данных – Microsoft 

Access, пользователи активно используют Microsoft Excel для этих же целей. Ведь 

возможности программы позволяют: сортировать; форматировать; фильтровать; 

редактировать; систематизировать и структурировать информацию. 

То есть все то, что необходимо для работы с базами данных. Единственный нюанс: 

программа Excel - это универсальный аналитический инструмент, который больше 

подходит для сложных расчетов, вычислений, сортировки и даже для сохранения 

структурированных данных, но в небольших объемах (не более миллиона записей в одной 

таблице, у версии 2010-го года выпуска). 

Структура базы данных – таблица Excel 

База данных – набор данных, распределенных по строкам и столбцам для удобного 

поиска, систематизации и редактирования. Как сделать базу данных в Excel? 

Вся информация в базе данных содержится в записях и полях. 

Запись – строка в базе данных (БД), включающая информацию об одном объекте. 

Поле – столбец в БД, содержащий однотипные данные обо всех объектах. 

Записи и поля БД соответствуют строкам и столбцам стандартной таблицы Microsoft 

Excel. 

 
 

Если Вы умеете делать простые таблицы, то создать БД не составит труда. 

Создание базы данных в Excel: пошаговая инструкция 

Пошаговое создание базы данных в Excel. Перед нами стоит задача – сформировать 

клиентскую БД. За несколько лет работы у компании появилось несколько десятков 

постоянных клиентов. Необходимо отслеживать сроки договоров, направления 

сотрудничества. Знать контактных лиц, данные для связи и т.п. 
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Как создать базу данных клиентов в Excel: 

 
 

 

Основная работа – внесение информации в БД – выполнена. Чтобы этой информацией 

было удобно пользоваться, необходимо выделить нужное, отфильтровать, отсортировать 

данные. 

Как вести базу клиентов в Excel 

Чтобы упростить поиск данных в базе, упорядочим их. Для этой цели подойдет 

инструмент «Сортировка». 
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 Данные в таблице распределились по сроку заключения договора. 

 
 

Теперь менеджер видит, с кем пора перезаключить договор. А с какими компаниями 

продолжаем сотрудничество. 
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БД в процессе деятельности фирмы разрастается до невероятных размеров. Найти 

нужную информацию становится все сложнее. Чтобы отыскать конкретный текст или 

цифры, можно воспользоваться одним из следующих способов: 

 
 

Посредством фильтрации данных программа прячет всю не интересующую пользователя 

информацию. Данные остаются в таблице, но невидимы. В любой момент их можно 

восстановить. 

В программе Excel чаще всего применяются 2 фильтра: 

 
Автофильтр предлагает пользователю выбрать параметр фильтрации из готового списка. 
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Готово! 

 
 Поэкспериментируем с фильтрацией данных по выделенным ячейкам. 

Допустим, нам нужно оставить в таблице только те компании, которые работают в 

Беларуси. 

 

 

Если в БД содержится финансовая информация, можно найти сумму по разным 

параметрам: 

 сумма (суммировать данные); 

 счет (подсчитать число ячеек с числовыми данными); 

 среднее значение (подсчитать среднее арифметическое); 

 максимальные и минимальные значения в выделенном диапазоне; 

 произведение (результат умножения данных); 
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 стандартное отклонение и дисперсия по выборке. 

Порядок работы с финансовой информацией в БД: 

Инструменты на вкладке «Данные» позволяют сегментировать БД. Сгруппировать 

информацию с точки зрения актуальности для целей фирмы. Выделение групп 

покупателей услуг и товаров поможет маркетинговому продвижению продукта.

 
 

Инструменты на вкладке «Данные» позволяют сегментировать БД. Сгруппировать 

информацию с точки зрения актуальности для целей фирмы. Выделение групп 

покупателей услуг и товаров поможет маркетинговому продвижению продукта. 

Готовые образцы шаблонов для ведения клиентской базы по сегментам. 

 
 Шаблоны можно подстраивать «под себя», сокращать, расширять и 

редактировать. 
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Практическая работа № 53 

Тема: Разработка таблиц учета стоимости оборудования, расходных  материалов, 

заработной платы сотрудников в программе  MS Excel  

Задание 

Учет стоимости оборудования  

Создать таблицу «Оборудование»; 

Указать их стоимость и количество; 

Подсчитать общую стоимость оборудования; 

Вывести оборудование, которое необходимо закупить. 

Учет расходных материалов  

Создать таблицу «Расходные материалы»; 

Указать их стоимость и количество; 

Подсчитать общую стоимость оборудования; 

Вывести продукцию, которую необходимо закупить. 

Учет зарплаты сотрудников  

Создать таблицу «Зарплата сотрудников»; 

Указать номер, ФИО, адрес домашний, телефон, паспортные данные,  

размер заработной плата, надбавки, налог, итог зарплаты; 

Подсчитать общее количество денег, которые выданы сотрудникам; 

Вывести сотрудников, которым не выдана/выдана зарплата 

(см. Рис 5.) 

 
Рис 5. Зарплата сотрудников 

 

Все три таблицы делаются в одной книге, листы  

называются: Оборудование, Материалы, Зарплата сотрудников 

. 

 

 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА №54 

Тема: «Создание Web-документа. Общая структура  сайта. Команды 
форматирования символов» 

Цель занятия:  
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 сформировать четкое  представление  и структуре Web-документа, его 

основных  компонентах (тегах форматирования символов, тегах форматирования текста   

и правилах их применения); 

 сформировать навыки использования тэгов языка   HTML,  

 научиться создавать, сохранять, просматривать  и редактировать Web-

документы. 

Краткие  теоретические  сведения  

 

Часть1.  Создание Web-документа. Общая структура  сайта 

World Wide Web, или просто Web, - часть Интернета- всемирной сети, с помощью 

которой пользователи компьютеров могут обмениваться информацией и программными 

средствами. В Web используются документы особого формата HTML (Hypertext Markup 

Language – язык разметки гипертекста), а также специальные типы ссылок URL (Uniform 

Resource Locator) для распознавания определенных документов и их местонахождения. В 

Word есть множество средств для облегчения работы с документами HTML 11 URL. 

Тэг – элементарная команда языка HTML. Тэги в программе записываются внутри 

угловых скобок. Например, команда вывода на экран бегущей строки – MARQUEE, 

должна быть заключена в угловые скобки: <MARQUEE>. Если скобки опущены, то 

интернет браузер будет рассматривать эту команду не как команду, а как строку текста, 

которую нужно вывести на экран. 

Большинство тэгов имеет команду отмены действия объявленного тэга. Для этого 

перед командой ставится правый наклонный слеш. Пара тэгов называется контейнером. 

Три самых важных управляющих кода HTML данной категории - <HTML>, 

<HEAD> и <BODY>. Они передают программе просмотра Web основную информацию 

для идентификации и организации документа. 

Управляющие коды <HTML> и </HTML> помещаются соответственно в начале и 

конце всего документа, чтобы обозначить текст как действительный документ на языке 

разметки гипертекста. Говоря точнее, эти коды ограничивают ту часть документа, 

которую должна обработать и отобразить программа просмотра Web. На самом деле ни 

одна из существующих программ просмотра не требует кодов <HTML> и </HTML> и 

никак их не интерпретирует; однако стоит привыкнуть ставить их во избежание проблем в 

будущем, когда программы просмотра и редакторы HTML станут сложнее. 

Между кодами <HEAD> и </HEAD> помещается раздел заголовка документа. 

Новички HTML часто неправильно его используют. Важно отметить, что никакой элемент 

данного раздела не появляется в прокручиваемой, или клиентской, области окна 

программы просмотра Web. Между кодами <HEAD> и </HEAD> разрешается 

использовать только несколько других кодов, и единственная пара среди них, которая 

сейчас может представлять для вас интерес, - это <TITLE> и </TITLE>. 

Когда текст обрамляется кодами <TITLE>, программа просмотра Web выводит его 

на панель заголовка соответствующего окна. Что еще важнее, если пользователя 

заинтересовал один из ваших документов и он хочет добавить его в "горячий список" или 
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"список закладок", то берется именно текст, выделенный кодами <TITLE>. Поэтому 

заголовок вашего документа должен быть информативным и конкретным, а не туманным и 

общим. 

Управляющие коды <BODY> и </BODY> определяют часть документа, которая 

будет показана пользователю в клиентской области окна программы просмотра Web. Тело 

документа состоит из произвольной смеси абзацев, горизонтальных линеек, заголовков и 

списков, перемежающихся вкрапленными управляющими кодами для форматирования 

символов, гипертекстовых связей и вставляемой графики. Все коды, которые мы будем 

обсуждать далее, используются внутри раздела <BODY>. 

Итак, общая структура типичного документа HTML выглядит следующим образом: 

<HTML> 

<HEAD> 

<TITLE> 

Текст заголовка окна 

</TITLE> 

</HEAD> 

<BODY> 

Текст документа 

</BODY> </HTML> 

Сохранение  файла  

Проще всего набирать текст в  любом несложном текстовом документе, например,  

в Блокноте. 

Сохраняем документ при помощи команды Файл – Сохранить как. В строке  Имя 

файла вводим имя и расширение (index. htm), выбираем тип  - Все файлы. Открыв с 

помощью любого браузера документ, можем просмотреть его содержимое. Чтобы 

продолжить редактирование  Web-документа, выбираем  в контекстном меню команду 

Открыть с  помощью – Блокнот.  

Задания для практической  работы  

1. Создайте  текстовый  документ с помощью редактора Блокнот. 

2. Наберите текст документа, (заключенный в рамку). 

3. Сохранить файл  под любым именем (Файл –Сохранить как).  

4. Просмотрите документ с помощью любого браузера, например, Internet 

Explorer. 

5. Закройте  документ и снова откройте его с помощью блокнота. Удалите  

слова ТЕКСТ ДОКУМЕНТА и вместо них введите  произвольный  текст. 

Сохраните  документ (Файл – Сохранить). 



196 

 

6. Снова просмотрите  документ с помощью браузера. Что изменилось?   

7. Введите в тэге    BODY  следующие команды <BODY BGCOLOR=RED 

TEXT= BLUE> 

8. Сделайте  самостоятельный  вывод о тэгах настройки фона страницы и 

цвета текста. 

9. Проверьте  правильность своих предположений, задав другие цвета. 

Часть 2. Ввод и форматирование текста 

Краткие  теоретические  сведения 

 

Управляющие коды форматирования символов можно разделить на две подгруппы: 

коды физических атрибутов символов и коды логических атрибутов символов. Эти коды 

всегда парные, и вы вставляете их прямо в поток символов; они не влияют на отступы, 

промежутки и переводы строк.  

Например, последовательность текста 

   Второе   <B>слово</B>   в   этом  <I>предложении</I> выделено полужирным 

шрифтом, а пятое - курсивом. <P> 

будет выглядеть на экране так: 

   Второе слово в этом предложении выделено  полужирным шрифтом, а пятое - 

курсивом. 

Тэги начальных установок
1
 

<HTML> ………  </HTML> Начало ………..Конец программы на 

HTML 

<BODY> ……..  </BODY> Тело программы ……Закрыть 

<TITLE>********* </TITLE> Заголовок…….Отмена заголовка 

<BODY BGCOLOR= TEXT= > Настройка цвета бумаги и цвета текста 

 

Тэги настроек шрифта 

<H2> ************** </H2> Выделение жирным шрифтом 

<FONT COLOR="RED"> Установлен шрифт красного цвета 

<FONT SIZE="+2"> Увеличить размер шрифта на 2 пункта 

<B>***************** </B> Жирный шрифт 

<U>***************** </U> Подчеркнутый шрифт 

<S>***************** </S> Зачеркнутый шрифт 

<TT>*************** </TT> Шрифт телетайп (равноширинный) 

<I>****************</I> Шрифт курсив (италик) 

<SUP>************</SUP> Верхний индекс символов 

<SUB>************</SUB> Нижний индекс символов 

 

Тэги форматирования текста 

 

<CENTER> ******</CENTER> Центрирование текста 

<MARQUEE>*****</MARQUEE> Бегущая строка 

<BR> Новая строка 

<HR> Горизонтальная линия 

<HR ALIGN=”CENTER 

WIDTH=”70% SIZE=”3”> 

Подчеркнуть надпись линией шириной – 

WIDTH <= 70%  и толщиной SIZE 

<UL TYPE="DISK"> Создание маркированного списка, тип 

                                                 
1 Ниже и далее точками (………) между тэгами обозначаются фрагменты 

программы, а звездочками (********) строки текста. 
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маркера – диск 

<LI> Начало строки маркированного списка 

</UL> Отмена маркированного списка 

<P>*************</P> Абзац  

 

index. html 

<HTML> 

<TITLE>Моя первая программа на  языке HTML </TITLE> 

<BODY> 

<BODY BGCOLOR=MAROON TEXT=LIME > 

<FONT SIZE=+2> 

<H2> <CENTER>Урок 1.  Исследуем свойства надписей </CENTER> </H2><HR> 

<FONT SIZE=+1> 

<FONT COLOR=AQUA> 

<CENTER> 

<UL TYPE="DISK"> 

<LI>Строка -  нормальный шрифт<BR> 

<LI><B>Строка -  жирный шрифт </B><BR> 

<LI><TT>Строка -  шрифт телетайп </TT><BR> 

<LI><I>Строка - шрифт курсив</I><BR> 

<LI><U>Строка - подчеркнутый шрифт </U> 

<LI><S>Строка - зачеркнутый шрифт</S> 

</CENTER> 

</UL><HR SIZE=5> 

<FONT COLOR=”WHITE”>Связь массы и энергии – E = mc<SUP>2</SUP><BR> 

<FONT COLOR=”LIME”>Формула воды – H<SUB>2</SUB>O 

</BODY> 

</HTML> 

 

Контрольные вопросы: 

1. Как называется  элементарная команда языка HTML? 

2. Какие тэги начальных установок вы знаете? 

3. При помощи какого тэга задается Шрифт? 

4. Какие атрибуты  шрифта можно задать при помощи тэга Font? 

5. Как создать Web-документ? 

6. Как сохранить Web-документ? 

7. Как внести изменения в уже созданный  Web-документ? 

8. Перечислите известные вам  тэги форматирования шрифта. 

 

 

ПРАКТИЧЕСКАЯ  РАБОТА № 55 

Тема: «Команды форматирования списков, таблиц, гипертекстовых связей» 
 

Цель занятия:  
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 сформировать четкое  представление о тегах форматирования таблиц и  

вставки графики, их атрибутах; 

 закрепить  навыки использования тэгов для создания списков различных видов,  

  автоматизировать навыки  создания, сохранения, и редактирования  Web-

документов, их просмотра. 

 
Краткие  теоретические  сведения 

1. Команды форматирования списков  

Версии 0.9/1.0 и 2.0 HTML предусматривают три типа списков: упорядоченные списки, 

неупорядоченные списки и списки определений, которые обозначаются соответственно 

метками <OL>, <UL> и <DL>. Упорядоченные списки предназначены для 

последовательных операций или алгоритмов, и программа просмотра Web автоматически 

генерирует номера для каждого пункта в списке. Неупорядоченные списки используются, 

например, при составлении перечня покупок, когда порядок несуществен и перед каждым 

элементом в выводимом на экран списке будет стоять буллит (специальный "списковый" 

значок). Списки определений обеспечивают специальное форматирование, как в словарях, 

или глоссариях, для терминов и связанных с ними описаний. 

Отдельные элементы в упорядоченном и неупорядоченном списке помечаются 

одиночным кодом <LI>, а элементы в списках <DL> - кодами <DT> и <DD> для термина 

и его значения соответственно. Например, последовательность HTML 

   <UL> 

   <LI> Это элемент списка 

   <LI> Это другой элемент 

   <LI> Это последний элемент 

   </UL> 

будет выведена в виде 

 Это элемент списка  

 Это другой элемент  

 Это последний элемент  

Вложенные списки поддерживаются в полной мере, и некоторые программы 

просмотра даже делают попытку использовать разумную иерархию буллитов разной 

формы или цвета для неупорядоченных списков. Висячие отступы, промежутки и другие 

важные аспекты списков, к сожалению, пока недоступны для настройки. В существующих 

версиях HTML списки - практически единственный способ наглядно отобразить 

структурированную информацию, однако на самом деле они - весьма слабое средство. 

Когда HTML 3.0 получит широкое распространение вместе с программами просмотра 

Web, полностью обеспечивающими работу с таблицами HTML 3.0, можно ожидать, что 

многие теперешние варианты использования кодов форматирования списков будут 

забыты. 

2. Загрузка фона и рисунка. Построение таблиц 

 

<BODY  BGCOLOR="RED"> Заливка фона красного цвета 
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<BODY BACKGROUND="FON.gif"> Загрузка фона страницы из 

графического файла fon.gif  

<TABLE BORDER="2" CELLSPACING="1"> Объявление таблицы с шириной 

бордюра = 2 и бордюром ячеек = 1 

<TR> Объявление строки таблицы 

<TD>************* Объявление ячейки таблицы. Текст - 

жирный шрифт. 

<TH>************* Объявление ячейки таблицы. Текст -

нормальный шрифт. 

</TABLE> Завершение таблицы 

<IMG SRC="name.bmp"> Загрузка картинки с именем 

name.bmp 

<IMG SRC="name.bmp" WIDTH="300" 
HEIGHT="260" ALIGN="MIDDLE"> 

Загрузка картинки с выравниванием - 

ALIGN и масштабированием – 

WIDTH, HEIGHT 

 

Index1.html  
 

<HTML> 

<TITLE>Урок2.  Фон и таблицы </TITLE> 

<BODY BACKGROUND="FON.gif" TEXT=LIME> 

<FONT COLOR=AQUA> 

<MARQUEE> 

<H2> <CENTER>Загружаем фон и строим таблицу </CENTER> </H2> 

</MARQUEE> 

</FONT> 

<HR> 

<CENTER> 

<TABLE BORDER="2" CELLSPACING="1"> 

<CAPTION>Таблица понятная всем</CAPTION> 

<TR> 

<TH>Ячейка 1 строка 1 

<TH>Ячейка 2 строка 1 

<TR> 

<TD>Ячейка 1 строка 2 

<TD>Ячейка 2 строка 2 

<TR> 

<TD><IMG SRC="image.gif"> 

<TD>В ячейку 1 строка 3<BR> мы загрузили картинку 

</TABLE> 

<P><HR> 

<IMG SRC="contact.gif" WIDTH="200" HEIGHT="120" ALIGN="MIDDLE"> 

<FONT COLOR=AQUA size=+2> 

<P><I>Эту картинку мы поместили посредине листа </I> 

</BODY> 

</HTML> 

Команды гипертекстовых связей 

 

Ссылка-это адрес или указатель какого-нибудь объекта в Web, такого, как Web-

страница или адрес абонента электронной почты. Вот два наиболее распространенных 

типа ссылок, с которыми вы будете иметь дело:  
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 Адрес электронной почты для связи с каким-нибудь адресатом электронной почты, 

например jsmithabc.com.  

 Гипертекстовая ссылка, указывающая на документ Web, например 

http://www.abc.com.  

В Word есть средство распознавания ссылок в документе, которые трактуются 

именно как ссылки, а не как обычный текст. Ссылки относятся к разновидности полей 

документа и отличаются от обычного текста следующим: ссылка выделяется на экране 

другим цветом. 

Эти управляющие коды применяются для кодирования гипертекстовых связей - 

выделенных цветом или подчеркиванием кусочков текста или растровых изображений в 

специальной рамке, щелчком на которых пользователь может перейти к другому 

документу или к другому месту того же документа. Основная форма кода гипертекстовой 

связи такая: 

   <A HREF="URL">некоторый текст</A>, 

где "некоторый текст" - это то, что видит пользователь, а URL - "место назначения" 

гипертекстовой связи. Адрес этого места может быть абсолютным, (с полным именем 

сервера и именем файла документа назначения); относительным, (означающим, что имя 

сервера и начальный каталог предполагаются теми же, что и у документа, содержащего 

код гипертекстовой связи); или даже локальным, (если файл находится на компьютере, 

где запущена программа просмотра Web, а не на сервере Web). Между кодами <A> и 

</A> можно поместить текст любого объема, код <IMG> для вставки графики или 

сочетание того и другого. 

Главный файл Index.html 

<HTML> 

<BODY  BACKGROUND=fon.gif ALINK=GREEN VLINK=FUCHSIA HLINK=BLUE 

LINK=FUCHSIA > 

<FONT COLOR=RED SIZE=+3> 

<B><MARQUEE> Урок  4 . Изучаем гиперссылки </MARQUEE><HR></B> 

<FONT COLOR=black SIZE=+2> 

<P> 

<CENTER> 

Главный файл обычно имеет имя "Index.html"<BR> 

Именно этот файл загружен сейчас в Internet Explorer<BR> 

<P> 

<FONT COLOR=BLUE> 

(1) Мы можем переместиться по ссылке внутри этого файла.<BR> 

Для этого щелкните мышкой по надписи указанной стрелкой<BR> 

<IMG SRC="1.GIF"> 

<A HREF=#local1>Перейти к тексту на этой странице</A><BR> 

Для того чтобы перейти к другому файлу,<BR> 

в нашем случае это файл 1.html,<BR> 

щелкните мышкой на картинке с мигающим глазом<BR> 

<A HREF="1.HTML"><IMG SRC=eye.GIF></A><BR> 

У нас есть еще один файл с именем 2.html,<BR> 

давайте перейдем к нему, щелкнув мышкой на следующей строке<BR> 

<A HREF="2.HTML">Перейти к файлу 2.htm</A><BR> 

<FONT COLOR=GREEN> 

<P> 

<U>Почитайте  пословицу:</U><BR> 

Терпение и труд<BR> 

http://www.abc.com/
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Все перетрут!<BR> 

<P> 

<FONT COLOR=black> 

</CENTER> 

<B><I> 

<A NAME=local1>Это текст к которому мы перешли из текста (1)<BR> 

Теперь Вы научились создавать гиперссылки! 

</B></I> 

</BODY> 

<HTML> 

 

Дополнительный файл 1.html 

 

<HTML> 

<BODY BGCOLOR=maroon TEXT=lime LINK=BLUE ALINK=WHITE > 

<CENTER><H2>Lesson 4. Файл 1.html</H2></CENTER><HR> 

<P> 

<FONT COLOR=SILVER> 

<FONT SIZE=+2> 

Прочитайте стишок:<BR> 

<CENTER> 

<FONT COLOR=FUCHSIA> 

<B><I> 

В тот год осенняя погода <BR> 

Стояла долго на дворе…<BR> 

Зимы ждала, ждала природа…<BR> 

Снег выпал только в декабре...<BR> 

</B></I> 

</CENTER><BR> 

</FONT> 

<a href=index.html>Вернуться на главную страницу</a> 

</BODY> 

</HTML> 

Дополнительный файл 2.html 

<HTML> 

<BODY BGCOLOR=AQUA TEXT=MAROON  ALINK=PURPLE VLINK=GREEN 

HLINK=OLIVE LINK=MAROON > 

<FONT SIZE=+2 COLOR=PURPLE> 

<CENTER>   

А вот, и вторая страничка!<HR> 

<P> 

<TABLE BORDER="5" CELLSPACING="1"> 

<TR> 

<TH><IMG SRC=1.jpg> 

<TR> 

<TH>  посмотрите на критинку!<BR> 

            

</TABLE> 

</CENTER> 

<P> 

</FONT> 

<A HREF="index.HTML"><IMG SRC="1.GIF">Если щелкнуть мышкой здесь,<BR> 

то вернемся на главную страницу 
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</BODY> 

</HTML> 

Перед выполнением работы создайте изображения, которые упоминаются в тексте 

сайта. 

Контрольные вопросы: 

1. Как называется  элементарная команда языка HTML? 

2. Какие тэги используются для перехода на другую страницу? 

3. При помощи какого тэга создаются гиперссылки? 

4. Как  можно задать положение картинки в  Web - документе? 

5. Как сохранить Web-документ? 

6. Каким образом можно задать адрес изображения? 

7. При помощи какого тэга задается таблица? 

8. Какие атрибуты  таблицы  можно задать при помощи тэга TD? 

9. Как задать строку таблицы? 

10. Перечислите известные вам  тэги форматирования таблиц. 

11. При помощи какого тэга можно вставить изображение? 

12. Как  можно задать положение картинки в  Web - документе? 

13. Как создать Web-документ?Как сохранить Web-документ? 

14. Как внести изменения в уже созданный  Web-документ? 
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ПРАКТИЧЕСКАЯ РАБОТА № 56 

Тема: «Создание ящика электронной почты и настройка его параметров. 
Формирование адресной книги» 

 
Цель: изучить возможности сетевого ПО, процесс регистрации (открытия) 

почтового ящика, подготовки, отправки и приема писем на почтовом сайте. 

Оборудование: ПК 

Программное обеспечение: Internet Explorer  

 

Теоретические сведения к практической работе 

Электронная почта – (самая распространенная услуга сети Internet) обмен 

письмами в компьютерных сетях. Само письмо представляет собой обычный файл, 

содержащий текст письма и специальный заголовок, в котором указано, от кого письмо 

направлено, кому предназначено, какая тема письма и дата отправления. 

Адресация в системе электронной почты 

Электронно-почтовый Internet-адрес имеет следующий формат 

пользователь@машина 

Пример адреса электронной почты: Ivanov@softpro.kursk.ru 

Ivanov– имя почтового ящика.  

softpro.kursk – название почтового сервера 

ru– код Российской Федерации 

Точки и символ @– разделительные знаки. Разделенные точками части 

электронного адреса называются доменами.  

Вся часть адреса, расположенная справа от значка @, является доменным именем 

почтового сервера, содержащего ящик абонента. Главный принцип состоит в том, чтобы 

это имя отличалось от имен всех прочих серверов в компьютерной сети. 

 

Содержание работы: 

Задание №1. Изучите презентацию «Электронная почта» (расположена на сетевом 

диске компьютера) и заполните следующую таблицу: 

 

Вопрос Ответ 

Что представляет собой электронная почта?  

Как записывается адрес электронной почты?  

В чем особенность электронной почты?  

Что представляет собой почтовый ящик?  

Что такое Спам?  

В чем преимущества электронной почты?  

Что такое протокол электронной почты?  

 

Задание №2. Регистрация почтового ящика электронной почты. 

Откройте программу Internet Explorer. 
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В поле Адрес введите адрес поискового сервера http://www.mail.ru 

На открывшейся Веб-странице выберите гиперссылку Регистрация в почте. 

Заполните анкету, следуя рекомендациям, написанным справа от текстовых полей. 

Обязательно должны быть заполнены поля: 

E-mail, 

Пароль, 

Если вы забудете пароль, 

Дополнительная информация о пользователе (заполнить полностью). 

Защита от авторегистрации (ввести зачеркнутые цифры). 

Нажмите кнопку Зарегистрировать почтовый ящик. 

В случае необходимости исправьте ошибки и снова нажмите кнопку 

Зарегистрировать почтовый ящик. 

Ваш почтовый ящик считается зарегистрированным только после появления 

уведомления о том, что ваша регистрация успешно завершена. 

 

Задание №3. Создание и отправка сообщения. 

Для того, чтобы отправить письмо, Вам нужно выбрать нажать гиперссылку 

Написать письмо.  

Напишите 2 письма своему одногруппнику, предварительно обменявшись с ним 

электронными адресами. Письма должны содержать не менее пяти предложений. Одно 

письмо сделайте в обычном формате, а второе в расширенном. 
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                                        Практическая работа №57 

Тема: Защита информации в компьютерной системе от случайных угроз.  

Цель: получение навыков по восстановлению работоспособности операционной 

системы и информации в компьютерной системе от возможного воздействия случайных 

угроз. 

Теоретические сведения 

Использование средств загрузки и восстановления системы 

Windows XP Professional содержит инструментальные средствах и параметры 

предназначенные для помощи в устранении неполадок во время запуска системы и 

восстановления после сбоев. Эти инструментальные средства включают безопасный 

режим, последнюю удачную конфигурацию, консоль восстановления и Мастер аварийного 

восстановления системы.  

Использование безопасного режима  
Если ваш компьютер не запускается, вы можете попробовать запустить его в 

безопасном режиме (safe mode). Нажатие клавиши F8 во время фазы выбора 

операционной системы приведет к выводу экрана с дополнительными вариантами 

загрузки Windows XP Professional. Если вы выбираете безопасный режим, Windows XP 

Professional запускается с ограниченным набором драйверов устройств и системных 

служб. Эти базовые драйверы устройств и системные службы включают мышь, 

стандартный VGA-монитор, клавиатуру, устройства хранения данных, заданные по 

умолчанию системные службы, но не включают сетевые подключения. В безопасном 

режиме также игнорируются автоматически загружаемые программы, профили пользо-

вателей, программы, указанные в реестре как загружаемые автоматически, и все 

локальные политики групп.  

Безопасный режим предоставляет доступ к конфигурационным файлам Windows 

XP Professional, что позволяет вам изменять параметры системы. Вы можете остановить 

или удалить системные службы и драйвера устройств или приложения, которые 

запускаются автоматически и препятствуют нормальному запуску компьютера.  

Если ваш компьютер загружается в безопасном режиме, фон экрана становится 

черным и во всех четырех углах экрана появляется надпись «Безопасный режим». Если 

ваш компьютер не загружается в безопасном режиме, можно попытаться использовать 

функцию Автоматического восстановления системы (Automatic System Recovery) 

Windows XP Professional.  

Безопасный режим с загрузкой сетевых драйверов  
Существуют два слегка измененных варианта безопасного режима. Вы можете 

выбрать безопасный режим с загрузкой сетевых драйверов, который идентичен 

безопасному режиму, за исключением того, что в этом случае добавляются драйвера и 

службы, необходимые для функционирования сети. Безопасный режим с загрузкой 

сетевых драйверов также позволяет реализовать групповую политику, включая уста-

новление связи с сервером в процессе входа в систему и последующую настройку 

параметров локального компьютера.  

Безопасный режим с поддержкой командной строки  
Вторая модификация безопасного режима - это безопасный режим с поддержкой 

командной строки, аналогичный безопасному режиму, но загружающий вместо 

графического интерфейса пользователя интерфейс командной строки и отображающий 

приглашение ввода.  

Использование последней удачной конфигурации  
После выбора дополнительного варианта загрузки Загрузка последней удачной 

конфигурации (LastKnownGood configuration) Windows XP  

Professional загружается, используя информацию из реестра, сохраненную Windows 

XP Professional при последнем выходе из системы.  

Если вы изменяете параметры Windows XP Professional, указав необходимость 
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загрузки нового драйвера, и при перезагрузке возникают проблемы, используйте режим 

загрузки последней удачной конфигурации для восстановления работоспособности 

системы. Режим загрузки последней удачной конфигурации в процессе загрузки Windows 

XP Professional использует набор параметров LastKnownGood, сохраненный в реестре.  

Windows XP Professional предоставляет два набора параметров для загрузки 

компьютера: Default и LastKnownGood. Рис. 1.1 показывает события, происходящие когда 

вы изменяете конфигурацию вашей системы. Любые изменения конфигурации (например, 

добавление или удаление драйверов) сохраняются в наборе параметров Current. 

После перезагрузки компьютера ядро во время фазы инициализации копирует 

информацию из набора параметров Current в набор параметров Clone. Когда вы успешно 

зарегистрировались в Windows XP Professional, информация из набора параметров Clone 

копируется в набор параметров LastKnownGood, как показано в нижней части рис. 1.1.  

Если при запуске системы вы сталкиваетесь с проблемами, вызванными по вашему 

предположению изменением параметров Windows XP Professional, выключите компьютер, 

не входя в систему, и затем перезагрузите его. Когда вам будет предложено выбрать для 

загрузки одну из операционных систем, перечисленных в файле BOOT.INI, нажмите F8 

для открытия экрана с дополнительными вариантами загрузки Windows. В предложенном 

меню выберите пункт Загрузка последней удачной конфигурации (LastKnownGood 

Configuration).  

Когда вы зарегистрируетесь в системе набор параметров Current копируется в набор 

параметров Default. Если внесенные вами изменения параметров работают корректно, то 

после регистрации набор параметров Current будет скопирован в набор параметров 

Default. Если измененные параметры не работают, вы можете перезагрузить компьютер и 

использовать вариант Загрузка последней удачной конфигурации (LastKnownGood 

Configuration). 

 
Рис. 1.1.   Использование наборов параметров Default и LastKnownGood  

В таблице 1.1 приведены общие сведения о назначении конфигураций Default и 

LastKnownGood. 

Таблица 1.2 содержит список ситуаций, в которых вы можете использовать загрузку 

последней удачной конфигурации и предлагаемые методы решения.  

Конфигурации Default и LastKnownGood             
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Таблица 1.1 

 

Конфигурация 

Описание 

Default 

 

LastKnownGood 

 

 

Содержит информацию, которая система сохранила при 

выключении компьютера. Для загрузки компьютера с 

использованием этой конфигурации выберите Windows XP 

Professional в меню выбора загружаемой операционной системы  

Содержит информацию, которую система сохраняет после 

успешной регистрации пользователя в системе. Конфигурация 

LastKnownGood загружается только при восстановлении системы 

после сбоев или критических ошибок загрузки драйверов 

устройств либо если она выбрана при загрузке системы 

Ситуация в которых используется последняя удачная конфигурация   Таблица 1.2  

 

Ситуация 

Решение 

После установки нового 

драйвера Windows XP 

Professional перезапус-

кается, но система зави-

сает и перестает отвечать 

Используйте загрузку последней удачной конфигурации для 

запуска Windows XP Professional, поскольку последняя удачная 

конфигурация не содержит никаких ссылок на новые драйверы, 

вызвавшие проблему. 

Вы по ошибке удалили 

необходимый для работы 

системы драйвер 

(например, scsiport) 

Некоторые критические драйверы написаны, чтобы защитить 

пользователей от их ошибочного отключения. С этими 

драйверами, система автоматически возвращается к набору 

параметров LastKnownGood, если пользователь отключает 

драйвер. Если драйвер автоматически не заставляет систему 

возвращаться к набору параметров LastKnownGood, вы должны 

вручную выбрать загрузку последней удачной конфигурации. 

Использование последней удачной конфигурации не поможет вам в описанных 

далее ситуациях.  

•    Когда проблема не связана с изменением параметров Windows XP Professional. 

Например, проблема может быть вызвана некорректным профилем пользователя или 

неправильно назначенными разрешениями.  

•    После того как вы зарегистрировались в системе. Система обновляет набор 

параметров LastKnownGood копируя в него новые параметры Windows XP Professional 

сразу после успешной регистрации пользователя.  

•    Когда проблема загрузки вызвана неисправностью оборудования либо 

поврежденным или отсутствующим файлом.  

Внимание! Запуск Windows XP Professional с использованием последней удачной 

конфигурации перезаписывает все изменения параметров, сделанные вами с момента 

последней успешной загрузки Windows XP Professional.  

Использование других дополнительных вариантов загрузки  
Если во время выбора загружаемой операционной системы нажать F8, на экран 

будет выведено меню с дополнительными вариантами загрузки Windows, предлагающее 

рассмотренные ниже варианты.  

•   Включить протоколирование загрузки (Enable Boot Logging). Включение 

протоколирования загрузки позволяет создать журнал загрузки и инициализирования 

драйверов и служб для диагностики и устранения неисправностей в процессе загрузки. В 

журнале регистрируется удачная или неуспешная загрузка и инициализация всех 

драйверов и служб. Файл журнала NTBTLOG.TXT находится в папке %windir%. Все три 

варианта безопасного режима автоматически создают файл журнала загрузки.  

•    Включить режим VGA (Enable VGA Mode). Если выбрать этот вариант 

загрузки, Windows XP Professional запустится со стандартным драйвером VGA.  
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•    Восстановление службы каталогов (Directory Services Restore Mode). Выбор 

режима восстановления службы каталогов применим только на контроллерах домена, 

таким образом, его не используют на компьютерах, работающих под управлением 

Windows XP Professional.  

•    Режим отладки (Debugging Mode). Выбор этого дополнительного варианта 

загрузки приведет к запуску Windows XP Professional в режиме отладки ядра, 

позволяющем отладчику прерывать работу ядра для диагностики и анализа работы 

системы.  

Примечание Когда используются дополнительные варианты загрузки Windows XP, 

журнал загрузки создается во всех вариантах, за исключением загрузки последней удачной 

конфигурации. Система записывает файл журнала (NTBTLOG.TXT) в папку 

%systemroot%. Также во всех вариантах, за исключением загрузки последней удачной кон-

фигурации используется стандартный драйвер VGA.  

Использование дополнительных вариантов для загрузки системы приводит к 

установке переменной среды %SAFEBOOT_OPTION% индицирующей режим загрузки 

системы. 

2.2. Использование консоли восстановления. 

Консоль восстановления Windows XP Professional — это работающий в текстовом 

режиме командный интерпретатор, который можно использовать для доступа к томам 

NTFS, FAT и FAT32 без загрузки Windows XP Professional. Консоль восстановления 

позволяет выполнить ряд задач по диагностике и устранению неполадок системы, 

включая:  

•    запуск и остановку служб;  

•    чтение и запись данных на локальных дисках;  

•    форматирование жестких дисков:  

•    восстановление MBR. 

Установка и запуск консоли восстановления  
Для установки Консоли восстановления (Recovery Console) вставьте CD-ROM 

Microsoft Windows XP Professional в ваш привод CD-ROM и закройте диалоговое окно 

Microsoft Windows XP Professional CD, если оно будет открыто. Откройте диалоговое окно 

Выполнить (Run) или окно командной строки в Windows XP Professional, перейдите в 

папку i386 на компакт-диске Windows XP Professional и запустите программу winnt32 с 

ключом /cmdcons. Можно использовать CD-ROM Windows XP Professional для запуска 

вашего компьютера и получить доступ к Консоли восстановления (Recovery Console), 

выбрав пункт Консоль восстановления (Recovery Console), когда вас спросят о варианте 

восстановления системы.  

После запуска Консоли восстановления (Recovery Console) необходимо войти в 

систему под учетной записью Администратора. 

Использование консоли восстановления Windows XP Professional  
Вы можете запустить Консоль восстановления (Recovery Console) с CD-ROM 

Windows XP Professional. Консоль восстановления (Recovery Console) предоставляет 

ограниченный набор команд, который вы можете использовать для восстановления 

поврежденной установки Windows XP Professional. Для запуска Консоли восстановления 

(Recovery Console) с Windows XP Professional CD-ROM выполните указанные далее 

действия.  

1.   Вставьте Windows XP Professional CD-ROM в ваш привод CD-ROM и 

перезагрузите компьютер. Если ваш компьютер или рабочая станция, нуждающаяся в 

восстановлении, не может загружаться с CD-ROM, вам необходимо вставить загрузочную 

дискету Windows XP Professional Setup Boot Disk вваш дисковод. По запросу Windows XP 

Professional вставляйте дополнительные установочные дискеты.  

2.   Когда программа установки выведет сообщение Setup Notification, прочитайте 

его и нажмите Enter для продолжения. Программа установки выведет экран Welcome To 

Setup. В дополнение к начальной установке Windows XP Professional, вы можете 
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использовать программу установки для восстановления поврежденной установки Windows 

XP Professional.  

3.   Нажмите R для восстановления установки Windows XP Professional. Будет 

выведен экран Консоли восстановления Windows XP (Windows XP Recovery Console).  

4.   Нажмите С, чтобы запустить Консоль восстановления (Recovery Console). Если 

на вашем компьютере установлено больше одной системы, Windows XP Professional 

требуется выбрать установку, нуждающуюся в восстановлении.  

5.   Введите 1 и нажмите Enter. Вас попросят ввести пароль для учетной записи 

Администратора.  

6.   Введите пароль и нажмите Enter. Программа установки показывает 

приглашение ко вводу.  

7.   Введите help и нажмите Enter, чтобы увидеть список доступных команд.  

8.   Когда вы закончите восстановление системы, введите exit и нажмите Enter.  

Компьютер будет перезагружен. 

В Консоли восстановления (Recovery Console) пользователю предоставляется 

несколько команд, некоторые из них описаны в таблице 1.3. 

Команды консоли восстановления 

Таблица 1.3 

 

Команда 

Описание 

Attrib 

 

Chdir (cd)      

Chkdsk                  

Cls                       

Сору 

 

Delete (Del)          

Dir 

Disable                 

Diskpart 

 

Enable                   

Exit 

Expand 

Fdisk                    

Fixboot                 

Fixmbr 

 

Format 

Help                      

Logon                    

Map                      

Mkdir (md)           

More                     

Rmdir (rd)     

        

Rename (ren)  

Systemroot 

Туре 

Меняет атрибуты файла или папки: - снимает атрибут; + устанавливает 

атрибут; с атрибут «архивный» (Compressed); h атрибут «скрытый» 

(Hidden); r атрибут «только чтение» (Read-only); sатрибут «системный» 

(System)  

Отображает имя текущей папки или меняет текущую папку  

Проверяет диск и выводит отчет  

Очистка экрана  

Копирует один файл в указанное местоположение. Вы не можете 

копировать файлы с жесткого диска на дискету, но можете копировать 

файлы с дискеты или с CD-ROM на жесткий диск, либо с одного 

жесткого диска на другой  

Удаляет один или несколько файлов  

Показывает список файлов и подпапок в папке. Допускает использование 

символов * и ? в шаблоне имени  

Запрещает работу системной службы или драйвера устройств  

Создает, удаляет и управляет разделами на жестком диске: /add создает 

новый раздел; /delete удаляет существующий раздел Не изменяйте с 

помощью этой команды структуру динамических дисков, поскольку это 

может привести к повреждению таблицы разделов  

Запускает системную службу или драйвер устройства  

Завершение работы с Консолью восстановления (Recovery Console) и 

перезапуск компьютера  

Извлекает архивированный файл с CD-ROM Windows XP Professional или 

из файла .cab и помещает его в указанное место  

Управляет разделами на вашем жестком диске  

Записывает новый загрузочный сектор в системный раздел  

Восстанавливает главную загрузочную запись (MBR). Команда 

перезаписывает только код главной загрузочной записи, оставляя 

существующую таблицу разделов неизменной. Если в MBR повреждена 

таблица разделов, команда fixmbr не поможет решить проблему  

Форматирование диска. Если файловая система не указана, по умолчанию 

используется NTFS  

Выводит список команд, которые доступны в Консоли восстановления  
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Регистрация в установленной Windows XP Professional  

Отображает буквы, назначенные дискам  

Создает папку  

Отображает текстовый файл  

Удаляет папку  

Переименовывает один файл  

Устанавливает текущую папку как папку %systemroot% для системы, в 

которой вы зарегистрированы  

Отображает текстовый файл 

2.3. Изучите особенности восстановления системы и защиты важных файлов 

Windows ХР. 

Одной из полезных возможностей Windows ХР является средство восстановления 

системы. Изменения в оборудовании компьютера, его настройках установка новых 

программ или другие причины, могут привести к его, неправильной работе. Используя 

утилиту восстановления системы, вы можете вернуть компьютеру рабочее состояние 

путем отмены изменений его конфигурации и восстановления потерянных файлов. 

Восстановление работоспособности операционной системы Windows ХР 

обеспечивается за счет того, что система отслеживает все изменения происходящие с 

компьютером, например, установку новой программы или удаление некоторых служебных 

файлов. Также происходит сохранение состояния системы через определенные интервалы 

времени, в моменты, называемые точками восстановления. Точки восстановления могут 

устанавливаться автоматически или вручную. Выбрав точку восстановления, вы вернете 

прошлое состояние, системы. Например, если вы нечаянно удалили файлы с программами 

или эти файлы повредились, то можно восстановить эти файлы, если выбрать для 

восстановления точку, расположенную во времени до того, как эта неприятность 

произошла.  

Утилита восстановления устанавливается на ваш компьютер всегда, но работает 

только, если на системном диске имеется более двухсот мегабайт свободного места. 

Объем сохраняемой информации зависит от того, как интенсивно вы работаете, как 

много программ устанавливаете и удаляете. Также этот объем зависит от количества 

свободного места на системном диске (диске на который установлена операционная 

система Windows ХР). Возможности утилиты восстановления позволяют отслеживать и 

восстанавливать изменения, произошедшие с вашим компьютером за период от одной до 

трех недель. 

Когда Windows ХР запускается первый раз, она создает начальную системную 

контрольную точку. Если вы выберете эту точку для восстановления, система будет 

приведена в первоначальное состояние, и многие файлы, созданные позднее, могут быть 

потеряны. 

Во время работы системы утилита восстановления может регулярно создавать 

контрольные точки, даже если, вы не вносили изменений в настройки системы. Обратите 

внимание, что компьютер прекращает реагировать на все ваши действия в течение 

нескольких минут во время создания контрольной точки. 

Кроме автоматического создания контрольных точек, система позволяет создавать 

контрольные точки вручную, в любое удобное для вас время. 

Имеется возможность создания множества точек восстановления. При 

последующем восстановлении системы вы сможете выбрать, из какой точки следует 

восстанавливаться. Тогда вам и понадобится описание, введенное в этом диалоге. Кроме 

вашего описания, к точке восстановления будут автоматически добавлены текущее время 

и дата. Все это делается, чтобы в будущем вы не спутали разные точки восстановления и 

не восстановили систему в неприемлемое состояние. 

Если у вас было создано несколько точек восстановления, вы можете восстановить 

состояние компьютера с помощью любой из них. Однако следует быть осторожным, так 

как изменения, внесенные в систему после создания точки восстановления, будут утеряны. 
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Поэтому средством восстановления следует пользоваться с большой осторожностью и 

применять его только действительно в критических случаях. 

Для сохранения вашей текущей работы мастер восстановления не трогает файлы в 

папке Мои документы (My Documents), а также файлы с расширениями dоc, в которых 

хранятся документы популярного текстового редактора Word. Не восстанавливаются 

также файлы некоторых других популярных форматов. Такое действие системы 

восстановления объясняется очень просто: если восстанавливать эти файлы, то может 

оказаться, что будут восстановлены старые версии документов, а текущая работа будет 

потеряна. 

Система восстановления предназначена, в первую очередь для восстановления 

работоспособности Windows XР и установленных приложений. Для сохранности 

разрабатываемых вами документов следует периодически сохранять их на сменных 

носителях информации, таких как дискеты, сменные диски, стримеры или 

перезаписываемые компакт-диски. 

Если на вашем компьютере установлен жесткий диск большого объема и вы не 

испытываете проблем со свободным местом, то не отключайте систему восстановления.  

Не всегда на диске бывает достаточно много места. Освободить место на жестком 

диске вашего компьютера можно, если отключить систему восстановления. 

Другой системой, обеспечивающей надёжность работы операционной системы 

Windows XP, является Защита системных файлов (System File Protection). Эта система 

гарантирует, что при установке новых программ, важные системные файлы, критичные 

для функционирования Windows ХР, не будут заменены более старыми версиями или 

версиями, не одобренными фирмой Microsoft. 

Это означает, что даже прикладные программы, разработанные Microsoft, не смогут 

заменять защищенные файлы старыми версиями. Это также означает, что программа 

сторонних производителей может заменить системные файлы, но только, если новый файл 

присутствует с каталогом, подписанным Microsoft, как более новый файл. Данное 

усовершенствование существенно повышает надежность системы при установке новых 

версий программ. 

Для аварийного восстановления операционной системы Windows XP в случае сбоя, 

случайного или преднамеренного удаления системной информации можно использовать 

Мастер аварийного восстановления системы (Automated System Recovery Wizard)  

Мастер подготовки аварийного восстановления системы помогает создать 

резервную копию системного раздела, которую можно использовать для восстановления.  

Мастер подготовки аварийного восстановления системы создает:  

 дискету, которая содержит параметры системы; 

 архив вашего локального системного раздела.  

Для хранения архива выбирают либо магнитную ленту, либо произвольное 

дисковое устройство, например жесткий диск, общую сетевую папку или устройство со 

сменными носителями типа Iomega Zip.  

Для восстановления системного раздела, вы можете использовать дискету, 

созданную Мастером подготовки автоматического восстановления системы (Automated 

System Recovery Wizard) для загрузки урезанной операционной системы. Архивы 

локального системного раздела, хранящиеся на ленте или в файле будут доступны для 

восстановления. Затем вы сможете использовать Мастер архивации или восстановления 

(Backup or Restore Wizard) для восстановления ваших данных и приложений из архивов. 

Практические задания 

Упражнение 1. Устранение проблем установки Windows XP Professional  
Сейчас вы обнаружите и устраните неисправность в установленной Windows XP 

Professional, используя Консоль восстановления (Recovery Console).  

Создание системной неисправности  
1.   Щелкните Пуск (Start), щелкните правой кнопкой мыши Мой компьютер (My 

Computer), затем щелкните пункт меню Проводник (Explore).  
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2.   В левой панели окна Проводник (Explorer) щелкните Локальный диск (С:) 

[Local Disk (С:)].  

3.   В правой панели окна Проводник (Explorer) щелкните правой кнопкой мыши 

значок файла NTLDR, а затем щелкните Переименовать (Rename).  

4.   Введите oldntldr и нажмите Enter.  

Windows XP Professional покажет диалоговое окно Подтверждение 

переименования файла (Confirm File Rename) с запросом, действительно ли вы хотите 

переименовать системный файл NTLDR в OLDNTLDR.  

5.   Щелкните Да (Yes).  

6.   Перезагрузите компьютер.  

Какое сообщение об ошибке выводится при перезапуске компьютера? 

Использование Консоли восстановления (Recovery Console) для устранения 

проблемы  
1.   Вставьте компакт-диск Windows XP Professional в привод CD-ROM и нажмите 

Ctrl+Alt+Delete для перезапуска компьютера.  

2.   Если ваш компьютер просит нажать клавишу для загрузки с CD-ROM, нажмите 

Пробел.  

3.   Когда программа установки выведет сообщение Setup Notification прочитайте 

его и нажмите Enter для продолжения. Программа установки выведет экран Welcome To 

Setup.  
4.   Нажмите R для восстановления установленной Windows XP Professional.  

Программа установки запустит Консоль восстановления (Recovery Console).  

5.   Введите 1 и нажмите Enter. Вас попросят ввести пароль администратора.  

6.   Введите password и нажмите Enter. Программа установки отобразит приглашение ко 

вводу с именем каталога C:\Windows.  

7.   Введите е: и нажмите Enter. Если вашему приводу CD-ROM соответствует 

другая буква, введите ее.  

8.   Введите cd i386 и нажмите Enter.  

9.   Введите dir и нажмите Enter.  

Большинство имен файлов на CD-ROM завершаются символом _, например, 

NTOSKRNL.EX_.  

10. Нажимайте Пробел, пока не обнаружите файл NTLDR. NTLDR не является 

сжатым файлом, так что вы можете сразу скопировать его на компьютер.  

11. Введите copy ntldr c:\ntldr и нажмите Enter. Когда копирование завершено, выводится 

сообщение 1 file(s) copied.  

12. Если в дисководе есть дискета, удалите ее. Если ваш компьютер может 

загружаться с привода CD-ROM, удалите компакт-диск Windows XP Professional из 

привода CD-ROM.  

13. Введите exit и нажмите Enter.  

Компьютер перезагрузится и запустится нормально. 

Упражнение 2. Установка Консоли восстановления Windows XP Professional  
1.   Войдите в систему под учетной записью Администратор (Administrator).  

2.   Вставьте компакт-диск Windows XP Professional в Привод CD-ROM.  

3.   Когда будет выведено окно Microsoft Windows XP Professional CD закройте его.  

4.   Щелкните Пуск (Start), затем щелкните Выполнить (Run).  

5. В диалоговом окне Выполнить (Run) введите cd-drive:\i386\winnt32/cmdcons 

(где cd-drive это буква, назначенная вашему приводу CD-ROM) и щелкните ОК.  

Появится окно сообщения Windows Setup сообщающее, что вы можете установить 

Консоль восстановления (Recovery Console) как один из параметров запуска системы.  

6.   Щелкните Да (Yes) для установки Консоли восстановления Windows XP 

Professional.  

Windows Setup предложит подключиться к Web-узлу Microsoft для получения 

обновленных файлов установки Windows, после чего установит Консоль восстановления 
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Windows XP (Recovery Console) на жесткий диск.  

Windows XP Professional выводит окно Microsoft Windows XP Professional Setup, 

сообщающее, что Консоль восстановления (Recovery Console) была успешно 

установлена.  

7.   Щелкните ОК, чтобы закрыть диалоговое окно Microsoft Windows XP 

Professional Setup. 

Упражнение 3. Использование Консоли восстановления Windows XP 

Professional (Recovery Console)  
1.   Перезапустите ваш компьютер.  

2.   На экране Выберите операционную систему для загрузки (Please Select The 

Operating System To Start) выберите Microsoft Windows Recovery Console.  

Запустится Консоль восстановления Microsoft Windows XP (Recovery Console), и вам 

предложено будет выбрать установку Windows, в которой вы хотите зарегистрироваться. 

Если у вас на компьютере установлено более одной системы Windows XP Professional, они 

все перечислены здесь.  

3.   Введите 1 и нажмите Enter.  

4.   Когда вас попросят ввести пароль администратора, введите password и нажмите 

Enter.  

5.   Введите help и нажмите Enter, чтобы просмотреть список доступных команд.  

6.   Прокрутите список команд. Команда Listsvc позволяет просмотреть все 

доступные службы.  

7.   Введите Listsvc, нажмите Enter и прокрутите список доступных служб.  

8.   Нажмите Esc.  

9.   Введите disable и нажмите Enter. Команда Disable позволяет запретить работу 

системной службы Windows или драйвера.  

10. Введите disable alerter и нажмите Enter.  

Консоль восстановления (Recovery Console) выведет несколько строк текста, в 

которых сообщается, что элемент реестра для службы Alerter был изменен с 

Service_Demand_Start на Service_Disabled. Служба Alerter теперь запрещена.  

11. Введите exit и нажмите Enter для перезапуска компьютера. 

Упражнение 4. Перезапуск службы Alerter  
1.   Войдите в систему под учетной записью Администратор (Administrator).  

2.   Щелкните Пуск (Start), щелкните Все программы (All Programs), 

Администрирование (Administrative Tools), а затем — Управление компьютером 

(Computer Management).  

3.   В окне Управление компьютером (Computer Management) разверните раздел 

Службы и приложения (Services And Applications).  

4.   В разделе Службы и приложения (Services And Applications) щелкните 

Службы (Services).  

5.   Дважды щелкните запись службы Alerter.  

6.   В диалоговом окне Alerter — свойства (Alerter Properties) измените параметр 

Тип запуска (Startup Type) на Авто (Automatic) и щелкните ОК.  

7.   Щелкните правой кнопкой мыши запись службы Alerter, а затем щелкните пункт 

контекстного меню Пуск (Start).  

8.   Закройте окно Управление компьютером (Computer Management). 

Контрольные вопросы 

o Когда создается конфигурация LastKnownGood?  

o Когда используется конфигурация LastKnownGood?  

o Как установить Консоль восстановления Windows XP Professional (Recovery 

Console) на компьютер? 

o С помощью чего создаются резервные копии? 

o Как создать загрузочную дискету? 

o Как создать точку восстановления системы Windows XP? 
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o Как восстановить систему Windows XP из контрольной точки? 

o Какие параметры настройки систему восстановления системы Windows XP? 

o Что создает Мастер подготовки аварийного восстановления системы в 

процессе архивации?  

 

 

Практическая работа № 58 

Тема: Зачетное  занятие  по дисциплине «Информатика и  ИКТ  в профессиональной  

деятельности» 

 

Вопросы для зачетного занятия по теме " Информатика и ИКТ в профессиональной 

деятельности". 

1 Понятия 

«Информатика и ИКТ в профессиональной деятельности» и 

«защита 

информации». 

2 Основные положения системы защиты информации. 

3 Условия удовлетворяющие СЗИ. 

4 Основные требования систем защиты информации 

5 Концептуальная модель информационной безопасности. 

6 Угрозы конфиденциальной информации. 

7 Действия, приводящие к неправомерному овладению конфиденциальной информацией. 

8 Направления обеспечения информационной безопасности (правовая защита). 

9 Страховая и лицензионная защита информации. 

10 Направления обеспечения информационной безопасности (организационная защита). 

11 Направления обеспечения информационной безопасности 

(инженерно-техническая 

защита). 

12 Физические средства защиты информации. 

13 Защита информации от утечки по техническим каналам. 

14 Аппаратные средства защиты информации. 

15 Архитектурная безопасность СВТ. 

16 Технические средства несанкционированного доступа. 

17 Программные средства защиты информации. 

18 Основные направления использования программной защиты информации. 

19 Защита информации от несанкционированного доступа. 

20 Защита информации от копирования. 

21 Защита информации от изменения и разрушения. 

22 Криптографические средства защиты. Технологии шифрования. 

23 Способы защиты информации. 

24 Общая характеристика защитных действий. 

25 Пресечение разглашения конфиденциальной информации. 

26 Противодействие несанкционированному доступу к источникам конфиденциальной 

информации. 

27 Способы несанкционированного доступа. 

28 Возможности типичных систем управления безопасностью. 

Нормативно-законодательная база в области информационной безопасности 

 

 

 

 

 

 


